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1 Overview
The Vertiv™ Liebert® SiteScan™ Web building-automation system offers an intuitive user interface and powerful tools to help
facility managers keep occupants comfortable, manage energy conservation measures, identify key operational problems, and
analyze the results. The web-based Liebert® SiteScan™ Web system can be accessed from anywhere in the world through a
web browser. On a workstation or mobile device, user can perform building management functions such as:

• Adjust setpoints and other control parameters

• Set and change schedules

• Graphically trend important building conditions

• View and acknowledge alarms

• Run pre-configured and custom reports on energy usage, occupant overrides, and much more

A Liebert® SiteScan™ Web system supports:

• Unlimited simultaneous users

• Multiple operating systems and databases

• Mobile devices

• Built-in and custom alarms, trends, and reports

• International languages (International English, Brazilian Portuguese, French, German, Italian, Japanese, Korean,
Russian, Traditional and Simplified Chinese, Spanish, Swedish, Thai, Vietnamese)

• Third-party integration

• Secure server access using TLS

1 Overview Proprietary and Confidential ©2026 Vertiv Group Corp. 1

Vertiv™Liebert® SiteScan™ Web Installer/User Guide



1.1 Working of Vertiv™ Liebert® SiteScan™ Web

A Liebert® SiteScan™ Web system uses a network of microprocessor based controllers to control heating, air conditioning,
and other facility systems. A web based server communicates with these controllers and generates the Liebert® SiteScan™
Web interface that the user can access through a web browser. Through the interface, user can gather information, change
operating properties, run reports, and perform other building management functions on a single building, an entire campus, or
a network of facilities that stretch around the globe.

Figure 1.1 Typical Liebert® SiteScan™ Web System

Item Description

1 Liebert® SiteScan™ Web server. Runs the Liebert® SiteScan™ Web Server application.

2
Liebert® SiteScan™ Web clients. Access the Liebert® SiteScan™ Web server as a web site using a standard web browser.
Simultaneous users allowed based-on licensing.

3
Enterprise integration. With add-ons and web services, Liebert® SiteScan™ Web integrates with other enterprise applications to
share data across a facility's network.

4 SiteTPI-E integrates third-party protocols such as Modbus, LonWorks, and N2.

5 SiteIP-E integrates SNMP devices.

6 SiteIO-E is a multi-equipment controller.

7 Vertiv™ Liebert® SiteLink-E communications with Liebert environmental/power equipment and with the Liebert gateway.

8 Ethernet TCP/IP. Protocols include: BACnet, HTTP/HTTPS, XML/SOAP, and Liebert legacy.
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The Vertiv™ Liebert® SiteScan™ Web client uses a web browser to access the Liebert® SiteScan™ Web Server application as a
website.

Figure 1.2 Liebert® SiteScan™ Web Access and Security Options

Item Description

1 Liebert® SiteScan™ Web client with outside, internet connection

2 Liebert® SiteScan™ Web server (Java platform)

3 Liebert® SiteScan™ Web clients on internal network

4 I/P router/Firewall

5 Network security: Transport layer security (TLS/HTTPS), Virtual private network (VPN)

6 Internet

7 Liebert® SiteScan™ Web clients with outside, wireless browsers

1.2 Client Requirements

Computers

The client computer should have at least the following:

• Dual-core processor

• 1.5 GB RAM

• Communication link of 10 Mbps or higher

NOTE: Liebert® SiteScan™ Web will work with slower computers, but the results may not be satisfactory.

Operating systems and web browsers

A computer with Windows® operating system supports:

• Google Chrome™ v84.0 or later

• Microsoft Edge® v84 or later
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• Mozilla Firefox® v79.0 or later

A computer with Mac® OS X® (Apple® Mac only) operating system supports:

• Safari® v11 or later

• Google Chrome™ v84.0 or later

• Mozilla Firefox® v79.0 or later

A computer with Linux® operating system supports:

• Google Chrome™ v84.0 or later

• Mozilla Firefox® v79.0 or later

Mobile devices

For smartphone devices, the Android™ and iOS platforms are supported. For tablet devices, the Android™, iOS, and Surface™
platforms are supported.

NOTE: Some functionality may be limited by the capability of the mobile device and operating system.

1.3 Server Requirements

The Vertiv™ Liebert® SiteScan™ Web server must be 64-bit, and memory requirements will vary based on the following:

• Number of pieces of equipment and device instances

• Size of the control programs

• Number of simultaneous users logged in to the Liebert® SiteScan™ Web application

Size

With the Following Number of: The Server should have at least a dual-core processor and the following:

Equipment
and Device Instances1

Physical Points
and Display Objects

Passmark
Total Score2

Passmark
Single-Threaded

Score

GB RAM
(Minimum

/Recommended)

GB JVM Memory
(Minimum

/Recommended)

Small 0 – 250 0 – 1000 2000 800 4/4 4/4

Medium 250 – 1000 1000 – 5000 3000 1000 8/12 4/8

Large 1000 – 10,000 5000 – 50,000 5000 1400 12/16 8/12

Extra Large More than 10,000 More than 50,000 6500 1600 16/24 16/24

1. Total number of control programs and controllers.

2. For more information, see www.CPUbenchmark.net.

3. For a huge system with minimal user activity, the average piece of equipment or instance device requires approximately 300 KB of server
RAM. Contact Vertiv Technical Support for server sizing recommendations.

Table 1.1 Server Requirements by System Size
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Operating system and database requirements

To determine which operating system and database management system (DBMS) to use, consider:

• Operating systems and DBMS's already in use in your customer’s organization.

• Project size and trending requirements. See Trend archival requirements on page 7.

• Project budget

• User's skill with the operating system and DBMS

The Vertiv™ Liebert® SiteScan™ Web system use of database resources may require:

• A moderate increase in the number of allowed connections if your database management system is set to the
default value for the maximum allowed connections.

• An increase in the maximum number of database cursors allowed may also be required for Oracle databases.

Supported operating systems and database management systems

A Liebert® SiteScan™ v10.0 or later system is supported on the following 64-bit operating systems. The Table 1.2 below shows
which operating systems can be used with each DBMS.

• Windows® 11 Professional and Enterprise

• Windows® Server 2025

• Windows® Server 2022

• Windows® Server 2019

• Windows® Server 2016

• Red Hat Enterprise Linux® 7.4

• Ubuntu® Desktop 22.04 or 24.04 LTS

Database Supported OS Speed
Multiple Servers

Supported

Dynamic

Defragmentation

Database

Replication
Notes

SQL Server®
Express 2016,
2017, 2019,
2022, 2025

Windows® Fast No Yes Yes Database cannot exceed 10 GB.

SQL Server®
2016, 2017,
2019, 2022,
2025

Windows® Fast Yes Yes Yes
SQL Server 2016 Enterprise,
Business Intelligence, and
Standard editions can be used.

Oracle® 19c Windows® Linux® Moderate Yes Yes Yes

Oracle® 19c Standard Edition is
sufficient. Oracle® 19c requires a
Named-User License for each
Liebert® SiteScan™ user or a
Processor License. (Dual
processor machines count as two
users.) See Oracle® License
Policies for more details.

Table 1.2 DBMS and Supported OS Matrix
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Database Supported OS Speed
Multiple Servers

Supported

Dynamic

Defragmentation

Database

Replication
Notes

SQL® through
8.0 LTS

Windows® Linux® Fast Yes No Yes
This open source database is free
under the GNU Public License.

PostgreSQL® 12
through 17.2

Windows® Linux® Fast Yes Yes Yes
This open source database is free
under the BSD Public License.

Apache Derby Windows® Linux® Slow No No Yes

• The Vertiv™ Liebert® SiteScan™
Installs for Windows® and Linux®
include all the files needed to use
an Apache Derby database.

• Only one application can access
the database at one time.
Example: VewBuilder cannot
access the database if SiteBuilder
is already running.

• Do not use Derby if total
historical trend capacity will
exceed 2 GB.

Audit database cannot contain an
entry of more than 32,700
characters; compact the database
before migrating to Derby.

Table 1.2 DBMS and Supported OS Matrix (continued)
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Trend archival requirements

Trend archival (historical trending) requirements are the most significant factors in database selection. Alarms are not usually
an issue unless large quantities (10,000+) will be kept for online access. For each archived trend sample, the Vertiv™ Liebert®
SiteScan™ application stores approximately 30 bytes of data. Disk space requirements per trended point are:

Sample Interval For 1 week For 1 Month For 3 Months For 1 Year

1 minute 300 kB 1.5 MB 5 MB 18 MB

5 minutes 60 kB 250 kB 1 MB 4 MB

15 minutes 21 kB 85 kB 250 kB 1 MB

1 hour 5 kB 20 kB 60 kB 240 kB

For example, a system with 2000 points archiving at 15 minute intervals for one year will require as much as 5.6 GB (2000 x 2.8 MB) disk space.

Notes on trend requirements:

• To limit disk space required for trend storage, archive trend data only for important system points.

• If your archival requirements are 5 GB or greater, you should consider using a separate server for the trend
database.

• If you use a separate trend database server, you can run the Liebert® SiteScan™ Web application on a Microsoft
operating system with any or all of its databases on non-Microsoft operating systems. But, user cannot run the
Liebert® SiteScan™ Web application on a non-Microsoft operating system and connect to Microsoft™ database
products. So, if user have Apache Derby or SQL Server® databases, the Liebert® SiteScan™ Web application must
be running on Windows® 8.1 Professional, 8.1 Enterprise, or 10.

Example: The Liebert® SiteScan™ Web application on Linux® can connect to MySQL® on Linux® But, it cannot
connect to Apache Derby, SQL Server® on Windows.
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2 Vertiv™ Liebert® SiteScan™ Web User Interface
Overview
Figure 2.1 on the next page, describes the main sections and features of the Liebert® SiteScan™ Web window.

Views logically divide the functions of Liebert® SiteScan™ Web. Table 2.1 below, describes the icons located above the
navigation tree that select the items and functions displayed in the navigation tree, menu tabs, and view pane.

Icon Description

Geographic view. See Using the Geographic View on page 15.

Network view.

Schedule Groups view.

System Configuration view. See Using the Configuration View on page 117.

Table 2.1 View Selection Icons

2 Vertiv™ Liebert® SiteScan™ Web
User Interface Overview
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Figure 2.1 Workspace Features and Options

Item Description

1 Back button

2 Menu tab options

3 Print

4 System-wide alarms. See Viewing, Troubleshooting, Acknowledging, and Deleting Alarms on page 1.

5 Help

6 Vertiv™ Liebert® SiteScan™ Web Menu

7 Shortcuts bar. See Using Shortcuts in the Geographic View on page 25.

8 Color-coded shortcuts legend. See Viewing Statuses on the Graphic Floor Plan on page 17.

9 View pane

10 Navigation tree pane. See Navigation Tree on the facing page.

11 Navigation tree options. See Navigation Tree on the facing page.
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2.1 Logging-on to Vertiv™ Liebert® SiteScan™ Web

To access Liebert® SiteScan™ Web:

1. Open a web browser, and enter the URL for the Liebert® SiteScan™ Web server in the address bar.

2. Enter your user name and password (provided by Vertiv Technical Support), and click Log in.

2.2 Saving Changes

You must save certain changes to Liebert® SiteScan™ Web. Whenever you make a change that must be saved, the Accept
and Cancel buttons appear in the toolbar.

• Click Accept to save the changes.

• Click Cancel to discard the changes.

Figure 2.2 Save-changes Buttons in Toolbar

2.3 Navigation Tree

The Navigation tree provides quick access to options depending on the selected view.

To show the navigation tree:

• Click the down arrow next to the application name in the upper-left of the window, see Figure 2.3 below.

To hide the navigation tree:

• Click the up arrow next to the application name at the bottom of the navigation tree, see Figure 2.3 below.

Figure 2.3 Opening and Closing the Navigation Tree

Item Description

1 Down arrow to expand the navigation tree

2 Up arrow to hide the navigation tree

2 Vertiv™ Liebert® SiteScan™ Web
User Interface Overview
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2.4 Tree Icons and Hover Text

The navigation tree displays an icon to the left of each item to denote the type of item. For example:

Icon Name

System

Area

Equipment

Table 2.2 Display of Navigation Tree Icons

To select custom equipment icons in the Vertiv™ Liebert® SiteScan™ Web interface, right-click the equipment on the

Geographic or Network tree, select Configure, then select the Icon. Custom icons can also be selected in the EIKON
application.

Optional icons

To denote locations on the Geographic tree, where items were created or assigned, the user can display the following
icons:

Icon Name

Schedules

Trend Graphs

Alarm Actions

Schedule Groups

Reports

Privileges

Table 2.3 Optional Icons

To turn On optional icons:

1. Right-click on the Geographic tree.

2. Select Tree Display Options.

3. Select the desired Tree Icons.

4. Click Accept.
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Optional hover text

If the hover text option is turned on, the user can hold the cursor over a system, area, or equipment icon to display information
about its item. The information displayed depends on which hover text options are selected.

Figure 2.4 Hover Text

To turn On hover text:

1. Right-click on the tree.

2. Select Tree Display Options.

3. Select the desired Tree Hover Text.

4. Click Accept.

2.5 Zooming and Resizing in the Viewing Area

• Hold the CTRL key while rolling the mouse wheel to zoom in or out on the contents of the Viewing Area.

• Right-click the Viewing Area and select Scale to 100% to restore the contents to their original size.

• If a graphic does not fit in the viewing area, right-click it and select Scale to Fit to make it fit the viewing area.

2.6 Hover-over Text

Hover text reveals information about an item when you hold the cursor over a system, area or equipment icon. Depending on
the options enabled, you can display a list of associated schedules, trends, reports, and alarm actions.

1. Right-click anywhere in the navigation tree and select Tree Display Options.

2. Click to check the information to display, click Apply and then Close.

2 Vertiv™ Liebert® SiteScan™ Web
User Interface Overview
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3 Using the Geographic View
The Geographic view lets you navigate Vertiv™ Liebert® SiteScan™ Web based on the geographic layout of the monitored site.

When you select the geographic view, the menus described in Table 3.1 below, are offered.

Menu tab Description

Graphics
Offers a quick look of the status of your entire system or any portion of it as a graphic-overlay. See Viewing the Graphic for an Area on the
next page.

Alarms
Lets you view and acknowledge system alarms. See Viewing, Troubleshooting, Acknowledging, and Deleting Alarms on page 1 .

This menu tab also offers several other alarm management options, see Alarms on page 28, for more details.

Trends
Lets you review equipment status values over time to monitor the equipment's operation. See Using trend graphs on page 69.

You can also use this tab to customize and manage trends, see Trends on page 63, for more details.

Reports
Lets you compile alarm and other information to help manage and troubleshoot your system. See Preconfigured reports on page 71.

You can also use this tab to configure existing reports and create and customize reports, see Reports on page 71, for more details.

Table 3.1 Geographic View Menus and Options

3.1 Using the Geographic View Navigation Tree

When you are in the geographic view, the navigation tree provides information about and access to your site and equipment.

3.1.1 Icons in the geographic view tree

The navigation tree displays an icon to the left of each item to denote the type of item. Table 3.2 below, describes the icons.

Icon Description

System

Area

Equipment

Table 3.2 Geographic View Tree Icons

In addition to the identification icons that display to the left of the equipment in the tree, you can display additional icons to
the right of the items to indicates where equipment was created or is assigned. Table 3.3 on the next page, describes the
optional icons.

To display the optional icons:

1. Right-click anywhere in the navigation tree and select Tree Display Options.

2. Click to check the icons to display, click Apply and then Close.
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Icon Description

Indicates schedules assigned to the item.

Indicates trends assigned to the item.

Indicates reports assigned to the item.

Indicates alarm actions assigned to the item.

Table 3.3 Optional Geographic View Tree Icons

3.2 Viewing Unit Data

The unit data view shows the status and other information about the unit in the view pane. Select a unit In the navigation tree
to display the unit data.

The unit data view includes an alarms section at the bottom of the window that displays descriptive text for detected alarms.

3.3 Viewing the Graphic for an Area

The Graphics menu tab in the geographic view opens a drawing or floor plan that shows device placement.

To view an area graphic:

Select a unit In the geographic view tree, then click Graphics in the menu bar or in the shortcuts bar.
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3.4 Viewing Statuses on the Graphic Floor Plan

In the geographic view, when you view an area graphic, status information is available for the units and equipment.

Each item in the floor plan has an icon with two parts:

• A text label with the assigned name of the item.

• A color coded button that indicates whether or not notifications or alarms are present. Table 3.4 below,
describes the color coding, which are also defined in a legend above the floor plan in the view pane. For more
details on alarms, see Viewing, Troubleshooting, Acknowledging, and Deleting Alarms on page 1 .

Color Indication

Red Critical alarm present

White No alarms present

Yellow Warning present

Blue Message present

Purple Loss of communication

Gray In maintenance mode

Table 3.4 Graphic-status Color Codes

To view status and other information for any item:

• Hover over the color coded button to display key information pop-up, the current status and the number of
alarms, warnings and other information.

• Click the color coded button to open the view of that item.

3.5 Viewing a Summary Page

Summary pages list the status of all the components of a selected item. Table 3.5 on the next page describes the available
summaries.

To view a summary page:

• Select a unit in the geographic view tree, and click the appropriate icon in the shortcuts bar. See Table 3.7 on
page 25.

– Or –

• Select a unit in the geographic view tree, click the drop-down arrow next to the Graphics tab to display the
available summaries, and select a summary.
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NOTE: The summaries available depend on the item you select in the navigation tree.

Summary Description

Unit_summary

The unit summary differs depending on the level of the item selected in the tree.

• At the top level, all areas are listed along with the alarm information for each.

• The unit summary for an area lists all the monitored equipment in that area, including cooling units, power
equipment, UPS’s and static switches.

• At lower levels, the summary lists data for the monitored equipment at that level.

Air_summary Summary list of all thermal management units at the site.

Power_summary Summary list of all power units at the site.

UPS_summary Summary list of all UPS units at the site.

Staticswitch_
summary

Summary list of all static switches at the site.

Table 3.5 Summary Pages

3.5.1 Viewing, troubleshooting, acknowledging, and deleting alarms

The Vertiv™ Liebert® SiteScan™ Web Alarms page displays alarms as they are received. When an alarm is received, the user
can set options on the My Settings page to have the Liebert® SiteScan™ Web application play an audio file.

The setup of an alarm may require that it be acknowledged and/or the alarm condition returned to normal. An alarm incident
group includes the alarm, its return to normal, and any other alarms associated with the incident. The Liebert® SiteScan™ Web
application closes an alarm incident group when all of the following have occurred:

• You acknowledge the alarm (if required).

• The Liebert® SiteScan™ Web application receives a return to normal (if required).

• The Liebert® SiteScan™ Web application performs all alarm actions defined for the group.

NOTE: The user should delete alarms from your system as they are closed because large quantities of stored alarms
can reduce the efficiency of your system.

Viewing alarms in the Liebert® SiteScan™ Web interface

To view the alarm Summary:

• Click at the top of the page to see all alarms in the system.

-Or-

Click the Alarms button and then select an item on the navigation tree to see all alarms at and below that level.
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Figure 3.1 Alarm Overview
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Item Description

1 Acknowledge, Force Normal, or Delete Alarms

2

View By:

• Date: Most recent at top.

• To do: Only alarms that require action.

• Incident Group: All alarms for one incident.

3 Show all Categories

4 Alarm Category

5
Advanced

NOTE: Click on Advanced to acknowledge or delete all alarms in selected categories, or to delete closed incident groups.

6

Alarm Status:

• Acknowledge: Needs to be acknowledged. Red text indicates a return to normal is also required.

• Waiting for Normal: Require return to normal.

• Closed: All required actions have been performed.

7
Show/Hide details

NOTE: Click on the alarm to show or hide details.

8
Date and Time

NOTE: Enter or select a Date. Click Go to see alarms since that date/time.

9

Click to see all alarms in system. Color indicates alarm needs to be acknowledged.

• Red: Critical

• Yellow: Non-Critical

• Gray: None

10 Alarms > Views shows 50 alarms at a time. Click arrows to see more alarms.

11 Select all Alarms

12 Select one or more alarms

NOTE: The Vertiv™ Liebert® SiteScan™ Web tree can show 10 levels. If an alarm source is deeper than 10 levels, the
alarm is reassigned to the system level.

Alarms generated by the Liebert® SiteScan™ Web application appear at the system level.

Alarms generated by controllers appear at the system level on the Geographic tree, but in the network hierarchy on
the Network tree.

The details of an alarm include a path to the alarm source. Each section of the path is a link to that location. For
example, in the path East Wing/RTU-4/SSP_LO, East Wing links to the East Wing graphic, RTU-4 links to the
equipment graphic, and SSP_LO links to the Properties page of the microblock.

The Liebert® SiteScan™ Web interface may display any of the following alarms icons:
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Figure 3.2 Alarm Icons
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Controling the alarms

Tools Actions to Control the Alarms List

1. Oldest Alarms

2. Previous 50 Alarms

3. Next 50 Alarms

4. Newest Alarms

Click the arrow buttons to display other alarms.

Enter a date and time or click to select a date. Click Go

to show up to 50 alarms since that date/time. When finished,

click to display the 50 newest alarms or to

display the oldest 50 alarms.

Date: Sorts list by date/time the alarms were generated with
the most recent at the top.

To Do: Shows only alarms that require one or more actions
before they are closed.

Incident Group: Sorts alarms by incident. For example, an
alarm and its return to normal form an incident group.

Brackets indicate a group.

Select the alarm categories that you want to see in the
alarms list. Use Ctrl+click, Shift+click, or both to select
multiple categories, or select Show all categories checkbox.

Table 3.6 Controling the Alarms
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Acknowledging alarms

Alarms that have been set up to require acknowledgement must be acknowledged. An alarm shows if it needs to be
acknowledged.

Figure 3.3 Acknowledging Alarms

The table in the upper left corner of the page displays the number of alarms that need to be acknowledged at the current
location (Here) and in the entire system (Total). This table also displays the number of alarms that need a return to normal
and the number of alarms that are closed. See Figure 3.4 below.

Figure 3.4 Alarm Count

Acknowledging an alarm:

1. On the Alarms page > View tab, select the checkbox of an alarm that shows Acknowledge.

2. Click the Acknowledge button.

Acknowledging all alarms in the alarms database for selected categories:

1. On the Alarms page > View tab in the left hand column, select the categories whose alarms you want to
acknowledge.

NOTE: Use Ctrl+click, Shift+click, or both to select multiple categories, or select the Select All checkbox.

2. Click Advanced.

3. Click Acknowledge All.

NOTE: It takes a long time to acknowledge multiple alarms simultaneously. To avoid long waits, acknowledge alarms
as they occur.

Deleting alarms

Alarms should be deleted from your system as soon as they are closed because having a large number of stored alarms can
reduce the efficiency of your system. To save alarm information before deleting, select Alarms > Reports tab > Alarms, then
click the Run button.

3 Using the Geographic View Proprietary and Confidential ©2026 Vertiv Group Corp. 23

Vertiv™Liebert® SiteScan™ Web Installer/User Guide



To delete an alarm, follow the below steps:

1. On the Alarms page > View tab, select an alarm's checkbox.

2. Click Delete.

To delete all alarms in the alarms database for selected categories, follow the below steps:

1. On the Alarms page > View tab in the left hand column, select the categories whose alarms you want to delete.

NOTE: Use Ctrl+click, Shift+click, or both to select multiple categories, or select the Select All checkbox.

2. Click Advanced.

3. Click Delete All Acknowledged.

To delete all closed alarm incident groups in the alarms database, follow the below steps:

An incident group contains all alarms related to a particular incident. For example, an alarm and its return-to-normal form an
alarm incident group. An incident group is considered closed when all the alarms in the group are closed.

1. On the Alarms page > View tab in the left-hand column, select the categories whose alarms you want to delete.

NOTE: Use Ctrl+click, Shift+click, or both to select multiple categories, or select the Select All checkbox.

2. Click Advanced.

3. Click Delete Closed Incidents.

NOTE: An alarm that requires acknowledgment cannot be deleted until it has been acknowledged.

To have the Vertiv™ Liebert® SiteScan™ Web application automatically delete alarm incident groups a specified
number of days after the groups close, select this option on the System Settings > Scheduled Tasks (see Scheduled
tasks tab on page 1) tab.

Also on the System Settings > Scheduled Tasks tab, you can set the Liebert® SiteScan™ Web application to archive
alarm information to a text file as alarms are deleted.

An alarm source may be set up to generate an alarm and a return to normal. If an alarm occurs but the Liebert®
SiteScan™ Web application never receives the return to normal, you can select the alarm and then click Force Normal
so that the alarm can be closed. Force Normal has no effect on the alarm condition that generated the alarm.

Receiving audible notification of alarms

The Liebert® SiteScan™ Web application can be configured to play an audio file on your workstation when it receives a critical
or non critical alarm.

1. On the System Configuration tree, select My Settings. See Changing My Settings on page 1 .

2. On the Settings tab, select Non critical alarms or Critical alarms to be notified of each type of alarm.

3. In the Sound File field, enter the path to the sound file.

When an alarm triggers the audio file to play, you can click and then select:

• Snooze to temporarily stop the sound for 5 minutes.

• Silence to stop the sound.

The alarm sound is silenced until another alarm that triggers a sound is received.
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3.5.2 Viewing a built-in, single point trend graph

1. On the Geographic tree, select the equipment whose trend you want to view.

2. Click the Trends button drop-down arrow, select Enabled Points, and then select the graph you want to view.

3. Select the View tab. See Using trend graphs on page 1.

NOTE: On the Configure tab, you can:

• Enable/disable the grid.

• Set the time range for the X-axis. For example, enter 7 days to see the data for the last week.

• Turn off autoscaling so that the user can define a range for the Y-axis.

• Enter a Y-axis label that will appear on the right side of the graph.

3.6 Using Shortcuts in the Geographic View

A toolbar with shortcuts appears directly below the menu tabs in the view pane. The icons vary according to the item you are
viewing. If power equipment is selected, the icons relate to power equipment. If cooling equipment is selected, icons related to
cooling equipment display. Table 3.7 below describes the icons.

NOTE: The toolbar icons disappear in some views. They reappear when the cursor hovers over the toolbar area.

Icon Description

System Overview: Navigates to the highest level of the geographic view tree.

Summary: Displays summary data for the equipment selected in the tree/displayed in the area graphic (in the view pane). See
Viewing a Summary Page on page 17.

Show/Hide Notes: View or add notes about the item. See Using the notes shortcut on the next page.

Area Graphic: Displays the floor plan of the selected item. See Viewing the Graphic for an Area on page 16.

Up One Level: Moves the view up one level in the tree.

Maintenance mode: Enables/Disables maintenance mode and lets you schedule maintenance for the selected equipment. See
Using maintenance mode on page 27.

Trend Graphs: Opens the trend graph for the selected item. See Using trend graphs on page 69.

Edit Page: Opens a page to view and edit the characteristics of the selected item. See Using the edit page shortcut on page 27.

Table 3.7 Shortcut Icons
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Icon Description

Area Edit. Displays an editable floor plan to moving and rename units and customize the area floor plan. See Editing an area on
the facing page.

Air Summary: Displays a summary of thermal-management units, temperature, heating, cooling, humidification, and
dehumidification. See Viewing a Summary Page on page 17.

Power Summary: Displays a summary of power status, input voltage, output (voltage and amps), load percentage, and power
factor. See Viewing a Summary Page on page 17.

Static Switch Summary: Displays a summary of static-switch status (voltage, current, and power in kVA, kW, and Hz). See
Viewing a Summary Page on page 17.

UPS Summary: Displays a summary of UPS status, bypass voltage, input voltage, battery conditions, inverter status, output
(voltage, current, and power in kVa, kW, and Hz). See Viewing a Summary Page on page 17.

Disable Notifications: Displays a list of notifications for the unit with option to disable notifications.

Pencil (only in area-edit mode): Edit item names and setpoints for selected units. See Editing an area on the facing page.

Save Changes (only in area-edit mode): Saves changes to the floor plan. See Editing an area on the facing page.

Unlock Units (only in area-edit mode). Unlocks the floor plan to move units and their labels. See Editing an area on the facing
page.

Lock Units (only in area-edit mode): Locks the floor plan to prevent moving units and labels. See Editing an area on the facing
page.

Add Object (only in area-edit mode): Opens a drop-down list of items to add to the floor plan. See Editing an area on the facing
page.

Delete Object (only in area-edit mode): Deletes an object for the floor plan. See Editing an area on the facing page.

Table 3.7 Shortcut Icons (continued)

3.6.1 Using the notes shortcut

1. With an item selected, click . The notes page opens.

2. Enter the note text.

3. Click again to return to the previous view.

NOTE: Notes remain until deleted.
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3.6.2 Using maintenance mode

To view or edit a maintenance schedule:

1. With an item selected, click .
The maintenance page opens listing the Description (name of the device) and the Maintenance Status (On or
Off).

2. Select the type of maintenance:

• Now: Enables the option to Run Maintenance Now.

• Future : Enables the option to Schedule Maintenance , and displays time and date options to schedule the
maintenance.

3. Set the Duration of maintenance for the device in hours and minutes.

4. If scheduling future maintenance, select the date and time for maintenance to begin.

5. Depending on the type of maintenance selected:

• Click Run Maintenance Now to perform maintenance immediately.

• Click Schedule Maintenanceto save and activate the maintenance schedule.

6. In the menu bar, click Accept to confirm the maintenance mode settings or Cancel to discard the changes.

3.6.3 Using the edit page shortcut

To view or change the characteristics of the selected unit or point:

1. With an item selected, click . The edit page opens.

2. Make changes as needed.

3. When finished, click Submit. To cancel changes, navigate to another page without clicking Submit.

3.6.4 Editing an area

In area edit mode, you can add, move, rename, and delete items on a floor plan.

NOTE: If any units are outside the view: CTRL+Right-click > Clear Unit Positions and reposition units as needed.

To add an object:

1. View an area graphic, and click in the shortcuts bar.

2. Click , select an object from the list, adjust the parameters, and click Apply.

3. Click to save the changes.
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To rename an object:

1. View an area graphic, and click in the shortcuts bar.

2. Click , and edit the name.

3. Click to save the changes.

To move an object:

1. View an area graphic, and click in the shortcuts bar.

2. Click to unlock the floor plan.

3. Drag the unit and/or label to the new location.

4. Click to save the changes.

5. Click to lock the floor plan and prevent unauthorized changes.

To delete an object:

1. View an area graphic, and click in the shortcuts bar.

2. Select and object to delete, then click .

3. Click to save the changes.

3.7 Alarms

An alarm is a message sent from an alarm source (usually a microblock in a control program) to the Vertiv™ Liebert®
SiteScan™ Web application to notify the user that certain conditions exist, such as a piece of equipment has stopped running
or a temperature is too high. When the Liebert® SiteScan™ Web application receives an alarm, it displays information about
the alarm on the Alarms page. It can also perform alarm actions to inform personnel of the condition and to record information
about the alarm. An alarm source can also send a return to normal message when the alarm condition returns to its normal
state.
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Figure 3.5 Alarm Configuration

Item Description

1 Start point of Alarm Process

2 Alarm Source

3 Alarm

4 Return to Normal

5 Alarm Action

Alarm sources and the alarms they generate are assigned to categories, such as HVAC Critical or HVAC Maintenance, to help
you work with related alarms.

The application engineer usually sets up alarm sources in the EIKON application. In the Vertiv™ Liebert® SiteScan™ Web
interface, you can:

• View, troubleshoot, acknowledge, and delete alarms (see Viewing, Troubleshooting, Acknowledging, and Deleting
Alarms on page 1 ).

• Set up the alarm actions that the Liebert® SiteScan™ Web application performs (see Setting up alarm actions on
the next page).

• Edit alarm sources that were set up in the EIKON application or set up new alarm sources to generate alarms
(see Setting up alarm actions on the next page).

• Customize alarms by changing the category or message (see Customizing alarms on page 49).

NOTE: The Liebert® SiteScan™ Web application features built-in system and equipment alarms in addition to the
alarms that you set up.
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3.7.1 Setting up alarm actions

The Vertiv™ Liebert® SiteScan™ Web application can perform alarm actions listed below to notify personnel of an alarm or to
record information about the alarm. You can assign alarm actions to an alarm source, a category of alarm sources, alarm
sources from a certain location, or a combination of these criteria.

The alarm actions that the Liebert® SiteScan™ Web application can perform are:

• Alarm pop-up

• Print

• Propagate To Server

• Run External Program

• Send Alphanumeric Page

• Send E-Mail

• Send SNMP Trap

• Send Web Service Request

• Write Property

• Write to Database

• Write to File

See the following topics for a description of each alarm action:

Assigning alarm actions to alarm sources

Assigning alarm actions to multiple alarm sources

Although the user can assign an alarm action to a single alarm source, at the area or equipment level, the user typically
assigns an action to multiple alarm sources. The alarm action applies to all instances of the alarm sources at the selected
location and below. Click the Edit button of Action tab to make any changes.

To assign an alarm action to alarm sources, follow the below steps:

1. On the Geographic or Network tree, select the area, equipment, or controller containing the alarm
sources.

2. On the Alarms page > Actions tab, follow the 3 steps on the screen.

NOTE: Use Ctrl+click, Shift+click, or both to select multiple items.

3. Click Add.

4. Set up the alarm action by editing the fields on the alarm action page. See the appropriate alarm action below for
field descriptions.

5. Click Accept.

Once the alarm actions are assigned to an alarm source, simulate the alarm (see Simulating an alarm on page 49) to check
your work. If an alarm action fails, the Liebert® SiteScan™ Web application receives an alarm for the failed action.

NOTE: Click View Selected Sources to view or change settings for each alarm.
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To assign an alarm action to a single alarm source, follow the below steps:

1. On the Geographic or Network tree, select the alarm source (microblock).

2. On the Alarms page > Actions tab, click the drop-down arrow, then select an alarm action.

3. Click Add.

4. Set up the alarm action by editing the fields on the alarm action page. See the appropriate alarm action below for
field descriptions.

5. Click Accept.

Alarm popup

The Alarm popup alarm action pops up a message on any computer with a Windows operating system that is running the
Vertiv™ Liebert® SiteScan™ Web Alarm Notification Client application.

Field Notes

To Operator To Group
Select individual operators or operator groups who should receive alarm notification.

NOTE: When using location dependent security, users only receive alarms for locations they are allowed to access.

Generate alarm if
delivery fails

Select this checkbox to generate a System Info alarm if the popup recipient is not currently running the Alarm Notification
Client application.

Message text
Use punctuation, spaces, or returns to format the text. To add live data to the text, select field codes (see Using field codes on
page 58) from the Append Field Code list.

Append Field Code Add field codes (see Using field codes on page 58) to the message text if needed.

Perform Action

By default, the Liebert® SiteScan™ Webapplication performs an alarm action when the alarm source generates an alarm and
when it returns to normal. Under Perform Action, you can choose to run the alarm action:

1. Only when the alarm source generates an alarm or when it returns to normal.

2. After a specified amount of time if the alarm has not been acknowledged or has not returned to normal. Use
this option for alarm escalation.

3. If the alarm occurs during the occupied hours defined for a schedule group or run if the alarm occurs during
the unoccupied hours defined for a schedule group.

Example: To have one alarm action performed during work hours and a different alarm action performed after
work hours:

• Create a schedule group, but do not assign members to it.

• Create a schedule for the group. Set the occupied hours to be the same as the work hours.

• Create the alarm action that is to be performed during work hours. Under Perform Action, select If
schedule group <your new group> is Occupied.

• Create the alarm action that is to be performed after work hours. Under Perform Action, select If
schedule group <your new group> is Unoccupied.

Table 3.8 Alarm Property

Alarm notification client application

The Alarm Notification Client application must be running on each client computer (Windows only) that should receive popup
notifications. Keep the application minimized to the right side of the Windows task bar. The window pop up with a message
when an alarm occurs.
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Select an alarm message, then click to open a web browser window displaying the piece of equipment that generated the
alarm. A grayed out alarm indicates that it was acknowledged in the Vertiv™ Liebert® SiteScan™ Web interface.

If the Alarm Notification Client is set up to play a continuous alarm sound, you can silence an alarm by clicking Silence!, by
pressing Ctrl+S, or by acknowledging the alarm in the Liebert® SiteScan™ Web interface.

Figure 3.6 Alarm Notification Client Window

Item Description

1 Browse to source equipment

2 Alarm message

Button Notes

Opens a web browser window that displays the equipment that generated the alarm.

NOTE: If SiteScan Server is to use https (SSL), you must do the following to enable communication between the server and
Alarm Notification Client. In SiteBuilder, go to Configure > Preferences > Web Server. For Enabled Web Server Ports, select Both
HTTP and SSL or SSL only. In the Server Connection field described below, enter the number of the SSL port.

If SiteScan Server is v6.0 and an Alarm Notification Client is an earlier version, you will have to login when you click .

Copies the selected alarm information to the clipboard.

Removes the alarm information from the alarm popup list. Removing items from this list has no effect on the alarms list in the Liebert®
SiteScan™ Web interface.

View information about the server connection.

Table 3.9 Alarm Notification Client Buttons
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Button Notes

On this Tab You Define

Server Connection

The Vertiv™ Liebert® SiteScan™ Web server and port, and the Liebert® SiteScan™ Web operator name
and password

NOTE: The default port is TCP 47806. If you change this, you must also change the Port field in
the Liebert® SiteScan™ Web System Settings. See To set up the SiteScan Server application to
support alarm Popup clients, follow the below steps: below.

You can use an IPv6 Server address in the Server field. In the Liebert® SiteScan™ Web interface,
in System Settings> General tab > Alarms, you can restrict access to the IPv6 address.

Browse To The Liebert® SiteScan™ Web page that you want to see first when browsing to the equipment.

Notification Sounds

• If you want to hear a sound when an alarm occurs.

• Which sound you want to hear for each type of alarm.

NOTE: A Connection Failure occurs when the Alarm Notification Client loses communication
with the SiteScan Server application.

• Whether you want the sound to continue until silenced.

NOTE: If multiple types of alarms occur simultaneously, the application plays the sound of the
most critical alarm (Connection Failure first, then Critical, then Normal).

Table 3.9 Alarm Notification Client Buttons (continued)

To set up the SiteScan Server application to support alarm Popup clients, follow the below steps:

1. On the System Configuration tree, select System Settings.

2. On the General tab, select Enable support for Alarm Notification Clients to connect to this server.

3. If the server has more than one network interface adapter, enter the IP address to which the Alarm Notification
Client application will connect in the Restrict to IP Address field. You must specify the same IP address in the
Server field in the Alarm Notification Client.

4. Use the default port or specify a different port. You must specify the same port in the Port field in the Alarm
Notification Client.

5. Click Accept.

NOTE: If the Alarm Notification Client application is not on the local network and will access Liebert® SiteScan™ Web
alarms through a NAT router, you must port forward the TCP port you defined in step 4 above.

To install the alarm notification client application, follow the below steps:

Follow the steps below on each client computer that should receive alarm popups.

Prerequisite: Enable support for Alarm Popup client in System Settings. See Alarm popup on page 31.

1. On the System Configuration tree, click Client Installs.

2. Select Alarm Notification Client.

3. Click Run, then follow the on screen instructions to install the Alarm Notification Client application. After you click
Done, the application starts automatically.

4. In the Settings dialog box, enter appropriate values. You can also click to open this box. See the Table 3.9 on
the previous page for a description of each setting.
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NOTE: You can lock the Settings so that a user cannot edit them. See Locking the settings feature of a client: below.

5. Click OK.

6. Minimize the Alarm Notification Client window.

Locking the settings feature of a client:

To lock the settings feature of a client to prevent the user from editing the settings , follow the below steps:

1. Right-click Alarm Notification Client in the Windows Start menu.

2. Select Properties.

3. On the Shortcut tab, enter -lockconfig at the end of the Target path.

Figure 3.7 Locking the Settings Feature of a Client
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3.7.2 Print

The Print alarm action prints alarm information.

Field Notes

Text Printing

Select to use the local dot-matrix printer of the Vertiv™ Liebert® SiteScan™ Web server. Text Printing will not print to a network
printer.

In the Port Name field, enter the computer port to which the printer is connected. In the Line Width field, enter the number of
characters to be printed per line.

Prints multiple alarms per page.

Graphics Printing
Select to use the default printer (local or network printer) of the Liebert® SiteScan™ Web server.

Prints one alarm per page to the default printer of the Liebert® SiteScan™ Web server.

Text to Print
Use punctuation, spaces, or returns to format the text. To add live data to the text, select field codes (see Using field codes on
page 58) from the Append Field Code list.

Perform Action

By default, the Liebert® SiteScan™ Webapplication performs an alarm action when the alarm source generates an alarm and
when it returns to normal. Under Perform Action, you can choose to run the alarm action:

1. Only when the alarm source generates an alarm or when it returns to normal.

2. After a specified amount of time if the alarm has not been acknowledged or has not returned to normal. Use
this option for alarm escalation.

3. If the alarm occurs during the occupied hours defined for a schedule group or run if the alarm occurs during
the unoccupied hours defined for a schedule group.

Example: To have one alarm action performed during work hours and a different alarm action performed after
work hours:

• Create a schedule group, but do not assign members to it.

• Create a schedule for the group. Set the occupied hours to be the same as the work hours.

• Create the alarm action that is to be performed during work hours. Under Perform Action, select If
schedule group <your new group> is Occupied.

• Create the alarm action that is to be performed after work hours. Under PerformAction, select If
schedule group <your new group> is Unoccupied.

Table 3.10 Print Alarm Action Options

Propagate to server

The Propagate to server alarm action sends the selected alarm to the parent server in a system with hierarchical servers.

Field Notes

Message text The alarm message that is sent to the parent server.

Append Field Code Add field codes (see Using field codes on page 58) to include live data in the Message text field.

Perform Action

By default, the Liebert® SiteScan™ Webapplication performs an alarm action when the alarm source generates an alarm and
when it returns to normal. Under Perform Action, you can choose to run the alarm action:

1. Only when the alarm source generates an alarm or when it returns to normal.

2. After a specified amount of time if the alarm has not been acknowledged or has not returned to normal. Use
this option for alarm escalation.

3. If the alarm occurs during the occupied hours defined for a schedule group or run if the alarm occurs during
the unoccupied hours defined for a schedule group.

Table 3.11 Propagate To Server Alarm Action Options
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Field Notes

Example: To have one alarm action performed during work hours and a different alarm action performed after
work hours:

• Create a schedule group, but do not assign members to it.

• Create a schedule for the group. Set the occupied hours to be the same as the work hours.

• Create the alarm action that is to be performed during work hours. Under Perform Action, select If
schedule group <your new group> is Occupied.

• Create the alarm action that is to be performed after work hours. Under PerformAction, select If
schedule group <your new group> is Unoccupied.

Table 3.11 Propagate To Server Alarm Action Options (continued)

Run external program

The Run External Program alarm action starts a program or batch file on the server.

NOTE: To set up this alarm action, the user must be running SiteScan Design Server.

Field Notes

Command Line
The path of the executable file on the Vertiv™ Liebert® SiteScan™ Web server followed by the path of the output file.

Example: c:\windows\notepad.exe or c:\SiteScan\webroot\alarms.txt

Append Field Code

Add field code (see Using field codes on page 58) to the Command Line field.

Example: c:\reports\run_report.bat $Generation_time$$To_State$. This starts a batch file on the server and uses the
generation time of the alarm and state as values.

Synchronize
Tells the Liebert® SiteScan™ Webapplication to wait for the external program to finish running before initiating the next Run
External Program alarm action.

Perform Action

By default, the Liebert® SiteScan™ Webapplication performs an alarm action when the alarm source generates an alarm and
when it returns to normal. Under Perform Action, you can choose to run the alarm action:

1. Only when the alarm source generates an alarm or when it returns to normal.

2. After a specified amount of time if the alarm has not been acknowledged or has not returned to normal. Use
this option for alarm escalation.

3. If the alarm occurs during the occupied hours defined for a schedule group or run if the alarm occurs during
the unoccupied hours defined for a schedule group.

Example: To have one alarm action performed during work hours and a different alarm action performed after
work hours:

• Create a schedule group, but do not assign members to it.

• Create a schedule for the group. Set the occupied hours to be the same as the work hours.

• Create the alarm action that is to be performed during work hours. Under Perform Action, select If
schedule group <your new group> is Occupied.

• Create the alarm action that is to be performed after work hours. Under PerformAction, select If
schedule group <your new group> is Unoccupied.

Table 3.12 Run External Program Alarm Action Options

Send alphanumeric page

The Send Alphanumeric Page alarm action sends a page to one or more alphanumeric pagers or sends text messages to cell
phones. The pager or phone must be able to accept e-mail.
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Field Notes

To
Enter the email address to which the alarm should be sent. To enter multiple addresses, enter a space or press enter after each
address.

From Enter a valid address if required by your mailserver.

Mail Host Address of the mailserver. This can be an IP address or a system name, such as mail.mycompany.com.

Mail Host Port Change this field if using a port other than the default port 25.

Mail Host Security
Options

Select the type of security the mailserver uses.

• Cleartext: Uses the SMTP protocol to send as clear text over TCP/IP.

• Secure SSL: Uses SSL, a communication protocol that provides data encryption.

• Secure TLS: Uses TLS, but does not begin encryption until the Vertiv™ Liebert® SiteScan™ Web application issues
STARTTLS command.

Specify Mail User
For Mail Host
Authentication

Select if your mailserver requires a username and password.

Send mail as MIME
attachment

Select if your mailserver allows only MIME attachments.

Message Text
Use punctuation, spaces, or returns to format the text. To add live data to the text, select field codes (see Using field codes on
page 58) from the Append Field Code list.

Perform Action

By default, the Vertiv™ Liebert® SiteScan™ Web application performs an alarm action when the alarm source generates an alarm
and when it returns to normal. Under Perform Action, you can choose to run the alarm action:

1. Only when the alarm source generates an alarm or when it returns to normal.

2. After a specified amount of time if the alarm has not been acknowledged or has not returned to normal. Use this
option for alarm escalation.

3. If the alarm occurs during the occupied hours defined for a schedule group or run if the alarm occurs during the
unoccupied hours defined for a schedule group. Example: To have one alarm action performed during work hours
and a different alarm action performed after work hours:

• Create a schedule group, but do not assign members to it.

• Create a schedule for the group. Set the occupied hours to be the same as the work hours.

• Create the alarm action that is to be performed during work hours. Under Perform Action, select If schedule
group <your new group> is Occupied.

• Create the alarm action that is to be performed after work hours. Under Perform Action, select If schedule
group <your new group> is Unoccupied.

Table 3.13 Send Alphanumeric Page Alarm Action Options

NOTE: This alarm action should not be assigned to frequently occurring alarms since it may cause problems on your
network or the Internet.

Securing mailserver communication using SSL or TLS

Liebert® SiteScan™ Web application requests an SSL certificate from the mailserver, before the it sends an email using SSL or
TLS. If the certificate that the Liebert® SiteScan™ Web application receives is in its list of trusted certificates, it sends the
email. If the certificate is not in the list, the Liebert® SiteScan™ Web application generates a system alarm indicating that the
email alarm action failed. If this occurs, you will need to add the certificate of mailserver to the SiteScan list of trusted
certificates of the Liebert® SiteScan™ Web application.

To secure mailserver communication using SSL or TLS:

1. Get a copy of the certificate file from the mailserver. Ask your Network Administrator for help.

2. Put the file on the Liebert® SiteScan™ Web server.
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3. On the Vertiv™ Liebert® SiteScan™ Web server, click the Windows Start button.

4. In the Search programs and files field, enter the following command:

C:\SiteScan_Web_<x.x>\bin\java\jre\bin\keytool.exe -import -trustcacerts -alias smtpserver -keystore
webserver\keystores\certkeys -file <file_path>

replacing:

<x.x> with the version number of the system.
<file_path> with the full path and file name of the certificate file.

5. The information for the smtpserver key is displayed and you are prompted to trust this certificate. Enter yes.

NOTE: If your mailserver is using SSL or TLS, theLiebert® SiteScan™ Web server is running antivirus software, and the
email alarm action fails because an SSL certificate cannot be found, try one of the following solutions:

Disable scanning of outgoing SMTP traffic in the antivirus software. For more information, consult the Help section of
your antivirus software.

Obtain the SSL certificate for the antivirus software and install it on the Liebert® SiteScan™ Web server using the
above procedure.

Setting up a dial up networking connection

The Liebert® SiteScan™ Web application can use a dial up internet connection through a modem to deliver e-mail for the Send
E-mail or Send Alphanumeric Pagealarm action.

To set up the dial up connection follow the below steps:

1. Set up your modem to dial out to your Internet Service Provider. See your modem documentation.

2. On the Liebert® SiteScan™ server, open Internet Explorer.

3. Select Tools or > Internet Options.

4. On the Connections tab, click Setup.

5. Follow the instructions in the wizard. See Windows Help for assistance.

6. In a text editor such as Windows Notepad, open SiteScan_Web_x.x\webroot\<system>\ system.properties.

7. At the end of the file, enter the following line:

repactions.connection.name=<name of connection>

where <name of connection> is the ISP name you entered in the wizard in step 2.

8. Open Internet Explorer, then select Tools > Internet Options > Connections tab.

9. If the box under Dial up and Virtual Private Network settings shows more than one connection, select the
connection that you just created, then click Set Default.

10. Select Always dial my default connection.

Send e-mail

The Send E-mail alarm action sends a message to one or more e-mail accounts. The alarm action can also run a report and
attach it to the e-mail as a PDF, HTML, or XLS file.
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Field Notes

To and CC
Enter the mail addresses to which you want to send the alarm. To enter multiple addresses, enter a space or press Enter after
each address.

Subject
Enter the text that you want to appear on the Subject line of the email. The subject can include field codes (see Using field
codes on page 58).

Use default email server
configuration

Check this field to have this alarm action use the email server configuration settings defined on the System Settings> General
tab. Uncheck to enter settings specific to this alarm action.

From Enter a valid address if required by your mail server.

Mail Host Address of the mailserver. This can be an IP address or a system name, such as mail.mycompany.com.

Mail Host Port Change this field if using a port other than the default port 25.

Mail Host Security
Options

Select the type of security the mailserver uses.

• Cleartext (SMTP): Uses the SMTP protocol to send as clear text over TCP/IP.

• Secure SSL (SMTP with SSL): Uses SSL, a communication protocol that provides data encryption.

• Secure TLS (STARTTLS): Uses TLS, but does not begin encryption until the Liebert® SiteScan™ Web
application issues STARTTLS command.

Specify Mail User For Mail
Host Authentication

Select if your mailserver requires a username and password.

Send mail as MIME
attachment

Select if your mailserver allows only MIME attachments.

Message Text
Use punctuation, spaces, or returns to format the text. To add live data to the text, select field codes (see Using field codes
on page 58) from the Append Field Code list.

Attach Report

Select to attach a report to the e-mail, then select the Report and the Format. The attached report will include the date and
time. For example, Alarm Sources 2017 Jan 01 1230.

NOTE: The Report Name field shows a custom report only if it is accessible at the current level.

Run as shows the name and login name of the operator creating the alarm action. The report will be run using the privileges
and report options of this operator.

NOTE: For this purpose, you might want to create a new operator with limited privileges.

Perform Action

By default, the Liebert® SiteScan™ Web application performs an alarm action when the alarm source generates an alarm and
when it returns to normal. Under Perform Action, you can choose to run the alarm action:

1. Only when the alarm source generates an alarm or when it returns to normal.

2. After a specified amount of time if the alarm has not been acknowledged or has not returned to normal. Use
this option for alarm escalation.

3. If the alarm occurs during the occupied hours defined for a schedule group or run if the alarm occurs during
the unoccupied hours defined for a schedule group.
Example: To have one alarm action performed during work hours and a different alarm action performed
after work hours:

• Create a schedule group, but do not assign members to it.

• Create a schedule for the group. Set the occupied hours to be the same as the work hours.

• Create the alarm action that is to be performed during work hours. Under Perform Action, select If
schedule group <your new group> is Occupied.

• Create the alarm action that is to be performed after work hours. Under Perform Action, select If
schedule group <your new group> is Unoccupied.

Table 3.14 Send E-mail Alarm Action Options
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NOTE: This alarm action should not be assigned to frequently occurring alarms since it may cause network or Internet
problems.

Securing mailserver communication using SSL or TLS

Before the Vertiv™ Liebert® SiteScan™ Web application sends an email using SSL or TLS, it requests an SSL certificate from
the mailserver. If the certificate that the Liebert® SiteScan™ Web application receives is in its list of trusted certificates, it
sends the email. If the certificate is not in the list, the Liebert® SiteScan™ Web application generates a system alarm indicating
that the email alarm action failed. If this occurs, you will need to add the certificate of the mailserver to the list of trusted
certificates of the Liebert® SiteScan™ Web application.

To secure mailserver communication using SSL or TLS:

1. Get a copy of the certificate file from the mailserver. Ask your Network Administrator for help.

2. Put the file on the SiteScan server.

3. On the SiteScan server, click the Windows Start button.

4. In the Search programs and files field, enter the following command:

C:\SiteScan_Web_<x.x>\bin\java\jre\bin\keytool.exe -import -trustcacerts -alias smtpserver -keystore
webserver\keystores\certkeys -file <file_path>

replacing:

<x.x> with the system's version number
<file_path> with the full path and file name of the certificate file

5. The information for the smtpserver key is displayed and you are prompted to trust this certificate. Enter yes.

NOTE: If your mailserver is using SSL or TLS, the SiteScan server is running antivirus software, and the email alarm
action fails because an SSL certificate cannot be found, try one of the following solutions:

Disable scanning of outgoing SMTP traffic in the antivirus software. For more information, consult the Help section of
your antivirus software.

Obtain the SSL certificate for the antivirus software and install it on the SiteScan server using the above procedure.

Send SNMP trap

The Send SNMP Trap alarm action sends an SNMP trap in response to receive an alarm. Traps contain the text created in the
Text to send as the SNMP Trap field in the alarm action dialog box. You can configure up to five SNMP servers to receive
traps.

NOTE: Liebert® SiteScan™ Web supports SNMP v1.

Each SNMP server you want to receive these traps must have SNMP monitoring equipment installed. If problems arise
with your SNMP connection or receiving traps, contact your IS department.

This alarm action uses Port 162 to send SNMP traps. To use a different port, open SiteScanx.x\webroot\<system_
name>\system.properties in a text editor such as Notepad. In the line #snmp.trap.port = 162, delete # at the beginning
of the line and change 162 to the port you want to use. If you make this change while the Liebert® SiteScan™ Server
application is running, you must restart it to have the change take effect.
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Field Notes

Network Address* The network address of the SNMP server receiving the SNMP trap.

Community Name* The community name to which the SNMP server belongs.

Comment The physical location of the SNMP server. This field is optional.

Trap number*
If the network administrator has configured trap numbers, enter a unique number from 1 to 127.

NOTE: The same trap number is used for all messages from this alarm action.

Text to send as the
SNMP Trap

255 character limit. Enter punctuation, spaces, or returns after the entries to format the message. You can customize this text
by selecting field codes (see Using field codes on page 58) from the Append Field Code list.

Perform Action

By default, the Vertiv™ Liebert® SiteScan™ Webapplication performs an alarm action when the alarm source generates an
alarm and when it returns to normal. Under Perform Action, you can choose to run the alarm action:

1. Only when the alarm source generates an alarm or when it returns to normal.

2. After a specified amount of time if the alarm has not been acknowledged or has not returned to normal. Use
this option for alarm escalation.

3. If the alarm occurs during the occupied hours defined for a schedule group or run if the alarm occurs during
the unoccupied hours defined for a schedule group.

Example: To have one alarm action performed during work hours and a different alarm action performed after
work hours:

• Create a schedule group, but do not assign members to it.

• Create a schedule for the group. Set the occupied hours to be the same as the work hours.

• Create the alarm action that is to be performed during work hours. Under Perform Action, select If
schedule group <your new group> is Occupied.

• Create the alarm action that is to be performed after work hours. Under Perform Action, select If
schedule group <your new group> is Unoccupied.

NOTE: * Ask your network administrator for this information.

Table 3.15 Send SNMP Trap Alarm Action Options

Send web service request

The Web Service Request alarm action sends a web service request to a third-party server when an alarm event occurs. For
example, the Liebert® SiteScan™ Web application could send a request to a work order system so it could create a work order
for someone to respond to the alarm condition.

Field Notes

Destination
Address

The URL of the server that will receive the request.

Example: https://192.168.168.102/workorder/bas

Web Service
Action

Select the type of web service request required by the target server: GET or POST

Content Type
If you selected POST in the previous field, select the format required by the target server:

Application/json   or   /x-www-form-urlencoded

Web Service
Request
Parameters

Optional: Create a parameter for each piece of information that the target server requires. You should be able to find information
about required parameters in the documentation for target server.

Parameter Name Enter a name for the parameter. For example, Parm1 or Date.

Table 3.16 Web Service Request Alarm Action Options
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Field Notes

Click Add Parameter.

Value
Text required for the parameter. To add live data to the request, select a field code (see Using field codes on page 58) from the
Append Field list.

Perform Action

By default, the Vertiv™ Liebert® SiteScan™ Webapplication performs an alarm action when the alarm source generates an alarm and
when it returns to normal. Under Perform Action, you can choose to run the alarm action:

1. Only when the alarm source generates an alarm or when it returns to normal.

2. After a specified amount of time if the alarm has not been acknowledged or has not returned to normal. Use this
option for alarm escalation.

3. If the alarm occurs during the occupied hours defined for a schedule group or run if the alarm occurs during the
unoccupied hours defined for a schedule group.
Example: To have one alarm action performed during work hours and a different alarm action performed after work
hours:

• Create a schedule group, but do not assign members to it.

• Create a schedule for the group. Set the occupied hours to be the same as the work hours.

• Create the alarm action that is to be performed during work hours. Under Perform Action, select If schedule
group <your new group> is Occupied.

• Create the alarm action that is to be performed after work hours. Under Perform Action, select If schedule
group <your new group> is Unoccupied.

Table 3.16 Web Service Request Alarm Action Options (continued)

Write property

The Write Property alarm action writes a specified value to a BACnet property. You typically set up 2 alarm actions, the first
writes a value when the alarm occurs and the other writes a value when the return to normal occurs.

Field Notes

Expression

Enter the path to the target property. To get the path, right-click the property on a Properties page, then select Global Modify. The
Geographic Location field in the Advanced section shows the path. Click to copy it.

NOTE: The present value of a BACnet parameter microblock cannot be written to directly. However, you can change the present
value by writing to the relinquish_default property, or to the priority_array/priority16 property.
For example, change #rtu-1/vfd_ovrde/present_value  to #rtu-1/vfd_ovrde/relinquish_default,   

or #rtu-1/vfd_ovrde/priority_array/priority16.

Do not use a BACnet address in this field.

Value to Write Enter the value you want to write to the microblock property. Enter 0 or 1 for a binary property.

Append field
code to value

Select field codes (see Using field codes on page 58) to add this information to the Value to Write field.

Perform
Action

By default, the Liebert® SiteScan™ Webapplication performs an alarm action when the alarm source generates an alarm and when it
returns to normal. Under Perform Action, you can choose to run the alarm action:

1. Only when the alarm source generates an alarm or when it returns to normal.

2. After a specified amount of time if the alarm has not been acknowledged or has not returned to normal. Use this option
for alarm escalation.

3. If the alarm occurs during the occupied hours defined for a schedule group or run if the alarm occurs during the
unoccupied hours defined for a schedule group.
Example: To have one alarm action performed during work hours and a different alarm action performed after work hours:

• Create a schedule group, but do not assign members to it.

Table 3.17 Write Property Alarm Action Options
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Field Notes

• Create a schedule for the group. Set the occupied hours to be the same as the work hours.

• Create the alarm action that is to be performed during work hours. Under Perform Action, select If schedule
group <your new group> is Occupied.

• Create the alarm action that is to be performed after work hours. Under Perform Action, select If schedule group
<your new group> is Unoccupied.

Table 3.17 Write Property Alarm Action Options (continued)

Write to database

The Write to Database alarm action stores alarm information in the tabular form in the Vertiv™ Liebert® SiteScan™ Web alarm
database or in a custom database. Third party applications can access the alarm information for building maintenance
management or alarm analysis. For example, an application can perform actions such as triggering a stored procedure or
running a report.

Writing to the Liebert® SiteScan™ Web alarm database

By default the Liebert® SiteScan™ Web application writes alarm information to the write_db_ra table in the Liebert® SiteScan™
Web alarm database when you add the Write to Database alarm action. The information written to the database is described
in the Table 3.18 below, along with the column name and data type you will need to access the alarm data from a third-party
application.

Description Column Name Data type

Alarm generation time EVENT_TIME_ Datestamp

Path to the alarm source Example:  #slm/m073 SOURCE_PATH_ String

Display name path to the alarm source Example:  Atlanta Office/R&D Facility/Second Floor/VAV 2-
1/Zone Temp

DISPLAY_NAME_ String

Alarm state Example: OFF NORMAL, LOW LIMIT, HIGH LIMIT EVENT_STATE_ String

Alarm text as defined in the Text to write to the database field on the alarm action page. You can add live data
to the text by selecting field codes (see Using field codes on page 58) from the Append Field Code list.

RA_TEXT_ String 

Table 3.18 Database Information

Field Notes

Perform
Action

By default, the Liebert® SiteScan™ Webapplication performs an alarm action when the alarm source generates an alarm and when it returns
to normal. Under Perform Action, you can choose to run the alarm action:

1. Only when the alarm source generates an alarm or when it returns to normal.

2. After a specified amount of time if the alarm has not been acknowledged or has not returned to normal. Use this option for
alarm escalation.

3. If the alarm occurs during the occupied hours defined for a schedule group or run if the alarm occurs during the unoccupied
hours defined for a schedule group.
Example: To have one alarm action performed during work hours and a different alarm action performed after work hours:

• Create a schedule group, but do not assign members to it.

• Create a schedule for the group. Set the occupied hours to be the same as the work hours.

• Create the alarm action that is to be performed during work hours. Under Perform Action, select If schedule group
<your new group> is Occupied.

• Create the alarm action that is to be performed after work hours. Under PerformAction, select If schedule group
<your new group> is Unoccupied.

Table 3.19 Write to Database Alarm Action Options
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NOTE: Use a third party database application to delete old entries to keep the database table from becoming too
large. The Liebert® SiteScan™ Web interface does not allow you to view, edit, or delete entries.

If your system uses an Access or Derby database, you cannot open the database in a third party application while the
Vertiv™ Liebert® SiteScan™ Web or SiteBuilder application is running.

Writing to a custom database

The Liebert® SiteScan™ Web application can write alarm information to the following types of custom databases. The custom
database does not have to be the same enter the Liebert® SiteScan™ Web database.

• SQL Server

• MySQL

• PostgreSQL

• Oracle

You may create a table in an existing third party database or create a new database.

Using your database management tool, create a table in your custom database that includes fields for each alarm field code to
be written to the table. Each field length in the table should be as long as the longest value to be written to that field.

To set up writing to a custom database instead of the Liebert® SiteScan™ Web alarm database, select the Specify Custom
Database checkbox on the Alarms page Actions tab, then enter information in the remaining fields. See Table 3.20 below.

Field Notes

Text to write to
the database

The text is made up of field codes (see Using field codes on page 58) that add live data to the text. You can select additional field
codes from the Append Field Code list.

NOTE: To write the text in this field to the custom database, you must include the Report Text field code ($report_text$) in
the Database Insert String field described below.

Database
Connect String

Database Type:

• SQL Server

• MySQL

• PostgreSQL

• Oracle

Connect String Format:

• jdbc:odbc:<odbc_alias>

• jdbc:mysql://<host>:<port>/<instance>

• jdbc:postgresql://<host>:<port>/<instance>

• jdbc:oracle:thin@<host>:<port>/<instance>

Where:

• <host> is the database server name/IP address

• <port> is the port number for the database

• <instance> is the database name in the database
server

• <odbc_
alias> is the name of the ODBC data source

Database Login
and Password

The login and password to connect to the database.

Database Insert
String

Use the following format:

Insert into <TABLE_NAME> (<column1_name>, <column2_name> ...) values (<$field_code1$>, <$field_code2$>, ...)

Example: Insert into SiteScan_ALARMS (TIME_, LOCATION_, TO_STATE_, TEXT_) values ($generation_time$, $location_path$, $to_
state$, $report_text$)

NOTE: You can add field codes (see Using field codes on page 58) to the Insert String using the Append Field Code list.

Table 3.20 Write to Custom Database Alarm Action Options
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Field Notes

If you add a time stamp type field code (for example, $generation_time$), you should have the data go into a timestamp data
type field in the custom database. Otherwise, you must use field code formatting (see Using field codes on page 58) to format
the time.

Perform Action

By default, the Vertiv™ Liebert® SiteScan™ Webapplication performs an alarm action when the alarm source generates an alarm and
when it returns to normal. Under Perform Action, you can choose to run the alarm action:

1. Only when the alarm source generates an alarm or when it returns to normal.

2. After a specified amount of time if the alarm has not been acknowledged or has not returned to normal. Use this
option for alarm escalation.

3. If the alarm occurs during the occupied hours defined for a schedule group or run if the alarm occurs during the
unoccupied hours defined for a schedule group.
Example: To have one alarm action performed during work hours and a different alarm action performed after work
hours:

• Create a schedule group, but do not assign members to it.

• Create a schedule for the group. Set the occupied hours to be the same as the work hours.

• Create the alarm action that is to be performed during work hours. Under Perform Action, select If schedule
group <your new group> is Occupied.

• Create the alarm action that is to be performed after work hours. Under Perform Action, select If schedule
group <your new group> is Unoccupied.

Table 3.20 Write to Custom Database Alarm Action Options (continued)

Write to file

The Write to File alarm action can do either of the following:

• Record alarm information in a standard ASCII text file that you can view and edit using a text editor such as
Windows Notepad.

• Write a report to a file.
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Field Notes

File Name

Path name for the file you want to write to such as:
c:\SiteScanx.x\webroot\alarms.txt.

• If you do not specify a path, the file is written to the system folder.

• If you enter a path that does not exist, the Vertiv™ Liebert® SiteScan™ Web application will create the
necessary folders.

• You can write to one of the following:

• A file on the server

• A networked computer if you map the network drive. Use the drive mapping in the path from the
server to the computer.

• The path name may contain field codes (see Using field codes on page 58).

Write alarm data

Select to record alarm information in a text file.

Select Append to add new alarm information to the end of the file instead of writing over existing data.

NOTE: Because you can append new alarm information to the end of the file, this file can become very large. You must
back up and delete this file frequently if you are using this alarm action with many alarms. The file size can become
very large as you can append new alarm information to the end of the file.

In the field Text to write to the file, enter the information you want to record for an alarm. Use punctuation, spaces, or returns to
format the text. To add live data to the text, select field codes (see Using field codes on page 58) from the Append Field Code
list.

Write a Report

Select to write a report to a file, then select the Report and the Format.

NOTE: The Report Name field shows a custom report only if it is accessible at the current level.

Run as shows the name and login name of the operator creating the alarm action. The report will be run using the privileges
and report options of this operator.

NOTE: For this purpose, you might want to create a new operator with limited privileges.

Perform Action

By default, the Liebert® SiteScan™ Webapplication performs an alarm action when the alarm source generates an alarm and
when it returns to normal. Under Perform Action, you can choose to run the alarm action:

1. Only when the alarm source generates an alarm or when it returns to normal.

2. After a specified amount of time if the alarm has not been acknowledged or has not returned to normal. Use
this option for alarm escalation.

3. If the alarm occurs during the occupied hours defined for a schedule group or run if the alarm occurs during
the unoccupied hours defined for a schedule group.
Example: To have one alarm action performed during work hours and a different alarm action performed after
work hours:

• Create a schedule group, but do not assign members to it.

• Create a schedule for the group. Set the occupied hours to be the same as the work hours.

• Create the alarm action that is to be performed during work hours. Under Perform Action, select If
schedule group <your new group> is Occupied.

• Create the alarm action that is to be performed after work hours. Under Perform Action, select If
schedule group <your new group> is Unoccupied.

Table 3.21 Write to File Alarm Action Options

3.7.3 Setting up an alarm source in the Liebert® SiteScan™ Web interface

The application engineer usually sets up alarm sources in the EIKON application. In the Liebert® SiteScan™ Web application,
you can:

• Edit settings of an existing alarm source or set up a new alarm source to generate alarms.
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• On the Alarm Sources > Properties page page of the equipment, set up all alarms for a piece of equipment at
once.

• Simulate an alarm to test its setup.

Two types of microblocks generate alarms in control programs.

• Alarm microblocks include logic that considers conditions such as space occupancy.

• I/O point microblocks can generate an alarm when the present value exceeds defined limits (analog) or when the
present value changes to an off normal state (binary). This type of microblock is typically set up for analog points
to generate alarms for sensor failure.

Alarm microblocks and I/O microblocks can have similar names. So, when you are going to enable an alarm source, first look

for an alarm microblock on the Geographic or Network tree.

Microblock Type Appearance on the Geographic or Network Tree

Table 3.22 Microblock Appearance on Geographic and Network Tree

Setting up, editing, or disabling alarm sources

To set up, edit, or disable a single alarm source, follow the below steps:

NOTE: On the Geographic or Network tree, select the alarm source (microblock).

1. Click Alarms, then select the Enable/Disable tab.

2. Make changes to the fields as needed. The fields can vary for different types of alarm sources. See Table 3.23 on
the next page.

3. Click Accept.

NOTE: To set up all the alarms for a piece of equipment at once, click Properties, then select Alarm Sources.
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Field Notes

Potential alarm source Check to enable the alarm source to generate alarms. Uncheck to disable the alarm source.

Alarm

Check to have the alarm source generate an alarm when the specified conditions occur.

• For a binary input, enter the conditions for generating an alarm.

• For an analog input, type the low and high limits that, when exceeded, will generate an alarm.

Deadband: The amount inside the normal range by which an alarm condition must return before a return to normal
notification is generated.

Example:

NOTE: If Status is checked, the alarm condition currently exists.

Return to Normal Check to have the alarm source generate a return to normal when the alarm condition returns to a normal state.

Alarm requires
acknowledgment

Check to have the Vertiv™ Liebert® SiteScan™ Web application require that an operator acknowledge the alarm.

Return requires
acknowledgment

Check to have the Liebert® SiteScan™ Webapplication require that an operator acknowledge the return to normal.

Classified as critical

This property determines the color of the system wide alarm button when the alarm comes in.

- Critical

- Non critical

Event State

The current state of the alarm source can be:

• Normal: The value is normal.

• Off Normal: The value is not normal (binary only).

• Fault: The alarm source microblock may be misconfigured.

• High Limit: The value exceeds the normal range (analog only).

• Low Limit : The value is below the normal range (analog only).

BACnet Configuration:

Dial on alarm

Check to have this alarm immediately delivered through a modem connection.

NOTE: When monitoring your system through a modem connection, non-critical alarms are stored in the gateway until
one of the following happens:

• A critical alarm occurs.

• The gateway is contacted by the Liebert® SiteScan™ Web application.

• The gateway buffer is full, at which time all alarms are sent to the Liebert® SiteScan™ Web application.

Notification Class Do not change this field.

Table 3.23 Alarm Source List
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To set up, edit, or disable multiple alarm sources simultaneously, follow the below steps:

1. On the Geographic or Network tree, select the area, equipment, or controller containing the alarm
sources.

2. Click Alarms, then select the Enable/Disable tab.

3. In step 1 , select the categories that contain the alarm sources.

NOTE: In step 1 and step 2 , Ctrl+click, Shift+click, or both to select multiple items, or check Select All.

4. In step 2 , select the alarm sources.

5. Make appropriate changes in step 3 .

6. Click Accept.

NOTE: Click View Selected Sources to view or change settings for each alarm.

Simulating an alarm

To test the setup of an alarm source and its alarm actions (see Setting up alarm actions on page 30), you can simulate an
alarm or its return to normal.

To simulate an alarm:

1. On the Geographic tree, select the alarm source ( , but not ) whose alarm you want to simulate.

2. On the Alarms > Enable/Disable tab, check Enable next to Alarm or Return to Normal.

3. Click Simulate next to Alarm or Return to Normal.

4. Select the equipment on the tree, then select the View tab to see the alarm.

Viewing all instances of an alarm source

To find all instances of an alarm source at and below a selected area:

1. On the Geographic or Network tree, select an area.

2. Select the Message, Actions, Enable/Disable, or Category tab.

3. Select an alarm source from the list in step 2.

4. Click View Selected Sources.

Each path in the dialog box links to the alarm source microblock.

NOTE: It is possible to change the settings that relate to the tab you selected.

3.7.4 Customizing alarms

Each alarm source has an alarm message, category, and template defined in the EIKON application. You can change
messages and categories in the Vertiv™ Liebert® SiteScan™ Web application.
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Alarm messages

An alarm message is the information that appears on the Alarms page View tab for an alarm. An alarm message can consist of
3 parts.

Figure 3.8 Alarm Message

Item Description

1 Prefix and Text make up the alarm message you see without double clicking the alarm.

2 Text defined in the control program.

You can edit Text only at the alarm source in the EIKON application.

Prefix and Details are hierarchical. They apply at the location where they are added and to all its children. For example, you
could enter Details at the system level to show the acknowledge time for alarms in the HVAC Critical category. The
acknowledge time would then be in any HVAC critical alarm message in the system.

NOTE: An alarm action can have a different message from the alarm message seen on the View tab. To edit the
message for a particular alarm action, see Setting up alarm actions (see Setting up alarm actions on page 30).

To edit the message for an alarm source, follow the below steps:

1. On the Geographic tree, select the alarm source (microblock).

2. Click Alarms, then select the Messages tab.

NOTE: Sample Alarm Message and Sample Return Message show the messages as they are currently defined.

3. Do the following as needed:

• Edit the Text for Alarm or Return. You can add live data to the text by selecting field codes (Using field
codes on page 58) from the Append Field Code list.

• Click the Edit button to edit Message Prefix or Message Details.

• In the drop-down list to the right of Message formation, select Add new prefix to beginning of message or
Add new details to end of message, then click Add.

4. Click Accept.
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To add a prefix or details for multiple alarm sources, follow the below steps:

1. On the Geographic or Network tree, select the area, equipment, or controller containing the alarm
sources.

2. Click Alarms, then select the Messages tab.

3. In step 1 , select the categories that contain the alarm sources whose messages you want to edit.

NOTE: In step 1 and step 2 , Ctrl+click, Shift+click, or both to select multiple items, or check Select All.

4. In step 2 , select the alarm sources.

5. In step 3 , select Add new prefix to beginning of message or Add new details to end of message.

6. Click Add.

7. Enter text and add field codes as needed.

8. Click Accept.

Alarm categories

Alarm categories sort related alarm sources and their alarms into groups such as HVAC Critical and Access Control General.
Alarm categories allows you to do the following:

• View, acknowledge, or delete selected categories of alarms (see Viewing a built-in, single point trend graph on
page 25) received by the Vertiv™ Liebert® SiteScan™ Web application.

• Assign alarm actions (see Setting up alarm actions on page 30) to selected categories of alarm sources.

• Set up alarm sources (see Setting up an alarm source in the Liebert® SiteScan™ Web interface on page 46) in
selected categories.

Each alarm source is assigned to an alarm category in either the EIKON application or in the Liebert® SiteScan™ Web
interface.

In addition to the default alarm categories in your system, you can create custom categories if needed. If you create a custom
category in the EIKON application, you must create the same category in the Liebert® SiteScan™ Web interface. The
Reference Name must be identical in both applications.

To assign alarm sources to a category in the Liebert® SiteScan™ Web interface, follow the below steps:

1. On the Geographic or Network tree, select the area, equipment, or controller containing the alarm
sources.

2. Click Alarms, then select the Category tab.

3. In step 1 , select the category that currently contains the alarm sources.

NOTE: In step 1 and step 2 , Ctrl+click, Shift+click, or both to select multiple items, or check Select All.

4. In step 2 , select the alarm sources whose category you want to change.

5. In step 3 , select a category from the drop-down list, then click Change.

6. Click Accept.

To add a custom alarm category , follow the below steps:

1. On the System Configuration tree, click to the left of Categories.
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2. Click Alarm.

3. Click Add. See Table 3.24 below.

4. Click Accept.

Field Notes

Reference Name
It must be unique in the database, lowercase, and not contain any spaces. This name must be identical
to the name of the custom alarm category that you added in the EIKON application.

Icon

Enter /_common/lvl5/graphics/event_categories/<file_name>.gif, replacing <file_name> with the name
of the icon file you want to use.

The event_categories folder contains the following alarm icons:

Icons used in the SiteScan interface:
Icons available for custom categories:

NOTE: * Represents critical, maintenance, general, or closed.

You can create your own 24 x 24 pixel icon (.gif or .png) and store it in the event_categories folder. However, your custom file will not be
transferred during a Vertiv™ Liebert® SiteScan™ Web upgrade, so you will need to copy the file to the new install directory after the upgrade.

Table 3.24 Interface Details

If you upgraded alarms from v2.0 or earlier

All v2.5 and later alarms use one template called Universal. This template lets you define your alarm message text, the critical
setting, and the required acknowledgments at the alarm source in the EIKON or Vertiv™Liebert® SiteScan™ Web application.

Templates in upgraded systems
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If you upgraded your system from v2.0 or earlier, the alarm sources retained their existing templates and existing alarm
settings. If the existing alarm sources contain little or no customization to the alarm settings, Vertiv recommends that you
change all of the alarms to use the Universal template. If the alarm sources had customized alarm settings, continue using the
existing templates.

To assign a different template to alarm sources, follow the below steps:

Prerequisite: The Alarms Template tab must be visible. If it is not, on the System Configuration tree, select Privilege
Sets, then check Maintain Alarm Templates.

1. On the Geographic tree, select the piece of equipment containing the alarm sources to be changed.

2. Click Alarms, then select the Template tab.

3. Follow the 3 steps on the screen.

NOTE: Use Ctrl+click, Shift+click, or both to select multiple items.

4. Click Change.

5. Click Accept.

NOTE: To change all alarms in the system simultaneously, go to the system level and then select all categories and all
alarm sources on the Templates tab.

Adding an alarm template:

1. On the System Configuration tree, select Alarm Templates.

2. Click Add.

3. Select Source based (a v2.5 template) or Stand alone (a pre-v2.5 template), then click OK.

4. Edit the template fields as needed. See Table 3.25 below.

5. Click Accept.

Field
Template

Type
Notes

Reference Name All
It must be unique in the database, be lowercase, and not contain any spaces. This name must be identical to the
name of the template in the EIKON application.

Display Name All The name that will appear in the Vertiv™ Liebert® SiteScan™ Web interface for this template.

Alarm Message Source based The message text displayed on the View tab or in the alarm action when an Alarm requires acknowledgment.

Return Message Source based
The message text displayed on the View tab or in the alarm action when a return to normal requires
acknowledgment.

Fault Message Source based The message text displayed on the View tab or in the alarm action when a Fault requires acknowledgment.

Critical Stand alone Select if this is a template you will use with a critical alarm.

Acknowledgement
Required

Stand alone Select which alarm states require an acknowledgment.

Out of Range Stand alone Analog inputs and outputs that have low and high limit alarm properties.

Table 3.25 Adding an Alarm Template
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Field
Template

Type
Notes

Click to the left of Out of Range to make changes to the alarm messages displayed on the Alarms page >

View tab. Short text is the message displayed when the alarm is not expanded. Long text is the message
displayed when the alarm is double clicked and expanded.

Change of State Stand alone
Binary inputs and alarm microblocks.

See Out of Range on the previous page to change the alarm messages.

Copy Field Code to
Clipboard

Stand alone

To add a field code to any of the message text fields:

1. Select a field code to copy it.

2. Click in the appropriate text field where you want the field code.

3. Press Ctrl+V to paste the field code.

Table 3.25 Adding an Alarm Template (continued)

3.7.5 Defining Vertiv™ Liebert® SiteScan™ Web paths

A path tells the Liebert® SiteScan™ Web application the route through the system hierarchy to an item in the system. For
example, a path tells the Liebert® SiteScan™ Web application where to find a microblock property value to display on a
graphic or where to jump to when the operator clicks a link on a graphic.

In Liebert® SiteScan™ Web, you use paths in:

• The source field code (Using field codes on page 1) in alarm actions and messages.

• An Equipment Values report (Creating an equipment values report on page 1).

• The go manual command (Defining Vertiv™ Liebert® SiteScan™ Web paths above).

• Custom reports (Custom Reports on page 1 ).

You can do one of the following to get the path:

• In the Liebert® SiteScan™ Web interface, determine the path yourself (Determining a path or microblock property
on page 57).

A path consists of the reference name of each tree item included in the path, separated by a forward slash (/). For example,
first_floor/zone_1/lstat.

A path can be absolute (Absolute path on the facing page) or relative (Relative path on the facing page).

Liebert® SiteScan™ Web paths are based on parent-child hierarchy. In the tree below, the Lobby is a child of First Floor, and
First Floor is a child of Atlanta R&D Facility. Conversely, Atlanta R&D Facility is the parent of First Floor, which is the parent of
Lobby.
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Figure 3.9 A System in the Liebert® SiteScan™ Web Interface

Figure 3.10 Same System in SiteBuilder Showing Reference Names in Blue

Absolute path

An absolute path begins at a specific point in the system hierarchy and is followed by the children below it down to the object
or property of interest. An absolute path can begin with either of the following:

• A global reference name a reference name that is unique within the entire system and begins with a # sign.

Example: If OA Conditions has a global reference name of #oa_conditions, the absolute path to OA Conditions is
simply #oa_conditions. The absolute path to any child of OA Conditions, such as OA Temperature, begins with
#oa_conditions. For example, #oa_conditions/oa_temp.

• The top of the Vertiv™ Liebert® SiteScan™ Web tree.

Example: (using the system in the figure above) To display the Lobby’s zone temperature on any graphic, the
absolute path is /trees/geographic/atlanta_-_rd_facility/first_floor/zone_1/lstat.

Relative path

A relative path is useful for items such as graphics or alarm messages that you will reuse in multiple Liebert® SiteScan™ Web
locations because the path is relative to the item that contains the path.

A Relative Path Going Down the Tree:
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A relative path going down the tree begins with the reference name of the item below the location where the path is used.
Examples using the system shown above:

• To display zone temperature of the Lobby on the Lobby graphic, the path is rs.

• To display zone temperature of the Lobby on the Atlanta-R&D Facility graphic, the path is first_floor/zone_1/rs.

A relative path going up the tree:

A relative path going up the tree begins with a ~ followed by one of the options shown in Table 3.26 below:

Use To Go Examples Using the System Shown Above

~parent Up one level

1. To put a link on the Lobby graphic that goes to the First Floor graphic,
the path is ~parent.

2. To put a link on the Lobby graphic that goes to the Atlanta R&D
Facility (up 2 levels), the path is ~parent/~parent.

3. To display the Lobby’s zone temperature on the Boiler graphic, the
path is ~parent/~parent/ first_floor/zone_1/lstat/present_value.

~equipment To the control program of microblock
To display the Lobby zone temperature in a High Temp alarm message, the path is
~equipment/lstat/present_value.

~device
From a control program in the Geographic tree
to its device in the Network tree.

To show the device name on an equipment graphic, use ~device.display-name.

~network
From a location in the Network tree up to its
network (IP, ARCNET, and so on)

1. To show the network name on an equipment graphic,
~device/~network.display-name.

2. To show the network number on a dead module alarm, use the
following field code and path: $source:~network.network-number$.

~geo
From a control program in the Network tree to
the same item in the Geographic tree.

Use the manual command go ~geo.

~net
From a control program in the Geographic tree
to the same item in the Network tree.

Use the manual command go ~net.

~instance(#)
To sibling equipment within a multi-equipment
device

See the system shown below. To display the Boiler Plant outdoor air temperature on
the Chiller Plant graphic, the path is ~instance(2)/oat/present_value.

Table 3.26 Relative Path

Relative path to heat, cool, demand, or custom source values

To get a heat, cool, demand, or custom source value, use one of the following relative paths, replacing xxx with the reference
name of the point you want to display and yyy with the reference name of a custom tree.

~heat/~parent/~geo/xxx

~cool/~parent/~geo/xxx

~dem/~parent/~geo/xxx
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~changetree(yyy)/~parent/~geo/xxx

NOTE: You must do the following before you can display a source value using the above paths. In the EIKON
application, configure Analog Status microblocks in the child control program for outgoing heat, cool, and run
requests. Also configure Total, Minimum, and Maximum microblocks for the incoming requests in the parent control
program. In SiteBuilder, assign your child equipment to its parent on the Heat Source or Cool Source tab.

Relative path to prime variables and thermographic colors

• To get a prime variable, use the relative path ~prime. The control program must contain a Prime Variable
microblock.

• To get a thermographic color, use the relative path ~color. The control program must contain a Setpoint or Set
Color If True microblock.

Determining a path or microblock property

A path tells the Vertiv™Liebert® SiteScan™ Web application the route through the system hierarchy to an item in the system.
Paths are used in graphics, links, alarm messages, alarm actions, network microblock address, autopilot, and other items.

Getting the path to an area, equipment, or microblock

In the Liebert® SiteScan™ Web interface, right-click the item on the tree, then select Copy Path. Paste the path where you
need it.

Getting the path to a microblock property value:

1. In the Liebert® SiteScan™ Web interface, right click the value, then select Global Modify.

2. Click Show Advanced to see the full path to the property value and the Edit Privilege associated with the
property.
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Figure 3.11 Global Modify Window

Item Description

1 Microblock

2 Property

3 Copies expression to Windows Clipboard

4 Location

5 Full absolute Path

6 Click and drag this divider down to see the view and edit privileges

3.7.6 Using field codes

Use field codes to insert live data into:

• The message on an alarm action.

• Text displayed on the Alarms page > View tab.

• Alarm information archived to a text file when an alarm is deleted.

By appending field codes to each of these items, you can customize their setup. For example, to have the device that
generated the alarm included in the message of an alarm action, append the Device field code to the message of the action.

Formatting field codes

You can enter a formatting command after a field code to format the field code in one of the following 3 ways:
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• Format a number field code (Example: ##.##).

• Format a date/time field code (Example: MM/dd/yyyy hh:mm:ss).

• Left, right, or center align a field code and set the field width.

A formatting command must have the following syntax:

Figure 3.12 Syntax for Formatting Command

Item Description

1 Format type

2 Style

See the Table 3.27 below to determine the format_type and style for a formatting command.

Formatting

Command
Format Type Style Example

To format a
number

N

The actual formatting, such as ##.##. The basic format
uses the pound sign (#) to represent a number. For
more information, search the Internet for customizing
number formats with java.

To always round a setpoint value to two digits
to the right of the decimal, the field code is:
$setpoint_value%N:##.##$For example,
78.9935 becomes 78.99.

To format
date/time

D
The actual formatting, such as MM/dd/yyyy hh:mm:ss.
For more information, search the Internet for
customizing date time formats with java.

To show the date and time when an alarm is
generated in a format like 03/15/2004
10:50:43, the field code is: $generation_
time%D:MM/dd/yyyy hh:mm:ss$ 

To set alignment
and field width

L for left align

R for right align

C for center align

Indicate the field width by number of characters.
To left align the name of the device that
generated the alarm and set the field width to
15 characters, the field code is: $device%L:15$

Table 3.27 Format Type and Style for a Formatting Command

Using multiple formatting commands

You can enter multiple formatting commands for a field code. For example, you can format a number and then set the
alignment and field width. The syntax for multiple formatting commands is:
$fieldcode%format_type1:style%format_type2:style$

Example: To format the alarm date and time, center it and set the field at 20 characters, the field code is:
$generation_time%D:MM/dd/yyyy hh:mm:ss%C:20$

NOTE: The date/time or number formatting command must be entered before the alignment/field width command.
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Field codes

Field Code

Name
Field Code Description

Acknowledge
Operator

$acknowledge_
operator$ 

The operator who acknowledged the alarm. Example: John Doe

Acknowledge
Time

$acknowledge_time$ The time when the operator acknowledged the alarm. Example: Nov 12, 2012 6:46:31 PM

Alarm Category $alarm_category$ The alarm category to which the alarm is assigned. Example: HVAC Critical

Alarm Priority $alarm_priority$
The priority number associated with the priority of the alarm (Off-Normal, Fault, or Normal) on the controller's
Driver > Notification Classpage.

Alarm Template $alarm_template$ The alarm template that the alarm is assigned. Example: Universal

Alarm Type $alarm_type$ The alarm type of the alarm source. Example: CHANGE OF STATE

Alert Text $alerttext$

For a converted SuperVision system if the option Create a single alarm template... was selected during
upgrade. Retrieves alarm message text from cmnet_alert_text.properties.

To use this field code:

1. Select the Alert Text field code.

2. After $alerttext, enter one of the following:

• :normalshort

• :normallong

• :alarmshort

• :alarmlong

For example, $alerttext:alarmlong$ 

Character $c$
A single ASCII character. Often used for form feeds and other printer escape sequences. Example: $C:65$ 
displays A

Command
Value

$command_value$ The commanded value from the alarm source. Valid only for alarm type COMMAND FAILURE. Example: 3

Control
Program

$equipment$ The display name of the equipment where the alarm came from. Example: Chiller

Controller $device$ The display name of the device where the alarm came from. Example: SE6104

Dead Band $deadband$ The deadband value from the alarm source. Valid only for alarm type OUT-OF-RANGE. EXAMPLE  5

Deletion
Operator

$deletion_operator$ The operator who deleted the alarm. Example: John Doe

Deletion Time $deletion_time$ The time the alarm was deleted. Example: Nov 12, 2012 6:46:31 PM

Error Limit $error_limit$ The error limit, from the alarm source. Valid only for alarm type FLOATING LIMIT. Example: 90

Event Values $event_values$ Returns a string of alarm values associated with the alarm.

Exceeded Limit $exceeded_limit$ The exceeded limit value from the alarm source. Valid only for alarm type OUT-OF-RANGE. Example: 90

Exceeding
Value

$exceeding_value$ The exceeding value from the alarm source. Valid only for alarm type OUT-OF-RANGE. Example: 91

Fault $fault$ The status of the fault condition from the alarm source. Example: True or false

Field Message $field_message$ Text generated in the alarm by the controller.

Table 3.28 Field Codes Description
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Field Code

Name
Field Code Description

Feedback Value $feedback_value$ The feedback value from the alarm source. Valid only for alarm type COMMAND FAILURE. EXAMPLE  10

From State $from_state$ The previous state of the alarm source. Example: NORMAL, FAULT, OFF NORMAL, HIGH LIMIT, LOW LIMIT

Generation
Operator

$generation_operator$ The operator who forced the alarm to return to normal. Example: John Doe

Generation
Time

$generation_time$ The time in the controller when the alarm was generated. Example: Nov 12, 2012 6:35:18 PM

In Alarm $in_alarm$ The In Alarm status from the alarm source. Example: True or false

Incident Closed
Time

$incident_closed_time$ The time the entire incident group closed of the alarm. Example: Nov 12, 2012 6:46:31 PM

Latched Data
Value (Analog)

$latched_data_
analog:x$ 

x ranges from 1 to 10. Returns a numerical value. Use for legacy systems.

Latched Data
Value (Digital)

$latched_data_
digital:x$

x ranges from 1 to 10. Returns On or Off. Use for legacy systems.

Location Path $location_path$ 

Displays the path display names from root to source. Example: Building B / Basement / VAV AHU B / SSP_
STOP

The number of levels in the path is based on the System Settings field Levels displayed in paths. To override
this setting, enter the field code as $location_path:#$, substituting # with the number of path levels you want
to show. For example, $location_path:5$ will show 5 levels.

Long Message $long_message$ The formatted alarm long text displayed by double clicking the alarm on the Alarms page.

Message
Details

$message_details$ The message details displayed on the Alarms page View tab.

Message Prefix $message_prefix$ The message prefix displayed on the Alarms page View tab.

Message Text $message_text$ The message text displayed on the Alarms page View tab.

New State $new_state$ 
The status of new state from the alarm source. Valid only for alarm type CHANGE OF STATE. Example: Alarm,
Fault

New Value $new_value$ The new value from the alarm source. Valid only for alarm type CHANGE OF VALUE. Example: 70

Notification
Class

$notification_class$
The notification class assigned denotes how the received alarm was generated. For example, if set to 1, the
alarm would typically be sent to SiteScan by Vertiv controllers.

Object ID $object_ID$ Object ID of the alarm source. Example: 5:26

Out of Service $out_of_service$ The status of 'out of service' from the alarm source. Example: True or false

Overridden $overridden$ The status of 'overridden' from the alarm source. Example: True or false

Program ID $program_id$ 

The address of the control program that generated the alarm.

BACnet program address format: device ID, program number Example: 2423101,1

SuperVision program address format: site, gateway, controller, fb Example: 1, 2, 13, 5

Receive Time $receive_time$ The time at the workstation when the alarm was received. Example: Nov 12, 2012 6:46:31 PM

Recipient
Device ID

$device_id$ The device ID of the device where the alarm came from. Example: 8:2423101

Table 3.28 Field Codes Description (continued)
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Field Code

Name
Field Code Description

Record Type $record_type$ The type of alarm. Example: BACnet, Supervision, System

Reference Path $reference_path$ Path to alarm source. Available in all alarm actions. Example: #e_b_vav_ahu_b/ssp_stop

Reference
Value

$reference_value$ The 'reference value' from the alarm source. Valid only for alarm type FLOATING LIMIT. EXAMPLE  83

Referenced
Bitstring

$referenced_bitstring$ 
The value of the 'referenced bitstring' value from the alarm source. Valid only for alarm type CHANGE OF
BITSTRING. Example: 1011011101101

RTN Time $RTN_time$ The time when the alarm returned to normal. Example: Nov 12, 2012 6:46:31 PM

Setpoint Value $setpoint_value$ The setpoint value from the alarm source. Valid only for alarm type FLOATING LIMIT. EXAMPLE  72

Short Message $short_message$ The formatted alarm short text.

Site $site$ The display name of the site the alarm came from. Example: Kennesaw

Source $source$ The display name of the alarm source microblock that generated the alarm. Example: SAT_HI

Source
description

$source:description$ 
The Description field of the alarm source microblock that generated the alarm. Example: High Cooling Supply
Air Temp

Source Path $source:<path>$ 

Substitute <path> with the path to the value you want to display. See Defining Vertiv™ Liebert® SiteScan™
Web paths on page 1.

Example to add text value: $source:~equipment.display-name$

Example to add a numeric value: $source:/trees/geographic/rd_facility/ zone_1/lstat/present_value$

NOTE: You can use Global Modify to get the path.

For legacy systems, use the latched data field codes.

System
Directory

$system_dir$ The system folder name. Example: c:\SiteScanx.x\webroot\ world_corporation

To State $to_state$ The current state of the alarm source. Example: NORMAL, FAULT, OFF NORMAL, HIGH LIMIT, LOW LIMIT

Table 3.28 Field Codes Description (continued)
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3.8 Trends

The Vertiv™ Liebert® SiteScan™ Web system can read and store equipment status values over time and then display this
information in a trend graph to help the user to monitor the operation of the equipment.

Figure 3.13 Trends Graph

The user can collect trend data for any point value in the Liebert® SiteScan™ Web system. The controller reads point values at
intervals that the user defines and then stores that data in the controller. A controller has limited memory for storing trend
data, so the user can set up historical trending to archive the trend data from the controller to the Liebert® SiteScan™ Web
database. A trend graph can display data from the controller and the database, or it can display only data stored in the
database.

Once the desired points for trend data collection are set (see Collecting trend data for a point on the next page), you can:

• View built in trend graphs that show a single point (see Viewing a built-in, single point trend graph on page 66).

• Create custom trend graphs with multiple points (see Creating a custom trend graph on page 66).
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Figure 3.14 Trends

Item Description

1 Custom Trend Graph

2 Single-point graphs

3.8.1 Collecting trend data for a point

To see a trend graph for a point, the user must first enable trending for that point and then define how the user wants the
controller to collect the data for that point. This can be done in the EIKON application or in the Vertiv™ Liebert® SiteScan™
Web interface using the instructions below.

NOTE: I/O microblocks have trending capability built in, and you enable trend logging in the I/O microblock. Any other
microblock value must have a trend microblock attached in the control program, and you enable trend logging of the
value in the trend microblock.

To set up trending for a point in the Liebert® SiteScan™ Web Interface, follow the below steps:

1. On the Geographic tree, select the equipment that has the point you want to trend.

2. Click the Trends button drop-down arrow, select Disabled Points, then select the point.

3. On the Enable/Disable tab, check Enable Trend Log.

4. Enter information in the appropriate fields. See Table 3.29 on the facing page.

5. Click Accept.

NOTE: On the Trend Sources tab of the Properties page of the equipment, the user can set up all trends for a piece of
equipment at once.
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Field Notes

Sample every _:_:_ (hh:mm:ss)

Records the value of the point at this interval.

NOTE: Set trend intervals for U line controllers to one minute or greater. U line controllers are designed to
meet low end, high volume terminal control applications and are not suited to very short trend intervals.

Sample on COV (change of value)
Records the value of the point only when the value changes by at least the amount of the COV Increment.

NOTE: Use this method for a binary point or for an analog point that has infrequent changes in value.

Max samples

The maximum number of samples that you want the controller to store.

CAUTION: Changing the value in Max samples will delete all the trend samples of the point
currently stored in the controller. Click the Store Trends Now button before changing the value to
transfer the trend data from the controller to the system database.

NOTE: Trending consumes memory in the controller. The amount of memory available depends on the type of
controller. Each trended point consumes 48 bytes of memory plus 10 bytes for each trend sample. Each trend

microblock consumes 416 bytes of memory plus 10 bytes for each trend sample.

NOTE: Click Reset to delete all samples currently stored in the controller.

NOTE: The above sample and memory allocation fields together define trend data storage in the controller in terms of hours.
Example: If you set these fields so that samples are collected every 5 minutes for a maximum of 120 samples, the controller will store 600 minutes
(5 x 120) or 10 hours of trend data.

Stop When Full Check this field to stop trend sampling when the maximum number of samples is reached.

Enable trend log at specific times
only

Collects trend data for the specific period of time that the user defines in the time and date fields.

Enable Trend Historian Archives trend data to the system database.

Store Trends Now Writes all trend data in the controller to the system database without having to enable trend historian.

Write to historian every __ trend
samples

Writes all trend data in the controller to the system database each time the controller collects the number of samples
that the user enters in this field. This number must be greater than zero and less than the number entered in the field
Max samples. The number of trends specified must be accumulated at least once before the historical trends can be
viewed.

Trend samples accumulated since
last notification

Shows the number of samples stored in the controller since data was last written to the database.

Last Record Written to Historian Shows the number of trend samples that were last written to the database.

Keep historical trends for __ days
This is based on the date that the sample was read. Select the first option to use the system default that is defined on
the System Settings > General tab. Select the second option to set a value for this trend only.

Delete
Deletes all trend samples stored in the database for the item selected on the Geographic tree.

BACnet Configuration
The Object Name is a unique alphanumeric string that defines the BACnet object. Although the Object Name field
can be edited, it is not recommended. The Notification Class is set to 1 to receive alarms generated by Vertiv
controllers.

Table 3.29 Property of Various Category

NOTE: Use Global Copy to copy trend properties to other pieces of equipment that use the same control program.

Run a Trend Usage report (see Preconfigured Reports on page 1 ) to view trend configurations.
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3.8.2 Viewing a built-in, single point trend graph

1. On the Geographic tree, select the equipment whose trend you want to view.

2. Click the Trends button drop-down arrow, select Enabled Points, and then select the graph you want to view.

3. Select the View tab. See Using trend graphs on page 69.

NOTE: On the Configure tab, you can:

• Enable/disable the grid.

• Set the time range for the X-axis. For example, enter 7 days to see the data for the last week.

• Turn off autoscaling so that the user can define a range for the Y-axis.

• Enter a Y-axis label that will appear on the right side of the graph.

3.8.3 Creating a custom trend graph

The user can select up to 16 points when creating a custom trend graph. The Vertiv™ Liebert® SiteScan™ Web application
divides the data into subgraphs if more than 4 points or points with different units are selected. A maximum of 4 points with
comparable units can be displayed in each subgraph.

Figure 3.15 Custom Trend Graph

NOTE: To include points in the custom trend graph, enable trending for that points. See Collecting trend data for a
point on page 64.
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The user can display icons and hover text on the Geographic tree that show where custom trend graphs were
created. See Tree Icons and Hover Text on page 12.

Creating a custom trend graph

Follow the below steps to create a custom trend graph:

1. On the Geographic tree, select the area or equipment where you want to see the graph.

2. Click the Trends button drop-down arrow, then select New Trend Graph.

NOTE: If the Trends button does not have a drop-down arrow, the New Trend Graph page is already displayed.

3. In the tree on the New Trend Graph page, use Ctrl+click or Shift+click to select the points (16 maximum) that you
want to see on a graph.

NOTE: The tree shows only points that have trending enabled. See Collecting trend data for a point on page 64.

4. Click Save.

5. Optional:If your system has trend categories defined, you can select a Category for this trend. For more
information on trend categories, see Adding trend categories on the next page.

6. Enter a Name for the graph that will appear at the top of the graph and in the Trends button drop-down list.

7. Click OK.

8. To see custom trend graph and to edit trend graph:

• Select the View tab to see the custom trend graph. See Using trend graphs on page 69.

• Select the Configure tab to edit the trend graph. See Editing a custom trend graph below.

Editing a custom trend graph

Follow the below steps to edit a custom trend graph:

1. On the Geographic tree, select the area or equipment where you created the graph.

2. Select the Trends > Configure tab. On this page, you can:

• Change the name of the custom trend graph.

• Enable/disable the grid.

• Set the time range for the X-axis.

• Edit a Y-axis label of subgraph that will appear on the right side of the graph.

• Turn off autoscaling so that you can define a range for the Y-axis.

• Add/delete subgraphs (see Adding a subgraph to a custom trend graph: below).

• Add/delete points (see Adding a point to a subgraph: on the next page).

• Change the name of a point on the graph.

• Change the active/inactive text of a binary point on the graph.

• Click Delete Trend Graph to delete the entire custom trend graph.

Adding a subgraph to a custom trend graph:

1. Click Add below the Subgraphs list.
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2. Type a Y-axis label.

3. Click Add below the Points list.

4. Select a point in the Data source tree.

NOTE: The tree shows only points that have trending enabled. See Collecting trend data for a point on page 64.

5. Repeat steps 3 and 4 to add up to 4 points to the subgraph.

6. Click Accept.

NOTE: To delete a subgraph, select it in the Subgraphs list, click Delete below the list, and then click Accept.

Adding a point to a subgraph:

1. Select the subgraph in the Subgraphs list.

2. Click Add below the Points list.

3. Select a point from the Data source tree.

NOTE: The tree shows only points that have trending enabled. See Collecting trend data for a point on page 64.

4. Click Accept.

NOTE: To delete a point, select the appropriate subgraph, select the point, click Delete below the Points list, and then
click Accept.

3.8.4 Adding trend categories

A point trend graph is in the Enabled or Disabled category in the Trends button drop-down menu.

Figure 3.16 Enabling/Disabling Point Trend Graph

Follow the below steps to create additional categories for your custom trend graphs:

1. On the System Configuration tree, click to the left of Categories, then select Trend.

2. Click Add.

3. Enter the Category Name and Reference Name.

4. Optional:Select a privilege so that only operators with that privilege can access trends in the category.

5. Click Accept.

NOTE: To edit a category, select the category, make your changes, then click Accept.
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To delete a category, select the category, click Delete, then click Accept.

3.8.5 Using trend graphs

Figure 3.17 Graph Trend

Item Description

1

Mouse mode:

• Pan

• Zoom

NOTE: Click and drag will Pan or Zoom. Hold Shift to swap.

2
Scale

NOTE: Scale the Y-axis to fit the data.

3 Back

4 Graph center
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Item Description

5

Toolbar options:

• Auto update from field

• Show database values only

• Black and White

• Display gap in graph line for missing data

6

Save as:

• PNG

• JPEG

• SVG

• PDF

• CSV

7
Legend

NOTE: Click Legend to toggle visibility.

A gray triangle at the top of a graph indicates a note from the system. Hover the cursor on the triangle to see which of the
following occurred:

• Equipment received a time synchronization from its network router or from the Vertiv™ Liebert® SiteScan™ Web
application.

• Trend Historian has been enabled or disabled.

• Trend Log has been enabled or disabled.

The trend object ID of a third party trend source has been changed. This is for information only, and the user do not need to
do anything.

• Click Print icon at the top of the Liebert® SiteScan™ Web page to print the graph. You may need to set your
printer's orientation to Landscape.

• Toolbar options are also accessible by right clicking a trend graph.

• You can check Display gap in graph line for missing data on an individual trend graph page, or you can go to the
System Settings > General tab (see General tab on page 1) to set this for all future trend graphs.

Viewing trend data in a spreadsheet program

To view trend data in a spreadsheet program:

The user can save trend data as csv data that can be opened in a spreadsheet program such as Microsoft Excel.

1. On the Trends > View tab, select > Save as CSV data.

2. Save the data (.zip file) wherever you want. The .zip file contains the following:

• A .csv file for each trend source (point). The file names match the point names.

• A combined folder containing a file with the combined data for all the trend sources of the graph.

3. Open the .csv file in a spreadsheet program.

NOTE: The data in the Time column of the spreadsheet must be converted to a readable date/time format
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If you are using Microsoft Excel on a Mac and the converted date shows the wrong year, follow the below steps:

1. In Excel, go to File > Options > Advanced.

2. Scroll down to the section when calculating this workbook, and then uncheck Use 1904 date system.

3.9 Reports

Monitor and troubleshoot your system with Vertiv™ Liebert® SiteScan™ Web reports. The Liebert® SiteScan™ Web license
and/or edition determines which of the following things you can accomplish in the Liebert® SiteScan™ Web interface:

• Run preconfigured reports

• Run custom reports

• Schedule reports

• Create custom reports

3.9.1 Preconfigured reports

The preconfigured reports shown in the Reports button drop-down list vary depending on which tree you selected.

Figure 3.18 Preconfigured Reports in the Geographic Tree and Network Tree

Item Description

1 Report category

2 Report name

A preconfigured report shows data for the selected tree item and all its children.
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Preconfigured Report Allows

Alarms

Alarm Actions Create a summary of the information configured on the Alarms > Actions (see Setting up alarm actions on page 1) tab.

Alarm Prefixes &
Details

Create a summary of the information configured on the Alarms > Messages (see Alarm messages on page 1) tab.

Alarm Sources
Create a summary of potential alarm sources as configured on the Alarms > Enable/Disable(see Setting up an alarm source in
the Liebert® SiteScan™ Web interface on page 1) tab.

Alarms
View, sort, and filter the information on the Alarms View (see Viewing, Troubleshooting, Acknowledging, and Deleting Alarms on
page 1 ) tab.

Commissioning

Equipment Checkout
View the information on the Equipment Checkout tab on the Properties page of the equipment during commissioning. Also, find
equipment that has not been fully commissioned.

Test & Balance
View the results of VAV box commissioning. Running this report automatically uploads calibration parameters to the Vertiv™
Liebert® SiteScan™ Web application.

Equipment

Locked Values
Find all locked points and locked values.

NOTE: Locks in the Airflow microblock are not reported.

Network IO
Verify the programming and status of all network points especially useful for commissioning controllers used for third-party
integration.

Parameter Mismatch Discover where your system has parameter mismatches that need to be resolved.

Point List
View the details of all points. Verify that all points have been checked out during commissioning. Also, create custom lists for
other contractors. For example, create a list of BACnet IDs.

Trend Usage
Creates a summary of the information configured on the Trends > Enable/Disable (see Collecting trend data for a point on
page 64) tab.

Schedules

Effective Schedules View all equipment that may be scheduled and the net result of all schedules in effect for a selected date and time.

Schedule Instances
Find every schedule with its location that is entered at and below a selected tree item. This report can help you discover newly
added and conflicting schedules.

Security NOTE: You must have the Advanced Security package to run these reports.

Location Audit Log
View chronological lists of location-based changes, the operators that made them, and the reasons for the changes. This report
includes changes such as property edits, downloads, driver changes, and view changes.

Operator Information
Lists operator name, login name, date of last login, date of last password change, password exemption status, auto logoff setting,
ready to e-sign status, system-wide privilege sets, and starting location.

System Audit Log
View chronological lists of system-wide changes, the operators that made them, and the reasons for the changes. This report
includes changes such as any change made on the System Configuration tree, login/logout, and scheduled processes like
deleting expired trends.

Network

Controller Status
Discover network communication problems (shown as purple squares on the report) that need troubleshooting. The report also
shows boot and driver version, download information, and if controller has 4.x or later driver, the report shows the serial number
and Local Access port status.

Table 3.30 Preconfigured Report for Selected Tree Item
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Preconfigured Report Allows

Equipment Status Display the thermographic color, status, and prime variable of each control program.

Quarantine Summary
Report

Provides a summary of trend data that has been quarantined due to recording discrepancies (switching from daylight saving
time, changing a timezone, and so on). This report is available in the Reports menu once you select a System or Area in the

Geographic tree.

Quarantine Detail
Report

Lists trend data that has been quarantined due to recording discrepancies (switching from daylight saving time, changing a
timezone, and so on). This report is available in the Reports menu once you select a piece of Equipment in the Geographic

tree.

Table 3.30 Preconfigured Report for Selected Tree Item (continued)

Running a preconfigured report

1. Select an item on the Geographic or Network tree.

2. Click the drop-down arrow and select Reports, then select a report.

3. On the Options tab, define the layout and content of the report.

NOTE: Changing the size and orientation of the printed page also changes the report layout on the View tab.

To create a CSV (Comma Separated Values) file after you run the report, select Support CSV text format. See
Creating a PDF, XLS, or CSV file on page 109.

The report options of the current operator are saved so that when that operator logs in again, the same options are
used.

4. Click Run.

NOTE: Click Schedule to schedule the report to run on a recurring basis. See Scheduling reports on page 109.

Running an Ad Hoc alarms or security report

Follow these steps to run a single ad hoc version of an alarms, or security report:

1. Click the drop-down arrow and select Reports, and then select the report that you want to schedule.

• Alarms > Alarms

• Security Reports > Location Audit Log

• Security Reports > System Audit Log

2. Go to the Options tab.

3. In the Ad Hoc Report section, select the time span of the report.
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Date Range Option Description

Unrestricted The report contains all data for the entire duration of available dates.

Continuous Data (Date) The report contains all data occurring between the specified Start and End dates.

Continuous Data (Date and
Time)

The report contains only the data occurring between the specified Start Date and Time and End Date and Time.

Shift Report*
The report contains only the data occurring between the specified Shift Start and End Times within the specified date
range.

NOTE: * Requires Advanced Reporting Package.

Table 3.31 Type of Date Range Option

4. Click Accept, and then click Run.

CAUTION: Changes made here affect Ad Hoc report settings for the selected Alarms or Security report in all
locations.

Configuring scheduled alarms and security reports

The following reports have additional scheduling options available. Scheduling these reports without configuring schedule
options results in an error; see Managing scheduled reports on page 110.

• Alarms > Alarms

• Security Reports > Location Audit Log

• Security Reports > System Audit Log

To configure scheduled alarms and security reports:

1. Go to the Options tab, open Scheduled Report, and check Enable schedule options for this location.

2. Select the time span of the report.

Date Range Option Description

Continuous Data (Date) The report contains all data occurring between the specified Start and End dates.

Continuous Data (Date and
Time)

The report contains only the data occurring between the specified Start Date and Time and End Date and Time.

Shift Report*
The report contains only the data occurring between the specified Shift Start and End Times within the specified date
range.

NOTE: * Requires Advanced Reporting Package.

Table 3.32 Type of Date Range Option

3. Select the number of Days, Weeks, Months, Quarters, or Years the report will contain.

NOTE: The use of previous: Selecting previous week returns data for the previous full calendar week, Sunday through
Saturday. Select previous 7 days to see the most recent week of data. For example, selecting previous 7 days on a
Wednesday returns data from last Wednesday through the current Tuesday.
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Checking include current causes the report to contain data for the most recent iteration of the report. For example, a
report for the previous week with the include current option checked contains only the data for the current week,
even if it is not a complete week. In order to get the last week and the current week, it would be necessary to specify
the previous 2 weeks.

4. Click Accept.

NOTE: Changes made here affect the selected Alarm or Security scheduled report in the current location only.

3.9.2 Custom reports

Custom reports are managed through the Vertiv™ Liebert® SiteScan™ Web Report Manager that shows a list of all custom
reports in your system. In the Report Manager, you can:

• Create a new custom report (see Creating a custom report below).

• Copy an existing report as a starting point for a new report (see Creating a custom report below).

• Edit or delete an existing report (see Editing or deleting a custom report on page 93).

• Export reports to a file so that it can be imported into another system (see Exporting or importing a custom
report on page 93).

A custom report can provide data for a data table (To Produce a Data Table on page 96), chart (Producing a Chart on
page 100), or color map (Producing a Color Map on page 104) on a Graphics page.

NOTE: A custom report may appear in the Report Manager but not appear in the Reports button menu because its
only purpose is to provide data to an item on a Graphics page.

To support upgraded systems, you can still create and access legacy (v6.5 and earlier) custom reports (see Working
with legacy (v6.5 and earlier) custom reports on page 111). These reports appear only in the Reports button drop-down
menu, but not in the Reports Manager.

Creating a custom report

To create custom reports:

1. Click the drop-down arrow and select Reports, and then select Report Manager.

2. Click Add.

NOTE: To save time when making a report that is similar to an existing report, select the existing report in the Report
Manager, and then click Copy. The Report Editor opens the new report so that you can make changes.

Click on the Display Name or ID heading in the Report Manager to sort the column.

3. Enter information on the following Report Editor tabs until you have created the report.

• Type tab (see Type tab: on the next page).

• Columns tab (see Columns tab on page 78).

• Variables tab (see Variables tab on page 88).

• Where tab (see Where tab: on page 89).

• Options tab (see Options tab: on page 89).

• Output tab (see Output tab on page 90).

NOTE: As you create your report, you can use the Preview section on each tab to check your work. See Previewing a
report on page 92.
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After you create the report, you can go to any item in the tree where the report is accessible, and run it. See Running a
custom report on page 93.

A report can have a maximum of 50 columns and 1000 rows.

CAUTION: As you move from tab to tab in the Report Editor, click Apply to save your changes on a tab. If you
click Cancel on a tab, all unsaved changes on any tab will be lost. Tabs that have unsaved changes have a

pencil icon beside the tab name. For example, .

Type tab:

1. Enter the necessary information about the report you are creating. See Table 3.33 below.

2. Click Accept or Apply.

Field Notes

Display name The name that will appear in the Reports button drop-down list.

ID A unique ID for the report (letters, numbers, underscores, and hyphens only; no spaces or special characters).

Show in Reports
menu

By default, the report name will appear directly in the Reports button drop-down list, not in a category. You can:

• Check this box and then select a category for the report. See Organizing custom reports by category on page 94.

• Uncheck this box so that this report does not appear in the Reports button drop-down list. For example, you could
uncheck this box if the report will provide data to a Graphics page but does not provide valuable information as a
stand-alone report.

Primary column
Select the type of information on which you want the report to be based.

Click Change if you want to change your initial selection and have your new selection to take effect.

Select Then

Control Programs

To create the list of control programs., do one or both of the following. The
primary column will list the equipment that use those control programs.

• Enter a control program name, and then click Add. You can
use wild cards. See the help text to the right of this field.

• Select from the list of existing control programs.

Locations

To create the list of locations that will appear on each row in the primary
column, do one or both of the following:

• Select locations in the Geographic or Network tree.

• Enter a location name, and then click Add.

Reference Names

Enter a reference name and then click Add. You can use wildcards. See the
help text to the right of this field.

If needed, add more reference names, to build a list of reference names. The
primary column will list the locations that have the reference names.

Select the types of reference names that you added.

Tag Names

To create the list based on tagged locations for each row in the primary
column of the report:

1. Click to the left in the list of system tags to add that tag to
the Tag Names table.

Table 3.33 Type Tab Fields
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Field Notes

NOTE: To combine several tags for a single location, keep clicking next
to each tag you want.

2. Click Add to assign the selected tags to the list of tag names
to use for a location.

3. Check the types of locations (Area, Equipment, Microblock)
that you want in the column.

4. Click Apply.

The locations selected for the report will be those that match any row of tag
names.

For example, to get a report of locations tagged Chilled Water and Hot Water:

1. Click next to Chilled.

2. Click next to Water.

3. Click Add.

4. Click next to Hot.

5. Click next to Water.

6. Click Add.

Date Range

Choose any one of the following:

• Previous:  A specified number of previous days, weeks,
months, quarters, or years. You can choose to include the
current time period.

• From date:  A specified number of days, weeks, months,
quarters, or years starting at a specific date (yyyy/mm/dd).

NOTE: In the fields for the above 2 options, , you can enter a value or
variable name. If you enter a variable, it must be defined on the
Variables tab on page 88.

Frequency:  If you choose Months or Days in the Previous or From date fields,
you can choose how often the data is to be reported. For example, if you
choose a frequency of Every 15 minutes, the primary column could look
similar to the following:

Date Range Format in Report: Type the date format that you want to see in
the report. See Date formats (Date formats on the next page) for a list of
supported formats.

Existing Report

Select an existing report from the drop-down list or enter a report name in
the text field. The existing report will be embedded in the new report so that
you can add columns to it. Any changes to the existing report will also be
reflected in the new report.

Table 3.33 Type Tab Fields (continued)
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Field Notes

Color Map
Select this option to show colors on a Graphics page. For example, you could
have a campus map where each building would show green for good energy
usage or red for high energy usage. See Producing a Color Map on page 104.

Hide Primary
column in
report

Check if you don't want this column to appear in the report.

Primary column
header

If you do not hide the Primary column, type the header that you want to appear at the top of this column.

Table 3.33 Type Tab Fields (continued)

Date formats

If your Primary column is a Date Range, use the following information to enter a format in the Date Range format in report field.

For Type Example

Year yyyy yy 2017 17

Month MMMM MMM MM September Sep 9

Week in year w 27

Week in month W 2

Day in year D 189

Day in month d 12

Day of week in month F 2 (2nd Thursday in June)

Day name EEEE E Tuesday Tue

Day number in week u 1 (Monday), 2 (Tuesday), and so on.

Table 3.34 Date Range Format

Type Example

yyyy-MM-dd 2017-06-02

MMMM yy June 17

MMM/yyyy Jun/2017

MM/dd/yy D 06/02/17 153

Table 3.35 Examples of Combinations

NOTE: To include a single quote, type two single quotes. Example: MMM ''yy = Jun '17

To include static text, enclose it in single quotes. Example: 'Year' yyyy = Year 2017

For more information on date formats, search the Internet for java simple date format.

Columns tab

The Primary column for a table is defined on the Type tab. The remaining columns can be defined on the Columns tab. To
define the columns in your report, you can:

• Add each individual column (see Adding a column: on the facing page).
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• Copy an existing column (see Copying a column: on the next page).

• Replicate a column (Trend Data only) (see Replicating a trend data column: on the next page).

Adding a column:

1. Click Add.

2. Enter or select options in the first four fields that appear. See Table 3.36 below.

3. Select an option in the Column data is from field. See the bold highlighted rows in the Table 3.36 below for a
description of the options.

NOTE: Click Change if you want to change your initial selection and have your new selection to take effect.

4. Select or enter information for the option you chose in step 1 . See Table 3.36 below.

5. Click Accept or Apply.

Field Notes

The following four fields are common to all the options from 1 .

Display name The name that will be shown in the report as the column's header.

ID A unique ID for the column (letters, numbers, underscores, and hyphens only; no spaces or special characters).

Render data as

Value Shows a value in the report.

Hidden Hides the column in the report. The column's data can be used to produce a value for another cell.

Color
Uses the column's value to determine a color on a color map (see Producing a Color Map on page 104). Set the
Column data is from field to Expression or Function, and then enter the appropriate information that returns a
color value.

Icon
Shows an icon to indicate a certain condition. Set the Column data is from field to Expression, and then enter an
expression that says what icon filename to show for a particular condition. You can use the icons included with
your system or you can create custom icons. See Icons: on page 87 for more information.

Column format
Lets you define the column's alignment, width, and format of digits.

NOTE: Column format does not apply if you select Hidden or Color in the Render data as field.

The following fields are based on your selection in the Column data is from field.

Path The column output will be based on a path to a value in the Vertiv™Liebert® SiteScan™ Web system.

Path Enter the path to the value you want. See Defining Vertiv™ Liebert® SiteScan™ Web paths on page 54.

Show value as
text

Check to have the value reported as text instead of its numerical value. For example, show the word On instead of 1.

Expression The column output will be based on the result of an expression (Expressions on page 81).

Trend Data The column's output will be based on a value calculated from a range of trend data.

Trend path

Do one of the following:

• Click the Select Trend Pathbutton to select the trended point. Typically, you want the full (absolute) path, but if needed,
you can select the relative path.

• Enter the path to the trend that you want the report to pull data from.

See Defining Vertiv™ Liebert® SiteScan™ Web paths on page 54.

Operation Select the type of value or calculation that you want the column to show. See Operations on page 87 for a description of each option.

Table 3.36 Properties of Column
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Field Notes

Interval sample
If the selected operation allows, you can choose how to handle the first and last sample of the time period. For example, Include start
time / exclude end time.

Database
trends only

Check to include only trends saved in the database, not those in the controller.

Show time of
sample

Check to include the time of the sample in the column.

Time range

From primary
column

You can use this option if the primary column of the report is a date range.

From column
You use this option if your report began with an embedded external report that has a column containing date
ranges.

Value A time period specified by entering a Start date and End date.

Past
Enter the number of days, weeks, months, quarters, and years in the past. You can select whether to include the
current time period or not.

NOTE: You can use a variable (Variables tab on page 88) for a Time range count or date field. The variable must be defined on
the Variables tab.

Function The column output will be based on the value or manipulation of the value from another column.

Input column The column on which you want to perform a function.

Function Select an option in the drop-down list. See Functions on page 86.

Arguments

A statement that contains the criteria of the function. See Functions on page 86 for argument formats and examples.

NOTE: You can use a variable (Variables tab on page 88) name in the argument. The variable must be defined on the Variables
tab.

+/- Date Range The column output will be based on the date range you choose.

 Adjust by Adjusts the data by these many days, weeks, months, quarters, or years. Enter a value or variable name.

From column Enter the Column ID of the date range you want to adjust. To adjust the primary date range, leave this field blank.

Table 3.36 Properties of Column (continued)

NOTE: To delete a column, select the column in the table at the top of the page, then click Delete.

To change the order of the columns, select a column and then click or to move the column.

Copying a column:

1. Select the column you want to copy in the table at the top of the Columns tab.

2. Click the Copy button.

3. Change the fields of the column as needed. See field descriptions in To add a column (Adding a column: on the
previous page).

NOTE: The column's ID is incremented by 1.

Replicating a trend data column:

When you have defined all the criteria for a trend column, you can quickly reproduce that column for other trend sources.

1. Select the column in the table at the top of the Columns tab.

2. Click the Replicate Column button.
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3. Select whether you want the Trend Path for the new columns to be the full (absolute) path or the relative path.
This is usually set to Full path. See Defining Vertiv™ Liebert® SiteScan™ Web paths on page 54.

4. In the left column, select a location.

5. The right column displays all trend sources at or below the selected location. Select the trend sources that you
want. A column will be added for each instance of the selected trend sources at or below the selected location.

6. Repeat steps 4 and 5 for any additional locations and points that you want in you report.

7. Click Apply.

8. Click Close.

9. Change the fields in each column as needed. See field descriptions Adding a column: on page 79.

Expressions

On the Columns tab of the Report Editor, you can specify that a column's data is from an expression. Vertiv™ Liebert®
SiteScan™ Web expressions are similar to expressions used in spreadsheet programs. The most basic expression is a math
calculation, but an expression can also manipulate text.

An expression generally consists of at least one item in dollar signs and an operator. See table below. The item in dollar signs
can be:

• Another column's ID.

• A path to an item in your system or a semantic tag.

• A variable defined on the Variables tab of the Report Editor.

Static text in an expression must be enclosed with quotes (either single or double quotes can be used). Any item that results
in text should also be enclosed with quotes. This example shows both situations: 'Filter is ' + '$filter_status$'

Example of a simple expression: to compute the average value of min_temp and max_temp columns

Expression: ($min_temp$ + $max_temp$) / 2

To verify that the expression you entered is formatted correctly, click Check Syntax. The result appears to the right of the
button. The numerical position of the first error in the expression appears and the error is highlighted.

NOTE: The result of checking an expression with a variable may not be accurate since variables can be used in such a
wide variety of ways.

Operators

An operator defines how each piece of an expression is to be handled. The Table 3.37 below lists operators that can be used
in expressions.

Symbol Name Description

Operators that return true/false (1/0)

< Less than
Compares numeric data. Returns true if the value to the left of the operator is smaller than the value to the
right.

> Greater than
Compares numeric data. Returns true if the value to the left of the operator is larger than the value to the
right.

<= Less than or equal to
Compares numeric data. Returns true if the value to the left of the operator is smaller than or equal to the
value to the right.

Table 3.37 List of Operators to be Used in Expressions
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Symbol Name Description

>= Greater than or equal to
Compares numeric data. Returns true if the value to the left of the operator is larger than or equal to the
value to the right.

! Not
Evaluates the expression and returns the opposite. Example:  !$zone_temp$ > 72 If zone_temp is greater than
72, the expression is false. If zone_temp is not greater than 72, the expression is true.

== Equal to Compares data. Returns true if the values on both sides of the operator are equal.

!= Not equal to Compares data. Returns true if the value to the left of the operator does not match the value to the right.

&& And Combines expressions. Returns true if the expressions on both sides of && result in true.

|| Or
Combines expressions. Returns true if the expression on either side or both sides of the operator results in
true.

Operators that return a numeric value

+ Add

Adds numeric data, expressions, or values.

NOTE: You can use this operator to concatenate mixed numbers and strings. Example: 1 + alpha
returns 1alpha.

- Subtract Subtracts numeric data, expressions, or values.

* Multiply Multiplies numeric data, expressions, or values.

^ Power
To the power of.

Example: 2^3 (returns 8)

/ Divide Divides numeric data, expressions, or values.

% Modulus Finds the remainder in the division of numeric data, expressions, or values.

Other operators

( ) Parentheses Use to nest expressions. Operations in parentheses are evaluated before those outside parentheses.

if
Syntax:  if (expression, true value, false value)

Expression is evaluated and if 1/true, the true value is returned, otherwise the false value is returned.

? Ternary

Syntax: <condition> ? <expression to execute if the condition is true> : <expression to execute if the condition
is false>

This operator can be used as an alternative to an if statement.

Example: 1 == 2 ? true : false

# Comment Use to make the characters in the line after this operator a comment.

Table 3.37 List of Operators to be Used in Expressions (continued)

NOTE: If no operator is present in an expression, + is assumed. Example: 1 2 3 returns 6, and a b c returns abc.

Combining Expressions

Example 1:

Expression:$zone_temp$ < 60 || $zone_temp$ > 75

Translation:True if the current zone temperature is less than 60 or greater than 75

Example 2:

Expression:! ( $ai1/locked$ || $ai1/present_value$ > 100 )
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Translation:True if ai1 is not locked and al's present value is not greater than 100

Example 3:

Expression:If ($zone_temp$ < 60 || $zone_temp$ > 75, 'out of range', 'good')

Translation:If zone temperature is less than 60 or greater than 75, show out of range. Otherwise, show good.
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Math functions

Function Description

abs (a) Returns the absolute value of a value.

acos (a) Returns the arc cosine of a value; the returned angle is in the range 0.0 through pi.

asin (a) Returns the arc sine of a value; the returned angle is in the range -pi/2 through pi/2.

atan (a) Returns the arc tangent of a value; the returned angle is in the range -pi/2 through pi/2.

atan2 (y, x) Returns the angle theta from the conversion of rectangular coordinates (x, y) to polar coordinates (r, theta).

cbrt (a) Returns the cube root of a value.

ceil (a)
Returns the smallest (closest to negative infinity) value that is greater than or equal to the argument and is equal to a mathematical
integer.

cos (a) Returns the trigonometric cosine of an angle.

exp (a) Returns Euler's number e raised to the power of a value.

floor (a)
Returns the largest (closest to positive infinity) value that is less than or equal to the argument and is equal to a mathematical
integer.

hypot (x, y) Returns sqrt(x2 +y2) without intermediate overflow or underflow.

IEEEremainder (f1,
f2)

Computes the remainder operation on two arguments as prescribed by the IEEE 754 standard.

log (a) Returns the natural logarithm (base e) of a value.

log10 (a) Returns the base 10 logarithm of a value.

max (a, b) Returns the greater of two values.

min (a, b) Returns the smaller of two values.

pow (a, b) Returns the value of the first argument raised to the power of the second argument.

random () Returns a value with a positive sign, greater than or equal to 0.0 and less than 1.0.

rint (a) Returns the value that is closest in value to the argument and is equal to a mathematical integer.

round (a) Returns the closest long to the argument, with ties rounding to positive infinity.

sin (a) Returns the trigonometric sine of an angle.

signum (float f)
Returns the signum function of the argument; zero if the argument is zero, 1.0f if the argument is greater than zero, -1.0f if the
argument is less than zero.

sqrt (a) Returns the correctly rounded positive square root of a value.

tan (a) Returns the trigonometric tangent of an angle.

toDegrees
(angrad)

Converts an angle measured in radians to an approximately equivalent angle measured in degrees.

toRadians
(angdeg)

Converts an angle measured in degrees to an approximately equivalent angle measured in radians.

Table 3.38 Math Functions
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Text functions

Function Description

char (code) Returns a single character string for the given Unicode character code. For example, char(36) will create the string $.

charAT (s, pos) Returns the character and the position.

compareTo (s1, s2) Compares two strings. <0 if s1 <s2, 0 if s1 == s2, >0 if s1 > s2

compartToIgnoreCase
(s1, s2)

Compares two strings ignoring case. <0 if s1 <s2, 0 if s1 == s2, >0 if s1 > s2

concat (s1, s2, ...) Concatenates the two or more strings together. Same as s1 + s2 +

dateDiff (s1, s2) Returns the difference between two dates, in days. Parameters may be date variables or strings of format yyyy/mm/dd

endsWith (s1, s2) Returns 1 if s1 ends with the string s2, else 0.

equals (s1, s2) Returns 1 if strings are equal, else 0.

equalsIgnoreCase (s1,
s2)

Returns 1 if strings are equal ignoring case, else 0.

indexOf (s1, s2, start)
Returns the index (position) of the first occurrence of the second string in the first string after start position. Use 0 to start
from beginning of string. It returns -1 if S2 is not found.

lastIndexOf (s1, s2) Returns the index (position) of the last occurrence of the seconds string in the first string. It returns -1 if S2 is not found.

length (s1) Returns the length of the strings.

newline()

or

\n

Inserts a return.

now (s1)

Returns the current time and accepts one time-format string based on Java SimpleDateFormat. If the string is empty, the
default system date and time format is used.

Examples:

• ""→ 08/28/2020 8:56:59 AM

• "EEEE" → "Friday"

• "MM/dd/yyyy"→ 08/28/2020

• "h:mm a"→ 8:56 AM

• "hh:mm a"→ 08:56 AM

replace (s1, s2, s3) Replaces all occurrences in s1 of s2 with s3.

startsWith (s1, s2) Returns 1" if s1 starts with s2.

substring (s1, i2, i2) Returns subset from string s1 starting at index i1 to index i2. (i2 must be >= i1).

toLowerCase (s) Converts string to lower case.

toUpperCase (s) Converts string to upper case.

trim (s) Removes white space from the beginning and end of the string.

\
Used to escape operator characters by placing it before the operator.

Example: 'Cost is \$' +$cost$' returns "Cost is $10.99".

Table 3.39 Text Functions
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Functions

On the Columns tab of Report Editor, you can specify that the data of a column comes from one of the following functions that
returns another column's value or manipulation of that value.

Function Description

Valid Column Returns true/false if input column is valid.

Default Value Returns the column's value if it is a valid value, otherwise returns the argument.

Format
Formats a value using Java String format function.

For more information, search the Internet for string format with java 8.

Format Duration

Formats a trend duration value.

Argument format:%d%, %h%, %m%, %s%  (clock based) %D%, %H%, %M%, %S%  (total count rounded down)

Example 1:  %ddd% days %hh%:%mm% = 003 days 13:50 Example 2:  %M% min = 283 min

Convert Values to Text

Converts a number to a text value.

Argument format: Define a set of comma separated statements. Format of each statement:  lower limit=value

Example 1:  0=F,60=D,70=C,80=B,90=A,100=A+ Example 2:  F,60=D,70=C,80=B,90=A,100=A+ (first bucket is default for
anything below second bucket's value) Example 3:  Cold,68=Perfect,75=Warm Example 4: 
65=Cold,68=Perfect,74=Perfect,75=Warm,76=Warm

Convert Integer to Text

Converts an integer value to text. If no match, value is empty.

Argument format: Comma separated list of statements. Format of each statement:  #=text

Example:  0=Zero, 1=One, 2=Two, 3=Oops

Convert Text to Integer

Converts text to an integer value. Matching is case insensitive.

Argument format: Comma separated list of statements. Format of each statement:  text=# Use * to match any letters.

Example 1:  Off=0, On=1  -or-  off=0  -or-  OFF=0 Example 2:  a*=1,b*=2 a=1  -or-  APPLE=1 B=2  -or-  Book=2

Convert to Color Attempts to convert an ALC color value (0 to 15) to a color for a color map.

Color Gradient

Converts a defined minimum and maximum number each to a color. It then maps numbers between minimum and maximum
to colors to form a gradient.

Format: min, max, color1, color2

Example 1:  1, 10, red, blue    Example 2:  1, 10, #FF0000, #0000FF

Date Range Start

Formats the START date/time of a Date Range.

Examples: yyyy/MM/dd hh:mm = 2017/07/04 11:30 hh:mm:ss = 08:35:16

For more information, search the Internet for customizing date time formats with java.

Date Range End

Formats the END date /time of a Date Range.

Examples: yyyy/MM/dd hh:mm = 2017/07/04 11:30 hh:mm:ss = 08:35:16

For more information, search the Internet for customizing date time formats with java.

Ordinal Value Converts a text enumeration to its integer value when possible.

Location Tags
Lists all of the semantic tags assigned to the location in each row.

Enter location for the input column ID to create a simple report that shows all of the tags for the locations.

Regular Expression
Finds a piece of text from a larger text body. Example: Finds a piece of text in a modstat.

For more information, search the Internet for regular expression patterns with java 8.

Table 3.40 Functions on Column Tab
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Operations

On the Columns tab of Report Editor, you can specify that the data of a column comes from trend data. You can then specify
one of the following operations be performed on the trend data.

Operation Shows the following for the specified time range

Average Value The average value.

Count All Trend Records Number of trend records collected (includes items such as time changes and enabling/disabling the trend log).

Count Trend Samples Only Number of times the trend value was read.

First Value w/Time The first trend sample and the time it was read.

Last Value w/Time The last trend sample and the time it was read.

Maximum Value w/Time The largest value and the time it was read.

Minimum Value w/Time The smallest value and the time it was read.

Aggregate Consumption Total consumption for meter trend data. This operation makes appropriate calculations for meters that reset to 0.

Sum of Values The total of all trend values.

% Time in Range

You can enter 3 types of arguments to determine the percentage of time that the trend value was:

• One or more single values. Format:  A comma separated list of values

Example: Enter  1, 2, 3, 4  to get the percentage of time that the trend value was 1, 2, 3, or 4.

• Between two values Format: A single statement or a comma separate list of statements

Example 1:  Enter the statement  65:75  to get the percentage of time that the trend value was 65 to 75.

Example 2:  Enter the statement  28:30, 38:40, 48:50  to get the percentage of time that the trend value
was 28 to 30, 38 to 40, or 48 to 50.

• Not a specified value or between two values Format:  !(value)

Example 1:  Enter !10 to get the percentage of time that the trend value was not 10.

Example 2:  Enter !28:30,38:40 to get the percentage of time that the trend value was not 28 to 30 or 38
to 40.

Table 3.41 Operations to be Performed on Trend Data

Icons:

You can design a report that displays icons to indicate different conditions. You can use the icons included with your system
or create custom icons. On the Columns tab of the Report Editor:

1. Set Column data is from field to Expression.

2. Set Render data as field to Icon.

3. Enter an Expression that contains the file name of the icon. See the Table 3.42 on the next page for the file
names of icons included with your system, or see Custom icons on the next page.
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Color On Off Animated .gif that flashes on and off

Red
light_on_red.png light_off_red.png light_alarm_red.gif

Blue
light_on_blue.png light_off_blue.png light_alarm_blue.gif

Light blue
light_on_ltblue.png light_off_ltblue.png light_alarm_ltblue.gif

Green
light_on_green.png light_off_green.png light_alarm_green.gif

Yellow
light_on_yellow.png light_off_yellow.png light_alarm_yellow.gif

Magenta
light_on magenta.png light_off_magenta.png light_alarm_magenta.gif

Orange
light_on_orange.png light_off_orange.png light_alarm_orange.gif

White
light_on_white.png light_off_white.png light_alarm_white.gif

Table 3.42 Included Icons

Custom icons

If you choose to use a custom icon, put the icon in one of the following places:

• In Vertiv™ Liebert® SiteScan™ Web X.X\webroot\<system name>\tables. Put only the icon's file name in the
expression.

• Anywhere under the webroot folder. Put the full path from the webroot folder in the expression.

Example: /_common/lvl5/skin/graphics/type/area.gif.

Variables tab

You can enter a variable in a Report Editor field so that you can edit that field when you run the report. For example, if you
create a date range report for the previous 4 months, you can put a variable named number_of_months in the field instead of a
4. When you run the report, you can change the variable value to 12 to show the previous 12 months.

1. Click Add to create a new variable.

2. Enter the criteria of variable. See Table 3.43 on the facing page.

3. Click Accept or Apply.
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Field Notes

ID
This ID is what you will insert in a report field that you want to be able to change when you run the report. (Use letters, numbers,
underscores, and hyphens only; no spaces or special characters).

Type

Select an option from the drop-down list, and then enter a Value.

Type Value

String A text phrase. Can contain letters, numbers, and special characters.

Number Can contain any number in any format.

Date Format is yyyy/mm/dd.

Time Format is hh:mm:ss.

User editable
Display name

Check to let a user edit the value of variable when they run the report. Enter a Display name for the variable that will appear on the page
where you run the report.

Table 3.43 Variables Tab Fields

NOTE: The table at the top of the Variables tab shows the variables that you defined. Their order in this table is how
they will appear in on the page where you run the report. To change the order on the Variables tab, select a variable in

the table and then click or .

Where tab:

1. Click the drop-down list for This report can be accessed from, and then select an option.

2. Click Define Where.

3. Select or enter information for the option you chose. See Table 3.44 below.

4. Click Accept or Apply.

Field Notes

Anywhere The report can be run from anywhere in the system.

Control Programs

Do one or both of the following:

• Enter a control program name, and then click Add.

NOTE: You can use wildcards. See the examples in the Liebert® SiteScan™ Web interface.

• Select existing control programs from the list.

Location Types Select the types of locations where you want the report to be available.

Locations Select locations on the trees, or type a location name in the text box.

Table 3.44 Where Tab Fields

Options tab:

1. Click the drop-down list to the left of the Add button, and select an option.

2. Click Add.

3. Select or enter information for the option you chose. See Table 3.45 on the next page.

4. Click Accept or Apply.
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Field Notes

Show
Max/Min/Avg/Total

Check the appropriate boxes to show the maximum value, minimum value, average, standard
deviation, or total at the bottom of the columns. Enter the Column ID of the column that you
want labels to be in.

Show first ___rows

Enter the maximum number of rows to be displayed when the report is previewed or run. This does not include the
Max/Min/Avg/Total rows.

NOTE: You can enter a value or variable name in this field. If you enter a variable, it must be defined on the Variables tab.

Sort column

Sorts the specified columns from A to Z or 1 to infinity.

Example of comma separated list of column IDs: date_range, kw_usage, normalizer

Check Reverse Sort to sort Z to A, Infinity to 1.

Filter rows Select Include row when or Exclude row when a specified column (ID) equals a specified value.

Table Calculations Allows custom expressions to be run after all columns have been generated.

Reorder columns Set the order in which columns appear by listing the column IDs separated by commas.

Add appended rows
to chart

Displays data from appended rows in charts, such as Maximum and Minimum.

Table 3.45 Options Tab Fields

NOTE: You can create a report with multiple options, but take into account that they will be processed in the order
they appear in the table at the top of the Options page. For example, if your first option is to Show the first 10 rows
and your second option is Filter rows, only the 10 rows will be filtered. To change the order of processing, select an

option in the table and then click or .

Output tab

On this tab, you can define the criteria for a report PDF or a chart on a graphic:

1. Select or enter information as needed. See Table 3.46 below.

2. Click Accept or Apply.

Field Notes

PDF Output

Page
orientation Select Portrait or Landscape .

Page size Select the page size that you want for a pdf.

Ignore page
width

If the report exceeds the width of the selected Page size, select to ignore that width and show all columns in the online PDF.

Font size You can adjust the font size for the body of the report.

Title font size You can adjust the font size for the title of the report.

Chart These fields apply if you add a Chart control to a graphic in ViewBuilder. See Producing a Chart on page 100.

Table 3.46 Output Tab Fields
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Field Notes

Axis label
For a Horizontal Bar Chart, this label will appear below the X-axis. For a Vertical Bar Chart or Line Chart, this label will appear to the left of
the Y-axis.

Data series A column or row of numbers that are plotted in the chart.

Example:

For this report,

By column

A horizontal bar chart will look like this,

By row

NOTE: Pie charts show only one data series.

Table 3.46 Output Tab Fields (continued)
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Field Notes

Show title

Show legend

Show chart
border

1. Title

2. Chart Border

3. Legend

Graphics
Refresh

A chart or data table control will refresh its report data every time you visit the Graphics page or at the following refresh rates while the
Graphics page is displayed.

Primary column of report Default refresh rate

A Date Range with a Frequency of Hourly or Every 15 minutes Every 5 minutes

Any other Date Range 0 (never refreshes)

Anything else Every 30 seconds

Use custom
refresh rate

Check this field to change the refresh rate. If your chart or data table shows a lot of data, refreshing frequently could slow down your
system. If most of the data is historical data that does not change, you may want to set a longer refresh time.

Reset to
defaults

Click Reset to return all fields on the Output tab to their original settings.

Table 3.46 Output Tab Fields (continued)

Previewing a report

At the bottom of every tab in the Report Editor is a Preview section so that you can check your work. Click Show to see the
report. If you make changes to the report, click Refresh to update the preview.

You have the following options when previewing the report: See Table 3.47 below.

Option Description

Show all columns Includes columns defined as hidden and a column with additional information about the Primary column.

Show Column ID Each column header shows the display name and column ID.

Show Debug Information Gives information for troubleshooting a report.

Table 3.47 Options in Previewing Report
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NOTE: If the preview shows Error, hover your cursor over the word to see a description of the error.

If the preview shows ?, this indicates there is no data.

Running a custom report

To run a custom report:

1. Select an item on the Geographic or Network tree where the report you want to run is accessible.

2. Click the drop-down arrow and select Reports, and then select the report.

3. Optional:If the report was designed with variables (Variables tab on page 88), you can change the values of the
variable at the top of the page.

NOTE: Click Reset if you want to change the variables back to the value that was assigned when the report was
created.

4. Click Run.

NOTE: A ? in the report indicates there is no data.

Click Edit to change the design of the report. See Creating a custom report on page 75 for field descriptions.

Click Schedule to schedule the report to run on a recurring basis. See Scheduling reports on page 109.

Editing or deleting a custom report

1. Click the drop-down arrow and select Reports, and then select Report Manager.

NOTE: Click on the Display Name or ID heading to sort the column.

2. Select the report, and then do one of the following:

• Click Edit to open the Report Editor, make changes as needed, then click Accept. See Creating a custom
report (Creating a custom report on page 75) for field descriptions.

NOTE: To open a report in the Report Editor, double click on it.

• Click Delete, then click OK.

Exporting or importing a custom report

You can export one or more reports from one system, copy them to another system, and then import the reports into the
Vertiv™ Liebert® SiteScan™ Web interface.

To export reports, follow the below steps:

1. Click the drop-down arrow and select Reports, and then select Report Manager.

2. Click Export.

3. Select the checkboxes for the reports that you want to export, or check Select All.

4. Click Export.

NOTE: A single report is exported as a .table file. Multiple reports are exported as a .zip file.

NOTE: In the Report Manager or Export Report window, you can click on the Display Name or ID heading to sort the
column.
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To import reports, follow the below steps:

1. Copy the .table or .zip file to the computer where you are importing them.

2. In the Vertiv™ Liebert® SiteScan™ Web interface, click the drop-down arrow and select Reports, and then select
Report Manager.

3. Click Import.

4. Browse to the file that you are importing.

5. If a report ID that you are importing matches an existing report ID, select how you want to handle the situation:

Option Description

Rename Rename the report that you are importing.

Replace Replace the existing report with the report you are importing.

Skip Do not import the report with the duplicate name.

Table 3.48 Option in the Exporting or Importing the Custom Report

6. Click Import.

Organizing custom reports by category

When you create a custom report, you can assign it to a category so that the report appears in the category in the Reports
button drop-down list.

Figure 3.19 Reports Button Drop-down List

Item Description

1 Report Category

2 Report Name
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To create a report category, follow the below steps:

1. On the System Configuration tree, click to the left of the Categories folder, then click Report.

2. Click Add.

3. Enter the Category Name and Reference Name.

4. Select a privilege so that only operators with that privilege can access reports in the category.

5. Click Accept.

NOTE: To edit a category, select the category, make your changes, then click Accept. To delete a category, select the
category, click Delete, then click Accept.

Using a custom report as the source for a graphics page

A Vertiv™ Liebert® SiteScan™ Web custom report can be the data source for the following items on a Graphics page:

• A data table

• A value

• A chart

• A color map

Please see the Table 3.49 below that shows the report that supplies data to the chart and data table.

Report Data Chart and Data Table

Table 3.49 Data Chart and Data Table for a Report

NOTE: When the graphic is viewed in Time Lapse:

The data in a data table or chart will not change.

A color map will ignore report data and show thermographic colors.

You can modify custom report variables (Variables tab on page 88) directly from a graphic in Liebert® SiteScan™ Web

by clicking the button.
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To Produce a Data Table

To produce a data table like the example in Figure 3.20 below, first create the report in the Vertiv™ Liebert® SiteScan™ Web
interface and then create the corresponding graphic in ViewBuilder.

Figure 3.20 Data Table

Creating the Report in the Liebert® SiteScan™ Web Interface

Instructions Example

1. Click the Reports drop-down arrow, and then select Report
Manager.

2. Click Add.

3. On the Type tab of the Report Editor, type a Display name
and ID for the report.

4. In the Primary column field, select the type of information
that you want the report to be based on (Control Programs
in this example).

5. On the Type tab (Type tab: on page 76), enter the criteria
for the option that you selected in 4 .

6. In the Primary column header field, enter the heading that
you want for that column (Equipment in this example).

Table 3.50 Instructions to Create a Report in Vertiv™ Liebert® SiteScan™ Web Interface
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Instructions Example

7. Define each column in the report on the Columns tab
(Columns tab on page 78). See the examples on the right.

8. Define any other information you may want, and then click
Accept.

Table 3.50 Instructions to Create a Report in Vertiv™ Liebert® SiteScan™ Web Interface (continued)
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Instructions Example

Table 3.50 Instructions to Create a Report in Vertiv™ Liebert® SiteScan™ Web Interface (continued)
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Creating the Graphic in ViewBuilder

Instructions Example

1. Select File > New > Graphic, and then click OK.

2. Click the Add Control tab in the Tools window.

3. Click the Data Table controland then click in the workspace.

4. In the Properties window, enter the Report ID exactly as it appears in
the Vertiv™ Liebert® SiteScan™ Web Report Editor.

5. Resize the control to at least the same size as the table in the
Liebert® SiteScan™ Web interface. Enter a specific size in the
Properties window or drag the handles on the control to resize it.

NOTE: Increase the size of the data table control in ViewBuilder if the table is
cut off when viewing the graphic in the Liebert® SiteScan™ Web interface.

6. If you defined variables in the Report Editor and you want to use a

different default value for the Data Table, click  in the Properties

window, enter the variable's ID (from the Report Editor), and then
type the new default value.

NOTE: To have the data table show data for a location other than the graphic's
location, add a variable and type location in the ID column. Enter the path to the
location in the Value column.

7. Save the graphic.

Table 3.51 Instructions to Create a Graphic in ViewBuilder

Referencing a Value in a Data Table

To reference the value of a cell in a data table, use one of these expressions:

• CELL: table ID,column ID,column ID=value

• CELL: table ID,column ID,numerical position in the column

NOTE: The numerical position in the column can be positive if counting for the top or negative if coming from the
bottom.

Examples

There are several methods to refer to the value of 17.02 in the table called sample table as shown in Figure 3.21 on the next
page:

• CELL: sample_table,c1,location=#e8

• CELL: sample_table,c1,ref=#e8

• CELL: sample_table,c1,3

• CELL: sample_table,c1,-5
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Figure 3.21 Sample Table

Producing a Chart

To produce a bar chart as shown in Figure 3.22 below, first create the report in the Vertiv™ Liebert® SiteScan™ Web interface
and then create the corresponding graphic in ViewBuilder.

Figure 3.22 Bar Chart for Monthly Consumption
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NOTE: When a chart that is based on a report is displayed on a Graphics page, you can hover over various points on
the chart to see values. You can also click on each item in the legend to turn that information on and off. See Using a
custom report as the source for a graphics page on page 95 in Vertiv™ Liebert® SiteScan™ Web Help for more
information on a chart.

Creating the Report in the Liebert® SiteScan™ Web Interface

Instructions Example

1. Click drop-down arrow and select Report, and then
select Report Manager.

2. Click Add.

3. On the Type tab of Report Editor, type a Display name
and ID for the report.

4. In the Primary column field, select the type of
information that you want to report based on (Date
Range in this example).

5. On the Type tab (Type tab: on page 76), enter the
criteria for the option that you selected in step 4 .

6. In the Primary column header field, enter the heading
that you want for that column (Date Range in this
example).

Table 3.52 Instructions to Create Report in the Liebert® SiteScan™ Web Interface
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Instructions Example

7. Define each column in the report on the Columns tab
(Columns tab on page 78).

NOTE: In the example to the right, all four columns have the same
criteria.

8. Define the Chart options on the Output tab (Output
tab on page 90).

9. Define any other information you may want, and then
click Accept.

Table 3.52 Instructions to Create Report in the Liebert® SiteScan™ Web Interface (continued)
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Creating the Graphic in ViewBuilder

Instructions Example

1. Select File > New > Graphic, and then click OK.

2. Click the Add Control tab in the Tools window.

3. Click the Chart control and then click in the workspace.

4. In the Properties window, enter the Report ID exactly as it
appears in the Vertiv™ Liebert® SiteScan™ Web Report Editor.

5. Select the Type of chart you want.

6. Resize the control so that it is at least the size that the chart will
be in the Liebert® SiteScan™ Web interface. To resize, enter a
specific size in the Properties window or drag the handles on the
control.

NOTE: Increase the size of the chart control in ViewBuilder if the chart is
cut off when you view the graphic in the Liebert® SiteScan™ Web interface.

7. If you defined variables in the Report Editor and you want to

use a different default value for the chart, click in the

Properties window, enter the variable's ID (from the Report
Editor), and then enter the new default value.

NOTE: To have the chart show data for a location other than the location of
the graphics, add a variable and type location in the ID column. Enter the
path to the location in the Value column.

8. Save the graphic.

Table 3.53 Instructions to Create a Graphic in ViewBuilder
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Producing a Color Map

A Graphics page color map shows specified colors for various conditions that are defined in a Vertiv™ Liebert® SiteScan™ Web
report. For example, each building on a campus map could show a color that indicates its energy usage. See Figure 3.23
below.

A color map can also have an option that lets a user switch between different kinds of information. For example, in theFigure
3.23 below, a user could click on the MTD kWh drop-down list and select YTD kWh.

Figure 3.23 Graphics Page Color Map

To produce a color map, follow the below steps:

1. Create the graphic in ViewBuilder.

2. Create the corresponding report in the Liebert® SiteScan™ Web interface.

3. Edit the graphic to add information specific to the Liebert® SiteScan™ Web report.
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Create the Graphic in ViewBuilder

Instructions Example

1. Add an image (floorplan, campus map, and so on) to the
graphic, and then double click the image to open the
Associations window.

2. Associate each item on your image (zone, building, ad so on)
just as you would associate zones on a thermographic
floorplan. See "Associating zones on a floorplan to
equipment" in ViewBuilder Help.

NOTE: The Variable Color checkbox in the Associations window must be
checked. 

3. Click Save and Close.

Table 3.54 Instructions to Create the Graphic in ViewBuilder

Create the Report in the Vertiv™ Liebert® SiteScan™ Web Interface

Instructions Example

1. Click drop-down arrow and select Report, and then select
Report Manager.

2. Click Add.

3. On the Type tab of Report Editor, enter a Display name and ID
for the report.

4. In the Primary column field, select Color Map.

5. Enter a location in your system so that you can preview the
report (#building_1 in the example). This location is only for
testing your entries in the Report Editor. Associations to actual
locations in the system will be made in ViewBuilder.

NOTE: You can add more than one location if you want to see more in the
preview.

6. Click Add.

7. Optional:Select Include equipment color column if you want to
automatically include a column for Liebert® SiteScan™ Web
thermographic colors.

NOTE: You can see this column in the Preview section if you check Show all
columns.

Table 3.55 Instructions to Create the Report in the Liebert® SiteScan™ Web Interface
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Instructions Example

8. Define each column in the report on the Columns tab (Columns
tab on page 78). See examples of the first two columns on the
right.

A color map can retrieve color information only from a column
that has the Render data as field set to Color.

9. Define any other information needed on the Report Editor tabs,
and then click Accept.

Table 3.55 Instructions to Create the Report in the Liebert® SiteScan™ Web Interface (continued)
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Edit the Graphic in ViewBuilder to Add Report Information

Instructions Example

Follow steps 1 to 5 if the colormap will show information from more
than one report column. If not, skip to step 6 .

1. Select Configure > View Properties.

2. On the Local Variables tab, click .

3. Double-click Boolean in the Type column, and
then select Report columnin the drop-down list.

4. Double-click variable in the Name column, and then
replace variable with colormap_column.

NOTE: If the Graphic has multiple images that will pull data from
different reports, add one variable called colormap_column1,
another called colormap_column2, and so on.

5. Click OK.

6. Double-click the image to open the Associations
window.

7. Click , and then enter the following information:

• Report ID:  Get the report ID from the Vertiv™
Liebert® SiteScan™ Web Report Editor.

• Default Column ID:  This is the column whose
color is displayed when the graphic first
appears. Get the Column ID from the Liebert®
SiteScan™ WebReport Editor. Leave blank if
the graphic will pull data from only one report
column.

• Column Name Local Variable:  Type the name
of the variable that you created in step 5 .
Leave blank if the graphic will pull data from
only one report column.

8. If a report uses a variable and you want the colormap
to use a different default value than what is defined in

the Liebert® SiteScan™ Web Report Editor, click  in

the Report Properties window, enter the variable's ID
(defined in the Report Editor), and then enter the new
default value.

Table 3.56 Instructions to Edit the Graphic in ViewBuilder to Add Report Information
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Instructions Example

9. If the colormap will show information from more than
one report column, add a control (droplist or radio
buttons) that will allow the user to select the
information they want to see.

10. In the Microblock Path field, enter the local variable
that you defined in step 4 enclosing it in $$.

11. Finish the graphic and then test it in the Vertiv™
Liebert® SiteScan™ Web interface.

Table 3.56 Instructions to Edit the Graphic in ViewBuilder to Add Report Information (continued)

Troubleshooting custom reports

If a Graphics page contains a chart, data table, or color map that is retrieving information from a very large report, the graphic
may be slow to load or refresh. You can do the following to improve this condition:

• Verify that your system follows the recommendations in Liebert® SiteScan™ Web v8.5 client, server, operating
system, and database requirements.

• Reduce the size of the report by redefining the primary column criteria on the Type tab of Report Editor.

• Filter the report to show only a portion of the information. You can filter the report on the Options tab of Report
Editor.

• Increase the refresh time (default is 30 seconds). If the chart, data table, or color map is based on information
that changes infrequently, increase the refresh rate or set it to 0 to turn off refreshing. You can adjust the refresh
rate on the Report Editor's Options tab.

• Reduce the number of controls on the graphic that are pulling data from different reports.

If an Invalid Report Definitions section appears at the bottom of the Report Manager page, one of the following has occurred:

• The file or file name of the report has been manually manipulated, invalidating the report's digital signature.
Contact Technical Support to resolve this problem.

• The report is set up to have an add-on supply content for the report, but the add-on has not been installed in the
Liebert® SiteScan™ Web interface. Install the add-on to resolve this problem.
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3.9.3 Creating a PDF, XLS, or CSV file

To create a PDF, XLS, or CSV file of the reports, see Table 3.57 below.

Reports Output Notes

v7.0 and later custom reports
A PDF file

A CSV file

Preconfigured reports and v6.5 and earlier
custom reports

A PDF file

An XLS file

A CSV file

For a v6.5 and earlier CVS file, you must enable Support CSV text format on the
Reports > Options tab before you run the report.

Table 3.57 Create Output for Reports

To create a output a file, follow the below steps:

1. Run a report.

2. Click PDF, XLS, or CSV to download the file.

To create a CSV file when using Safari, follow the below steps:

1. Run a report.

2. Click CSV. A popup displays the results.

3. Select File > Save As.

4. In the Format field, select Page Source.

5. Add the .csv extension to the file name.

6. Select the save location in the Where field.

7. Click Save.

8. Close the popup.

NOTE: If you need a digitally signed PDF to comply with 21 CFR Part 11, open it in a program that supports digital
signatures, such as Adobe Acrobat, and sign it. The Vertiv™ Liebert® SiteScan™ Web application does not support
digital signing because 21 CFR Part 11 requires that the signature be added manually, not through an automated
process.

3.9.4 Scheduling reports

You can schedule a report so that it runs on a recurring basis. The report is saved as a file (PDF, CSV, or XLS), and you can
choose to have it automatically emailed to someone.

NOTE: To run a report, use the following alarm actions:

The Send E-mail alarm action (Send e-mail on page 1) can run any Liebert® SiteScan™ Web report and attach it to the
email.

The Write to File alarm action (Write to file on page 1) can run any Liebert® SiteScan™ Web report and save it as a file.
For both alarm actions, the report can be a PDF, HTML, XLS, or CSV file.

Scheduling a report

1. Click the drop-down arrow and select Reports, and then select the report that you want to schedule.

2. Click the Schedule button.
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3. Enter the information in each field.

 Fields Notes

Description Enter a brief description of the report or how this schedule will be used.

Operator The report will be run based on the selected operator's privileges.

Run report Define when the report will run by selecting options in the drop-down lists.

At __:__ __ Enter the time of day that you want the report to run.

Save report as

v7.0 and later reports can be output as a PDF or CSV file. Preconfigured reports and v6.5 reports can also be output as an XLS
file. Select the type of report file that you want.

NOTE: See Output tab on page 90 for a description of the PDF options that are available in the Report Editor.

Keep latest
Enter the number of files and Schedule History entries that you want to keep for this report. As a new file or entry is saved, the
oldest one is deleted.

Email report

Enter the information needed to email the report each time it runs.

NOTE: For the Vertiv™ Liebert® SiteScan™ Web application to email a report, you must define the Email Server
configuration on the System Settings > General tab (General tab on page 1).

Table 3.58 Scheduling a Report Fields

4. Click Accept.

NOTE: The following reports have additional scheduling options available. Scheduling these reports without
configuring schedule options results in an error; see View History in Managing scheduled reports below.

• Alarms > Alarms

• Security Reports > Location Audit Log

• Security Reports > System Audit Log

See Configuring scheduled alarms and security reports on page 74.

Managing scheduled reports

Click the drop-down arrow and select Reports, and then select Scheduled Reports. The Table 3.59 below shows any report
that was scheduled to run.

Select a Schedule and then Click To

Edit
Change the schedule of the report in the Schedule Editor.

NOTE: You can also double click a schedule in the table to open the Schedule Editor.

View History
See when the report ran. Click PDF, CSV, or XLS in the Results column to download the report that was produced.

NOTE: The XLS option is not available for v7.0 custom reports.

Delete Remove the schedule. This removes its history and all associated files.

Table 3.59 Reports Scheduled to Run

NOTE: You can also access this table by going to the System Configuration tree and selecting Scheduled
Reports.
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If a Report Fails

The table shown in Figure 3.24 below will show a red X and a system alarm will be generated.

Figure 3.24 Displaying Failed Report

Select the schedule in the table above, and then click View History. Hold the cursor over the word Failure to see hover text
describing what failed.

3.9.5 Working with legacy (v6.5 and earlier) custom reports

Although the Vertiv™ Liebert® SiteScan™ Web v7.0 and above interfaces have a new method of creating and managing
reports, you can still create or edit the following reports that were available in Liebert® SiteScan™ Web v6.5 and earlier
systems. These reports will be accessible from the Reports button drop-down list, but not the Report Manager.

Report Allows to

Equipment Summary

View the following information for equipment at or below the location where the report was created:

• Color

• Active alarm

• Locked values

• Current value of selected points

• Combined schedule

See Creating an equipment summary report below).

Equipment Values Compare point information. See Creating an equipment values report on the next page.

Trend Samples View trend values for a particular time frame. See Creating a trend samples report on page 114.

Table 3.60 Type of Custom Reports

NOTE: You can display icons and hover text on the Geographic tree that show where custom reports have been
created. See Tree Icons and Hover Text on page 12.

You can schedule a report to run on a recurring basis. See Scheduling reports on page 109.

Creating an equipment summary report

An Equipment Summary report can provide the following information for equipment at or below the location where the report
is created.

• Color

• Active alarm

• Locked values

• Current value of selected points

• Effective schedule
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To create an equipment summary report:

1. On the Geographic tree, select the location where you want to view the report.

2. Click the drop-down arrow and select Reports, then select Add Legacy Report.

3. Select Equipment Summary.

4. Optional:Select a Category.

NOTE: The category field is visible only if you have defined report categories. See Organizing custom reports by
category on page 94.

5. Enter a name for the report.

6. Click Create.

7. Define the Title, Page Size and orientation, and the Maximum number of rows.

8. Check or uncheck the Optional Sections checkboxes as needed.

9. Optional:Check Include only specific control programs at or below this location, then type the names of the
control programs.

10. Select Available Points that you want to include in the report. Use Ctrl+click, Shift+click, or both to select multiple
items.

11. Click Add.

12. Click Accept.

13. Click Run.

NOTE: To run this report later, go to the location where the report was created. Click the drop-down arrow and select
Reports, select the report, then click Run.

Creating an equipment values report

NOTE: To see if your system has this optional package, click , then select About. You have this package if
Enabled Features shows Adv. Reporting.

An equipment values report allows you to compare point information.

To create an equipment values report:

1. On the Geographic tree, select the location where you want to view the report.

2. Click the drop-down arrow and select Reports, then select Add Legacy Report.

3. Select Equipment Values.

4. Optional:Select a Category.

NOTE: The Category drop down list is only visible if you have defined report categories. See Organizing custom
reports by category on page 94.

5. Enter a name for the report.

6. Click Create.

7. Do one of the following:
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• Select Include only specific control programs at or below this location, then type the control program
names.

• On the selection tree, select the pieces of equipment you want to view in the report. (Use Ctrl+click ,
Shift+click, or both to select multiple items.) Then click Add.

8. Optional: Check Highlight alternate rows to make the report easier to analyze.

9. Click Next or next to Columns.

10. Verify or change the report title, Page units of measure for defining column widths, and Outer border
characteristics.

11. Select a Column in the report preview.

NOTE: The selected column is light blue.

12. Under Column Header, define how you want the column header to look.

13. Under Column Data, define the data you want in the column and how you want it to look. See Table 3.61 below.

NOTE: Select General from the Format drop-down list unless you want to define the number of places to the right of
the decimal point for the displayed value.

14. Optional:Use the Add, Delete, and arrow buttons below the report preview to manipulate the columns.

15. Optional:Click next to Page to change the page size and orientation.

NOTE: Changing the size and orientation of the printed page also changes the report layout on the View tab.

16. Click Accept.

17. Click Run.

NOTE: To run this report later, go to the location where the report was created. Click the drop-down arrow and select
Reports, select the report, then click Run.

Type of Column

Data
Description

Point

Displays point data in the column.

Display Select the property to show in this column.

Data is named differently in
some control programs

Select this checkbox if similar points have different names in different control programs. Add each of
the names to the Name to use list.

For example, if a point is named Zone Temp in one control program and Zone Temperature in
different control program, add both names to the list.

Point to use Select the name of the point to show in the column.

Table 3.61 Data and it's Representation
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Type of Column

Data
Description

Trend Sample

Display Select First, Minimum, Maximum, or Last recorded trend value.

Data is named differently in
some control programs

Select this checkbox if similar points have different names in different control programs. Add each of
the names to the Name to use list.

For example, if a point is named Zone Temp in one control program and Zone Temperature in
different control program, add both names to the list.

Trend to use Select the name of the point to show in the column.

Set Click to have all columns in the report use the same time range.

Time Range Select the time range to run the report for.

Trend Calculation

Display Select the type of calculation to show in the column, Average or Total.

Data is named differently in
some control programs

Select this checkbox if similar points have different names in different control programs. Add each of
the names to the Name to use list.

For example, if a point is named Zone Temp in one control program and Zone Temperature in
different control program, add both names to the list.

Trend to use Select the name of the point to show in the column.

Set Click to have all columns in the report use the same time range.

Time Range Select the time range to run the report for.

Control Program Display
Select Color, Display Name, Display Path, Notes, Prime Variable, or Reference Name to show in the
column.

Expression

Data is named differently in
some control programs

Select this checkbox if similar points have different names in different control programs. Add each of
the names to the Name to use list.

For example, if a point is named Zone Temp in one control program and Zone Temperature in
different control program, add both names to the list.

Expression

Type the path relative to the current control program. The path must return a string value. Defining
Vertiv™ Liebert® SiteScan™ Web paths on page 54 for more information on paths.

To display the Notes on an equipment's Properties page, enter .notations in this field.

Table 3.61 Data and it's Representation (continued)

Creating a trend samples report

NOTE: To see if your system has this optional package, click , then select About. You have this package if
Enabled Features shows Adv. Reporting.

A Trend Samples report provides trend values for a particular time frame.

To create a trend samples report:

1. On the Geographic tree, select the location where you want to view the report.

2. Click the drop-down arrow and select Reports, then select Add Legacy Report.

3. Select Trend Samples.

4. Optional:Select a Category.
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NOTE: The Category drop down list is only visible if you have defined report categories. See Organizing custom
reports by category on page 94.

5. Enter a name for the report.

6. Click Create.

7. Select a Time Range from the drop-down list, then refine that option by selecting an option from the drop-down
lists to the right.

8. Define the trend data.

NOTE: Calculate values for missing samples calculates a value based on the 2 closest values to the time interval.

Find the closest sample displays the value closest to the time interval selected.

9. Optional:Check Highlight alternate rows to make the report easier to analyze.

10. Click Next or next to Columns.

11. Verify or change the report title, Page units of measure for defining column widths, and Outer border
characteristics.

12. Select a column in the report preview.

NOTE: The selected column is light purple.

13. Under Column Header, define how you want the column header to look.

14. Under Column Data, select the source of the trend data and how you want the data to look.

NOTE: Select General from the Format drop-down list unless you want to define the number of places to the right of
the decimal point for the displayed value.

15. Optional:Use the Add, Delete, and arrow buttons below the report preview to manipulate the columns.

16. Optional:Click next to Page to change the page size and orientation.

NOTE: Changing the size and orientation of the printed page also changes the report layout on the View tab.

17. Click Accept.

18. Click Run.

NOTE: To run this report later, go to the location where the report was created. Click the drop-down arrow and select
Reports, select the report, then click Run.

Saving the design of v6.5 or earlier custom report for use in another location or system

You can save the design of an Equipment Values report or a Trend Samples report for reuse in another location or in another
system. Or, you can create a library of different report designs to pull from as needed.

To save the design of report, follow the below steps:

1. Create the Equipment Values (see Creating an equipment summary report on page 111) or Trend Samples
(Creating a trend samples report on the previous page) report.

2. On the Reports > Design tab, click the Save Report Design button. The design is saved to
SiteScanx.x/webroot/<system>/Reports/<report name>.reportdesign.

NOTE: The .reportdesign file includes the report name. If you save multiple report designs in your system, each of
those reports must have a unique name.
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To use the report design at a different location in the system, follow the below steps:

1. Select the location in the Geographic tree.

2. Select Reports > Add Legacy Report.

3. In step 1 , select Report design, then select the report name in the drop-down list.

4. In step 2 , enter a report Name.

5. In step 3 , click Create.

To copy individual report design files to another system, follow the below steps:

1. In Windows Explorer, go to the SiteScanx.x/webroot/<system>/Reports/ folder.

2. Copy the *.reportdesign files that you want.

3. In the new system, paste the copied files in the SiteScanx.x/webroot/<system>/Reports/ folder.

4. Follow the steps above in To use the report design at a different location in the system, follow the below steps:
above.

To create a .zip file to import into another system, follow the below steps:

NOTE: The import process will not import a file if it has the same name as a file in the other system. Make sure your
file names are unique.

1. Do one of the following:

• Create a .zip file that contains the *.reportdesign files that you want. These files may be in the
SiteScanx.x/webroot/<system>/Reports/ folder, or in a library that you created.

• On the System Settings > General tab, under Source Files, click Export.

NOTE: Export creates a .zip file that contains all of the system's source files (control programs, drivers, view files,
touchscreen or BACview files, report design files).

2. In the new system, go to the System Settings > General tab.

3. Under Source Files, click Import.

4. Browse to the .zip file.

5. Click Continue.

6. Click Close. The Vertiv™ Liebert® SiteScan™ Web application will put the imported files in the correct folder.

Editing or deleting a v6.5 or earlier custom report

To edit or delete a v6.5 or earlier custom report:

1. Select the Item on the Geographic tree where the report was created.

2. Click the drop-down arrow and select Reports, then select the report you want to edit or delete.

3. Do one of the following on the Design tab:

• Edit the report, then click Accept.

• Click the Delete Report button, then click OK.
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4 Using the Configuration View
Most of the configuration for Vertiv™ Liebert® SiteScan™ Web is performed by Vertiv. This section provides instructions on
how to change the most-commonly-used configuration settings.

When you select the configuration view, the menus described in Configuration View Menus and Options below, are offered.

Navigation Tree Option View Tab Options

My Settings Lets the logged-in user configure personal options and information.

System Settings
Lets you view and in some cases, configure general Liebert® SiteScan™ Web options and daylight saving options. See System
settings on page 130

Operators Lets you set up Liebert® SiteScan™ Web users. See Operator Access below.

Privilege Sets
Lets you set up and assign access and use Liebert® SiteScan™ Web options to individual operators or groups. See Privilege sets
on the next page.

Operator Groups
Lets you group operators to simplify assigning access privileges and setting up message notification recipients. See Operators
and operator groups on page 121.

Services Lets you view a list of services used by Liebert® SiteScan™ Web and the status of each. See Services Status on page 141.

Trends Display Setup
Lets you customize the color and other display options of the trend graphs. See Configuring the Trends Display Setup on
page 141.

Trends Print Setup Lets you specify the appearance of printed trend graphs. See Configuring Trends Print Setup on page 142.

Table 4.1 Configuration View Menus and Options

4.1 Operator Access

Privileges control which parts of the Liebert® SiteScan™ Web system an operator can access. Privileges also control what an
operator can do and what he can change.

To set up operator access to your system, follow the below steps:

1. Login to the Liebert® SiteScan™ Web application as the Administrator. See Operators and operator groups on
page 121.

2. Define privilege sets by job function. See Privilege sets on the next page.

3. Enter each operator in the system by assigning him privilege sets and entering settings that apply only to him. If
you need to assign the same privilege set to multiple operators, you can create an operator group and assign the
privilege set to the group. See Operators and operator groups on page 121.

See Changing my settings on page 123 change the settings of an operator.

To access the Liebert® SiteScan™ Web interface, an operator must enter his user name and password. See Advanced
password policy on page 125 to change the rules for passwords.

Restricting Operator Access

To restrict access to your system, follow the below steps:

• Restrict the privileges of an operator.

• Use location dependent operator access (Location dependent operator access on page 125).
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• Change Editing Privilege of a microblock from Preset to a specific privilege. The properties of a microblock will be
editable only by an operator that has that privilege.

CAUTION: Each microblock property has a default Editing Privilege (represented by the Preset option) that is
appropriate for that property. Changing Preset to a specific privilege changes every property in the
microblock to the same privilege which may produce undesirable results.

4.1.1 Privilege sets

A privilege set is a group of one or more privileges (see Privileges below). The Administrator creates privilege sets and assigns
them to operators and operator groups.

Privileges

This Privilege Allows an Operator

System
Administration
Privilege

• Add, edit, and delete operators, operator groups, and privilege sets.

• Update the Vertiv™ Liebert® SiteScan™ Websystem with service packs and patches.

• Register the Liebert® SiteScan™ Web software. See Registering your Liebert® SiteScan™ Web software on page 1.

• Enable and set up advanced security features such as location dependent operator access (Location dependent
operator access on page 125) and the advanced password policy (Advanced password policy on page 125).

• Add and remove Liebert® SiteScan™ Web add-ons such as EnergyReports.

Table 4.2 Privilege

This Access Privilege Allows an Operator to Access (But Not Edit)

Access Geographic Locations
Pages from the Geographic tree.

Access Network Items
Pages from the Network tree.

Access Groups
Pages from the Schedule Groups tree.

Access Config Items
Pages from the System Configuration tree.

Access Alarms Alarms.

Access Logic Pages Logic pages.

Access User Category 1-5 Anything in a category that has the same privilege assigned to it. See Creating a custom privilege on page 120 below.

Table 4.3 Access Privilege
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This Parameter Privilege Allows an Operator to Edit Properties such as

Edit Setpoint Parameters Occupied and unoccupied heating and cooling setpoints.

Edit Setpoint Tuning Parameters
Demand level setpoint offsets, thermographic color band offsets, heating and cooling capacities
and design temperatures, color hysteresis, and learning adaptive optimal start capacity
adjustment values.

Edit Tuning and Logic Parameters Gains, limits, trip points, hysteresis, color bandwidths, design temperatures, and optimal start/stop.

Edit Manual Override Parameters Locks on input, output, and network points.

Edit Point Setup Parameters Point number, type, range, and network source and destination.

Edit Restricted Parameters Properties the installer restricted with this privilege.

Edit Category Assignments Alarm, Graphic, Trend, and Report category assignments.

Edit History Value Reset Elapsed active time and history resets, and runtime hours.

Edit Trend Parameters Enable trend logging, log intervals, and log start/stop times.

Edit Calibration Parameters Point calibration offsets.

Edit Hardware Controller Parameters Driver properties.

Edit Critical Configuration Critical properties the installer protected with this privilege.

Edit Area Name Area display names.

Edit Control Program Name Control program display names.

Edit Alarm Configuration Enabling/disabling alarms and editing alarm messages, actions, categories, and templates.

InterOp Privilege 1 - 10 Those protected by password levels 1-10 in SuperVision.

Table 4.4 Parameter Privilege

This Functional Privilege Allows an Operator to

Manage Alarm Messages and
Actions

Add, edit, and delete alarm messages and actions.

Maintain System Parameters Edit all properties on the System Settings page.

Maintain Schedules Add, edit, delete, and download schedules.

Maintain Schedule Group
Members

Add, edit, and delete schedule groups.

Maintain Categories Add, edit, and delete categories.

Maintain Alarm Templates Edit Alarm Template and Reporting Action Templates.

Acknowledge Non-Critical Alarms Acknowledge all non-critical alarms.

Acknowledge Critical Alarms Acknowledge all critical alarms.

Force Normal Non-Critical Alarms Force non-critical alarms to return to normal.

Force Normal Critical Alarms Force critical alarms to return to normal.

Delete Non-Critical Alarms Delete non-critical alarms.

Delete Critical Alarms Delete critical alarms.

Table 4.5 Functional Privilege
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This Functional Privilege Allows an Operator to

Execute Audit Log Report Run the Location Audit Log and System Audit Log reports.

Download Controllers Mark equipment for download and initiate a download.

System Shutdown Issue the Shutdown manual command that shuts down the Vertiv™ Liebert® SiteScan™ Web Server application.

Engineer System

• Login and make database changes in SiteBuilder.

• Use the copy, notify, reload, and revert manual commands.

• Access the Configure and Set up Treeright-click menus in the Liebert® SiteScan™ Web interface.

• Add text in the Notes field on an equipment's Properties page of an equipment.

• Set Device Passwords in SiteBuilder, or the SiteScan™ interface, to restrict access to the controller
setup pages through the Service Port (applies only to routers with the drv_gen5 driver).

Access Commissioning Tools

Access:

• Equipment Checkout

• Airflow Configuration

• Trend, Report, and Graphic categories that require this privilege

• Discovery tool

Maintain Graphs and Reports Add, edit, and delete trend graphs and reports.

Maintain Connections Edit Connections page properties.

Remote File Management Access files using a WebDAV utility.

Remote Data Access-SOAP Retrieve Liebert® SiteScan™ Web data through an Enterprise Data Exchange (SOAP) application.

Do not audit changes made using
SOAP (Web services)

Not have his SOAP (web services) changes recorded in the Audit Log.

Manual Commands/Console
Operations

Access the manual command dialog box and issue basic manual commands.

Manual Commands/File IO Execute manual commands that access the server's file system.

Manual Commands/Adv Network Execute manual commands that directly access network communications.

Manual Commands/Unrestricted Execute manual commands that bypass all safeguards and may cause unpredictable results if used incorrectly.

Change My Settings Edit his preferences on the My Settings page.

Table 4.5 Functional Privilege (continued)

Creating a custom privilege

You can assign a privilege to a Graphic, Property, Trend, or Report category so that only operators with that privilege can
access the category. You can assign a category privilege on the page where you create or edit categories.

If all the other privileges are too widely used to accomplish the results you want, you can assign one of the five Access User
Category privileges to the operators and category.

For example, your system has 2 graphics categories, HVAC and Lighting/Security. You want HVAC technicians to see only the
HVAC graphics and security personnel to see only the Lighting/Security graphics. To do this, see Table 4.6 on the facing
page:
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Assign To Results

Access User
Category 1

HVAC graphics category and HVAC
technicians only

The security personnel cannot see the HVAC graphics because they do not have
Access User Category 1.

Access User
Category 2

Lighting/Security Graphics category and
Security personnel only

The HVAC technicians cannot see the Lighting/Security graphics because they do
not have Access User Category 2.

Table 4.6 Creating a Custom Privilege

Adding or editing a privilege set:

1. On the System Configuration tree, select Privilege Sets.

2. Click Add to create a new privilege set, or select a privilege set to edit.

3. Enter the Name and Reference Name for the privilege set.

4. Check each privilege (Privileges on page 118) that you want to include in the privilege set.

5. Click Accept.

CAUTION: Include all required access privileges in a privilege set. For example, if you add Acknowledge Non-
Critical Alarms to a privilege set, also add Access Alarms to that privilege set.

NOTE: To create a privilege set that is similar to an existing set, select the existing set, then click Add. The privileges
that are initially selected are identical to those of the existing set (Location independent security only).

Deleting a privilege set

1. On the System Configuration tree, select Privilege Sets.

2. Select the privilege set to be deleted.

3. Click Delete.

4. Click OK.

5. Click Accept.

4.1.2 Operators and operator groups

When you create a new system in SiteBuilder, you assign a login name and password to the administrator operator. This
administrator operator sets up each operator in the Vertiv™ Liebert® SiteScan™ Web interface by entering the necessary
settings and assigning one or more privilege sets (see Privilege sets on page 118) to the operator.

Operator groups give you the ability to assign privilege sets to a group of operators instead of the individual operators.
Operator groups are useful if you have multiple operators who need the same privilege set or you have positions with high
turnover rates. You can assign an operator to a group when you enter the operator or when you create the operator group.

NOTE: When using hierarchical servers, you must create identical operators on each server in order to navigate across
servers.

CAUTION: Passwords can be forgotten. To ensure access to the Liebert® SiteScan™ Web administrative
functions, assign the Admin privilege set to at least 2 operators.
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Adding or editing an operator

1. On the System Configuration tree, select Operators.

2. Click Add to enter a new operator, or select an operator to edit his settings.

3. Enter information on this page as needed. See Table 4.7 below.

4. Click Accept.

Field Notes

Login Name The name the operator must type to login to the system. This name must be unique within the system.

Change password
Enable this field, then type the current and new passwords.

NOTE: An operator can change his password on the My Settings page (Changing my settings on the facing page).

Force User to Change
Password at login?

Forces the operator to change his password immediately after his next login.

NOTE: Use this field with the Change Password field to create a temporary password that the operator must change
after his next login.

Exempt From Password
Policy

If Use advanced password policy is enabled on the System Settings > Security tab (see  Security tab on page 1), select this
option if you do not want the policy to apply to this operator.

Ready to e-sign

This checkbox indicates the operator can e-sign documents. It only appears checked when E-signature file uploaded and
Signing privileges granted are checked.

• E-signature file uploaded indicates the operator has uploaded a valid e-signature file (see E-signature on
page 124).

• Signing privileges granted indicates the operator has e-signature signing privileges (see Privilege sets on
page 118).

NOTE: These checkboxes are read only.

Logoff options
If Log off operators after __ of inactivity is enabled on the System Settings > Security tab (see Security tab on page 1), select
one of the 3 logoff options.

Personal Information

You can enter contact information for this operator.

NOTE: An operator can enter contact information on the My Settings page (Changing my settings on the facing
page).

Starting Location and
Starting Page

The Vertiv™ Liebert® SiteScan™ Web location and page that will be displayed after the operator logs in.

System-wide Privilege Sets

Select the privilege sets that you want to assign to the operator. The Effective System-wide Privileges list show which
privileges the operator will have.

NOTE: Click Show current privileges only to see only the selected privilege sets and privileges.

NOTE: A grayed out privilege set with a group name beside it indicates the operator is inheriting that privilege set
from the group.

Table 4.7 Fields for Adding or Editing an Operator

NOTE: To test the settings and privileges that you gave to an operator, you can open a second browser session on
your computer and login as the operator. For instructions on opening a second session in the browser you are using,
see Setting up and using a web browser to view the Liebert® SiteScan™ Web interface (see Setting Up a System in the
Vertiv™ Liebert® SiteScan™ Web Interface on page 130).
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Deleting an operator

To delete an operator:

1. On the System Configuration tree, select Operators.

2. Select the operator.

3. Click Delete.

4. Click Accept.

Adding or editing an operator group

To add or edit an operator group:

1. On the System Configuration tree, select Operator Groups.

2. Click Add to create a new operator group, or select an operator group to edit it.

3. Enter the Display Name and Reference Name for the operator group.

4. Under Members, select the operators and/or groups that you want to add to the new group.

5. Under Privilege Sets, select the privilege sets (see Privilege sets on page 118) that you want to assign to the new
group.

NOTE: To see what privileges are included in a privilege set, go to the Privilege Sets page and then select the Privilege
set in the table.

6. Click Accept.

NOTE: Every operator is automatically a member of a permanent default group called Everybody. You can assign
privilege sets to this group.

Deleting an operator group

To delete an operator group:

1. On the System Configuration tree, select Operator Groups.

2. Select the operator group.

3. Click Delete.

4. Click Accept.

CAUTION: When you delete an operator group, its individual members lose the privilege sets that were
assigned to the group.

4.1.3 Changing my settings

On the My Settings page, you can change settings, such as:

• Password

• Viewing preferences
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• Contact information

NOTE: The System Administrator can also change these settings on the Operators page.

To change your settings:

1. On the System Configuration tree, select My Settings.

2. Make changes on the Settings or Contact Info tab. See Table 4.8 below.

3. Click Accept.

Field Notes

Settings Tab

Change password Enable this field, then type your current and new passwords.

Starting Location and Starting Page The Vertiv™ Liebert® SiteScan™ Web location and page that will be displayed after you login.

Language

The language and formatting conventions you want to see in the Liebert® SiteScan™ Web interface.

NOTE: If you will be using a language other than English, see Setting Up a System for Non-English
Languages on page 147 for additional requirements.

NOTE: If support for your selected language is removed in SiteBuilder, the Liebert® SiteScan™ Web
application will automatically assign the System language to you.

Automatically collapse trees Expands only one tree branch at a time.

Automatically download schedules on each
change

Select to automatically download all new schedules that you create and schedules that you change.

Play sound at browser when server receives

Check Non critical alarms or Critical alarms if you want the system to audibly notify you when that type of
alarm is received.

You can specify a different sound file.

• Microsoft Edge, Firefox, and Safari support .wav, .mp3, or .au files.

• Google Chrome supports .wav or .mp3 files.

1. Put your file in the webroot\_common\lvl5\sounds folder.

2. In the Sound File field, replace normal_alarm.wav or critical_alarm.wav with the name of
your sound file.

NOTE: You can put your sound file anywhere under the SiteScanx.x folder, but you must change the
path in the Sound File field.

E-signature

E-signature File

An e-signature file is required to add an e-signature to Scheduled Reports.

1. Click Choose File and select your e-signature file.

2. Click Upload.

NOTE: These options may be limited to a specific license or optional package. See SiteScan™ editions and optional packages for more
information.

Table 4.8 Fields for Changing Settings
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4.1.4 Advanced password policy

You can set up a Vertiv™ Liebert® SiteScan™ Web password policy to meet your security needs.

1. On the System Configuration tree, select System Settings.

2. On the Security tab under Operators, enter information in the fields described in Table 4.9 below.

NOTE: See System Settings on page 1 for information on all the other fields.

Field Notes

Use advanced password policy

Enable this field to put restrictions on passwords.

Login name and password of an operator must be different when this policy is enabled.

After you change the password policy, any operator whose password doesn't meet the new requirements will not be
locked out of the system, but will be prompted to create a new password.

NOTE: This password policy also applies to site-level passwords.

Passwords must contain

You can specify how many characters and which of the following types of characters a password must contain:

• Numbers

• Special characters: Any keyboard character that is not a number or letter.

• Letters: Uppercase, lowercase, or both.

Cannot be changed more than
once every __ days.

Enter a number to limit how often users can change their passwords. When set to 0, users can change them as often
as they want.

May not be reused until __
different passwords are used.

Enter a number between 1 and 20. Enter 0 to reuse passwords without a delay.

Expire after __ days
Enable to set the number of days an operator can use his password before the system requires him to change it. Enter
a number between 1 and 999.

Force expiration
Click this button to force every user's password to expire. Each user will be prompted to change their password when
they next attempt to login to the Liebert® SiteScan™ Webinterface.

Table 4.9 Fields for Advanced Password Policy

NOTE: The Advanced password policy settings do not synchronize across hierarchical servers. You should set up each
system with the same advanced password settings to avoid problems when navigating between the systems.

4.1.5 Location dependent operator access

You can set up operator access to your system to be location dependent. This type of operator access lets you assign
privileges to an operator only at locations in the system where he needs them. For example, you could assign an operator
mechanic privileges in one building in a system, view-only privileges in another building, and no privileges in a third building.

New and converted Liebert® SiteScan™ Web systems default to location independent operator access in which an operator’s
privileges apply throughout the system. You should understand this type of operator access before switching to location
dependent. See Operator Access on page 117 for more information on location independent operator access.

NOTE: When using hierarchical servers, the security policy and privilege sets are local to each server, so you can have
location independent security on one server but not on another.
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Switching to location dependent access

CAUTION: Create a backup of your system before you begin. Switching to location-dependent operator
access changes the configuration of operators and privilege sets. If you need to revert to location-
independent operator access, your previous configuration cannot be automatically restored.

CAUTION: If you change the policy after you create and assign privilege sets to operators, you may need to
reconfigure your operators’ privileges.

To switch to location dependent operator access, follow the below steps:

1. On the System Configuration tree, select System Settings.

2. On the Security tab under Security Policy, click Change Policy.

3. Follow the on screen instructions.

Privileges and privilege sets

When using location dependent operator access, privileges are either system wide or local.

System wide privileges allow an operator to perform functions throughout the entire system, such as accessing the
Configuration tree or performing a system shutdown.

Local privileges allow an operator to perform functions in a specific area of the system, such as editing setpoints or viewing
alarms. Assigning any local privilege to an operator also allows him to change his password and set preferences on his My
Settings (see Changing my settings on page 123) page.

You assign system-wide privileges to system-wide privilege sets and local privileges to local privilege sets. See Table 4.10 on
the facing page for planning which privileges to assign to a privilege set. For a description of each privilege, see Privileges on
page 118).
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System Wide Privileges Local Privileges

Access Groups

Access Config Items

Maintain System Parameters

Maintain Schedule Group Members    

Maintain Categories

Maintain Trends Display and Print Setup

Maintain Alarm Templates

Acknowledge Non-Critical Alarms

Acknowledge Critical Alarms

Force Normal Non-Critical Alarms

Force Normal Critical Alarms

Delete Non-Critical Alarms

Delete Critical Alarms

Execute Audit Log Report

Download Controllers

System Shutdown

Engineer System

Access Commissioning Tools

Maintain Graphs and Reports

Maintain Connections

Remote File Management

Remote Data Access-SOAP

Do not audit changes made using SOAP (Web services)

Manual Commands/Console Operations

Manual Commands/File IO

Manual Commands/Adv Network

Manual Commands/Unrestricted

Change My Settings

Access Geographic Locations

Access Network Items

Access Alarms

Access Logic Pages

Access User Category 1 - 5

Edit Setpoint Parameters

Edit Setpoint Tuning Parameters

Edit Tuning and Logic Parameters    

Edit Manual Override Parameters

Edit Point Setup Parameters

Edit Restricted Parameters

Edit Category Assignments

Edit History Value Reset

Edit Trend Parameters

Edit Calibration Parameters

Edit Hardware Controller Parameters

Edit Critical Configuration

Edit Area Name

Edit Control Program Name

Edit Alarm Configuration

InterOp Privilege 1 - 10

Manage Alarm Messages and Actions

Maintain Schedules

Table 4.10 System Wide and Local Privileges

NOTE: For an operator to add, edit, or delete schedule groups, he must have the system wide privilege Maintain
Schedule Group Members. He must also have the local privileges Access Geographic Locations and Maintain
Schedules at each location that is a member of the schedule group.

NOTE: If you switch to location-dependent operator access in a system that has operators and privileges set up, the
Vertiv™ Liebert® SiteScan™ Web application splits any existing privilege set containing local and system wide
privileges into 2 separate privilege sets - one local and one system wide. Operators system wide privilege sets still
apply throughout the system. The operators’ local privilege sets are automatically assigned at the system level. You
can then reassign the local privilege sets to the operators at the locations where they need them.
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Adding a privilege set

Adding a privilege set using location dependent operator access is the same as using location independent operator access
except that you must select whether you are adding a system wide or local privilege set. See Privilege sets on page 118.

Assigning privilege sets to an operator

Assign a system wide privilege set to an operator on the Operators page in the same way you would assign privilege sets in a
system using location independent operator access. See Operators and operator groups on page 121.

Assign a local privilege set to an operator at locations on the Geographic or Network tree where he needs the privileges.

To assign privilege sets to an operator:

1. Select a location on the Geographic or Network tree.

2. Click Privileges.

3. On the Configure tab, click Add.

4. Select the Operator or Operator group.

5. Click OK.

6. Select the privilege sets that you want the operator to have.

7. Click Accept.

NOTE: You can display icons and hover text on the Geographic tree that show where privileges have been assigned.
See Tree Icons and Hover Text on page 12.

Deleting a local privilege set assignment

To delete a local privilege set assignment:

1. On the Geographic or Network tree, select the location where the assignment was made.

2. Click Privileges.

3. Select the assignment under Privilege Set Assignments at this Level.

4. Click Delete.

5. Click Accept.

Restricting access in the system

Restricting access of an operator to areas of the system

You can give an operator access to only a specific area of the system. All other areas will be either grayed out or not visible
when the operator logs in to the Vertiv™ Liebert® SiteScan™ Web interface.

Example: If you give an operator the Access Geographic Locations privilege only at the first floor of the system shown below,
he will see a navigation tree like the one on the left. The areas above the first floor are visible because he needs them to
navigate to the first floor, but grayed out because he cannot access them. The operator does not see Dallas, New York, or San
Francisco because he can’t access them and does not need them to navigate.
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Figure 4.1 Restricted Access

Figure 4.2 Full System Access

Restricting all operator access to a location

To remove all local privileges of all operators from a location so that you can assign access only to a specific operators,
navigate to the location, select Privileges, then uncheck Inherit security privileges from above this level.

Security assignments report

A Security Assignments Report shows local and system-wide privileges and privilege sets of an operator at a specific location.

To run security assignment report:

1. Select the location on the Geographic or Network tree.

2. Click the drop-down arrow and select Reports, then select Security > Security Assignments.

3. On the Options tab, select an operator.

4. Click Run.

Recording reasons for edits (21 CFR Part 11)

Vertiv™ Liebert® SiteScan™ Web provides support for 21 CFR Part 11. The Liebert® SiteScan™ Web application can require an
operator to record a reason for changing an equipment property, or acknowledging an alarm, before it accepts the change.
The Liebert® SiteScan™ Web Audit Log report then displays the operator's name and the recorded reason for making the
change.
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To set up equipment to require reasons for changes, follow the below steps:

1. On the Vertiv™ Liebert® SiteScan™ Web Geographic or Network tree, right-click the equipment, then select
Configure.

2. Check Require operator to record any changes to control program and when acknowledging alarms.

NOTE: In order to enable this feature to record changes, you must also enable Alarm requires acknowledgment and/or
Return requires acknowledgment. See Setting up, editing, or disabling alarm sources on page 47).

3. Click Save.

NOTE: You can also turn this setting on in SiteBuilder in the equipment's properties dialog box.

To view reasons for changing equipment properties, follow the below steps:

1. On the Liebert® SiteScan™ Web tree, select a piece of equipment that requires reasons for change.

2. Click the drop-down arrow and select Reports, select Security > Location Audit Log or System Audit Log.

3. On the Options tab under Display the following columns, select the Reason checkbox.

4. Click Run.

4.2 Setting Up a System in the Vertiv™ Liebert® SiteScan™ Web
Interface

4.2.1 System settings

The System Settings page contains information that you must enter before the Liebert® SiteScan™ Web application can run
properly.

1. On the System Configuration tree, select System Settings.

2. Click each tab, then enter the necessary information. Tab details are described below:

General tab

The General tab presents the following system information:

• System Directory Name

• Path to the Webroot Directory

• Database Type

• System Language: The language to be used for:

• The default language for new operators

• Alarms logged to the database

• State text and object names downloaded to the field

• The login page

NOTE: Language also refers to formatting conventions. For example, English uses the date format mm/dd/yy, but
English (International) uses the date format (dd/mm/yy).

You can edit or use the following fields and buttons.
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Field Notes

System Information

System Statistics button

Click to see the following system information:

• Number of controllers

• Number of controllers that can run control programs

• Number of points, regardless of vendor

•   Number of trend sources in database

• Number of trend samples in database

Levels displayed in paths

The number of levels displayed in Vertiv™ Liebert® SiteScan™ Web paths. For example, if Node Name Display Depth is
set at:

    2, a typical path might be ..\AHU-1\RA Temp

    3, a typical path might be  ..\Atlanta R&D\First Floor\AHU-1

NOTE: Changing this field does not take effect until you restart the SiteScan Server application.

Logs

Select a week of logs to review For troubleshooting, you can download a zip file that contains logs of system activity.

Time

Time Sync

Click to immediately synchronize the time on all IP network controllers in the system database to the Liebert®
SiteScan™ Web server's time.

Time synchronization occurs daily if the Enable time synchronization of controllers daily at____ field on the Scheduled
Tasks tab (see Scheduled tasks tab on page 135) is enabled. (Click this link for more information on time
synchronization.)

Time Format

Select one of the following for the system time:

• 12 hour clock (Example: 4:34 pm)

• 24 hour clock (Example: 16:34)

Date Format Select the format you want the system to use.

Update Devices
Click to apply Time Format and Date Format to all IP network controllers in the system database. This function only
applies to controllers with Gen 5 firmware or later.

Alarms

Use a single alarm template for
CMnet alarms

If your system is an upgraded legacy system:

• Check to have alarms for CMnet equipment use only the alert_auto alarm template.

• Uncheck to allow multiple alarm templates.

Enable support for Alarm
Notification Clients to connect
to this server

Check to use the Alarm Notification Client application. See Alarm Popup (see Alarm Popup on page 1 ) alarm action.

NOTE: When using location-dependent security, users only receive alarms for locations they are allowed to
access.

Restrict to IP Address
If the server has more than one network interface adapter, enter the IP address of the server network connection that
the Alarm Notification Client application will connect to.

Port Change this field if the Alarm Notification Client application will use a port other than 47806 on the server.

Current client connections Shows any workstation whose Alarm Notification Client is actively connected to this server.

Reports

Display Date and Time in Choose whether to display the date and time together in a single column or to have separate columns for each.
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Field Notes

Display preceding zeros in Date
and Time

Yes: Displays preceding zeros. Ex. 01/01/2023 02:05:09 PM

No: Omits preceding zeros Ex. 1/1/2023 2:05:09 PM

Display missing Trend data as You can specify text of up to 20 characters to appear in the report when there is no tend data. The default is a dash -.

Report logo

1. Click Choose File, and select your logo file. The logo must be a JPEG or PNG of less than 2 MB in size.

2. Click Upload. A preview of the logo appears to the right. You can review the preview to ensure the
correct file was uploaded.

NOTE: For best results, use a transparent or white background on your logo.

NOTE: The logo is resized to fit within a 100 x 100 pixel area. We recommend that you upload a logo of this size
or larger.

Schedules

Disable Schedules
If your system has no need to run schedules, check this box so that the Schedules feature is no longer visible in Vertiv™
Liebert® SiteScan™ Web interface.

Trends

Keep historical trends for ___
days

Stores trend data in the Liebert® SiteScan™ Web database for the time you specify. This is a default setting that you can
change when you set up trends for an individual point. Specify the time of day that the trends are deleted on the
Scheduled Tasks tab.

Display gap in graph line for
missing data

Check to show a gap if trend data is missing.

Enable Server Trending of
Color

Leave this checked unless directed otherwise by Technical Support.

Poll Interval
The frequency that the server polls routers for color trend data. Increase this field only if Last Poll Duration exceeds the
Poll Interval.

Source Files

All Source Files

Use to export source files to a .zipfile that can be imported into another Liebert® SiteScan™ Web system. Source files
include:

• Control programs (.equipmentfiles only)

• Drivers

• Graphics (.view files only)

• Touchscreen files

• BACview files

• Report design files for Equipment Values or Trend Sample reports

NOTE: If import detects a difference between a database file and an import file with the same name, import does
not overwrite the database file. A message lists any file differences so that you can resolve them.

Email Server Configuration
The information in this section is used by the Send email alarm action and used to email a Scheduled Report (see
Scheduling reports on page 1).

From Enter a valid address if required by your mailserver.

Mail Host The mail server address. This can be an IP address or a system name, such as mail.mycompany.com.

Mail Host Port Change this field if using a port other than the default port 25.

Mail Host Security Options

Select the type of security the mailserver uses.

• Cleartext (SMTP):Uses the SMTP protocol to send as clear text over TCP/IP

• Secure SSL (SMTP with SSL): Uses SSL, a communication protocol that provides data encryption
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Field Notes

• Secure TLS (STARTTLS): Uses TLS, but does not begin encryption until the Vertiv™ Liebert®
SiteScan™ Web application issues STARTTLS command.

Specify Mail User for Mail Host
Authentication

Select if your mail server requires a username and password.

Test connection
Click to have the Vertiv™ Liebert® SiteScan™ Webapplication try to connect to the email server. A message will appear
below this button stating if the connection was successful or if it failed.

Security tab

Field Notes

Logging

Log audit data to file

Records operator activities and some system activities (such as opening and closing the database or automatic deletions) in a
text file.

The default file is auditlog.txt stored in SiteScan\webroot\<system_name>. You can change the file name and include a different
path.

To prevent the file from growing too large as new data is appended, you can archive the data to another text file by selecting an
archive frequency in the Archive log file contents field. The archive file is auditlog_yyyy_mm_dd.txt, where yyyy_mm_dd is the
creation date of the archive file. This file is created in the same location as auditlog.txt.

NOTE: If you do not archive the log file contents, you should manually delete the oldest entries.

Log audit data to
database

Records audit data in a database named audit.mdb that can be accessed by third party software.

NOTE: For Access, MSDE, and Derby, the database is automatically created. An Access database is named audit.mdb; a
MSDE database is named audit.mdf. The Derby database consists of multiple files in a folder called audit. For MySQL,
SQL Server, PostgreSQL, or Oracle, you must create the database manually.

Delete database
entries older than ____
days

Automatically deletes entries in the database that are older than the number of days you specify.

Log errors for invalid
URLs

Enable this field to write to the core.txt log any time an external source sends a request to the Liebert® SiteScan™ Web Server
application.

NOTE: Regular maintenance scans by external software can cause the log files to grow large.

Security Policy

Change Policy See Location Dependent Operator Access on page 1 ) for information on Change Policy.

Remote Access

Allow remote file
management

Lets you access the system using WebDAV.

Operators

Return operators to
previous locations
when server
reconnects

Returns operators to current tree locations when the server reconnects.

Log off operators after
_:_ (HH:MM) of
inactivity

The system automatically logs off an operator who has had no activity in the system for the time period specified.

This is a default setting for the system. The System Administrator can change this setting for an individual operator on the
Operators page.

4 Using the Configuration View Proprietary and Confidential ©2026 Vertiv Group Corp. 133

Vertiv™Liebert® SiteScan™ Web Installer/User Guide



Field Notes

Lock out operators for
__ minutes after __
failed login attempts

Clear Lockouts removes lockouts for all users.

NOTE: Restarting the Vertiv™ Liebert® SiteScan™ Web Server application will remove lockouts.

Use advanced
password policy

You can place specific requirements on passwords to increase security. See Advanced Password Policy on page 1 .

Do not synchronize
operator and
privileges

If using hierarchical servers, the Liebert® SiteScan™ Web application automatically synchronizes the operator/privilege settings
on the child servers with those on the parent server. You have the following options:

• Enable this checkbox on all servers to stop the synchronization process.

• Enable this checkbox on a child server to remove it from the synchronization process so that you can manage
that server's settings locally.

Synchronize Now Click this button on the parent server for immediate synchronization of operator/privilege settings.

Permissions

Permissions

When control programs, views, and BACview files are created, the creator can remove any of the following permissions from them.

• Permit Upload

• Permit Download

• Permit View Logic

• Permit Edit

A restriction applies to anyone who does not have the creator's Liebert® SiteScan™ Web license. However, the creator can
produce a key for someone with a different license that will override the restrictions to let them perform any action that the key
allows.

The table in this Permissions section shows all keys in the SiteScan X.X\resources\keys folder. To activate a key, click Add, then
browse to the key.

To delete a key from your system, select the key in the table, then click Delete.

Red text in the table indicates the key has a problem such as it does not apply or has expired. See the Notes column for an
explanation.
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Communications tab

The fields on this tab let you define controller communication with the SiteScan Server application and BACnet network
communication.

Field Notes

SiteScan Server BACnet Controller
Instance and BACnet Alarm
Recipient Instance

The BACnet identifier for the system server and the alarm recipient. You enter these system properties in
SiteBuilder.

Always upload properties from
controllers to SiteScan database on
mismatch

Automatic uploads are listed in the Audit Log.

If you do not check this field, properties must be manually uploaded or downloaded by the operator when a
mismatch occurs.

NOTE: If an automatic upload fails and the operator chooses to do nothing at that time, the upload will be
attempted again when he returns to the page where he encountered the mismatch.

Ignore incoming alarms from
sources not in this database

The Vertiv™ Liebert® SiteScan™ Web application will ignore alarms from third party devices not in the database or
devices from other Liebert® SiteScan™ Web systems on the same network.

BACnet Settings Native Liebert® SiteScan™ Web system only.

Log BACnet Binding Conflicts

The Liebert® SiteScan™ Web application uses BACnet (dynamic) binding for communication between devices
unless your system uses NAT routing. If using NAT, the Liebert® SiteScan™ Web application uses information in its
database to bind to BACnet devices.

When checked, the Liebert® SiteScan™ Webapplication logs binding conflicts that result from duplicate network
numbers or device IDs.

NOTE: Requires a connection/server restart.

Enable BMS Network Port Object
Modification

Allows you to write to the following network port object properties:

• bacnet_ip_mode

• fd_bbmd_address

• fd_subscription_lifetime

Changes to these properties are password protected. You must create a password by typing it into the Activate
Changes Password field. Enter this password when prompted.

NOTE: Requires a connection/server restart.

Scheduled tasks tab

Field Notes

Automatically delete alarm incident
groups which have been closed for
more than ___ days

An incident group is all alarms related to a particular incident, such as Off Normal, Fault, and Return to Normal.

NOTE: Alarms in an incident group are not deleted until all alarms in the group have been closed.

Archive alarm information upon
alarm deletion

Writes alarm information to a text file.

Automatically delete expired
schedules daily at ___

To ensure there are no time zone conflicts, the Liebert® SiteScan™ Web application waits 2 days after a schedule
expires to delete it.

Remove expired historical trends
daily at ____

Deletes trend data that has been in the database longer than the time specified in the Keep historical trends for ___
days field on the General tab.

Enable time synchronization of
controllers daily at____

Automatically synchronizes the time on all equipment to the time on the server, adjusting for different time zones
and daylight saving time. We recommend that you check this field.
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Field Notes

The Vertiv™ Liebert® SiteScan™ Web application will send a daily time sync message to each IP network device
that is in the system database. IP devices not in the database will not be synchronized. For all ARC156 or MS/TP
networks in the database, the Liebert® SiteScan™ Webapplication will send a broadcast time sync message. All
devices on these networks will be synchronized, regardless of whether or not the devices are in the database.

CAUTION: Make sure that your server time and time zone setting are correct. Make sure that
each site’s time zone setting in SiteBuilder is correct.
To prevent time sync problems when the transition to and from daylight saving time occurs, set

the time sync to occur at least 1 hour after the last controller in the system is adjusted for DST.
For example, your server and part of your system is in the Eastern Standard Time zone, but you
also have controllers in the Pacific Time zone. Your server is adjusted for DST at 2:00 a.m.
Eastern Standard Time, but the controllers in the Pacific Time zone are not adjusted until 3 hours
later. So you would set the time sync to occur daily at 6:00 a.m. or later.

NOTE: You can disable this function for an individual site on the site Properties page. See Setting up site
properties on page 139.

NOTE: You can perform system-wide time synchronizations using the Time Sync button on the General tab
(See General tab on page 130). Or, you can synchronize individual devices using the Time Sync button on
the devices Properties page.

NOTE: Between time sync broadcasts, Vertiv routers include time sync information in each color request to
the devices below the router. This ensures devices without a battery backed clock will get the time shortly
after powering up.

Check for expiring BACnet/SC
certificates daily at ____

Triggers an alarm when a BACnet/SC Hub certificate will expire within the Warning or Critical thresholds. While in
the Warning threshold, the alarm repeats once per week. In the Critical threshold, the alarm repeats daily and every
operator will get a popup message when they login.

Back up

Back up ____ at ____ — Enables an automatic periodic backup of the Liebert® SiteScan™ Web database and all
system files. Specify the desired frequency and time to run the backup.
Backup types — Enable Full and/or Partial backups. A partial backup creates a backup of the system and core
database to Derby.

NOTE: Full backups are supported for Postgres and Derby databases only.

Back up locally — Specify the number of local backups to retain of each type. Once the threshold is reached, the
oldest backup is removed upon the next backup operation. This applies to any backup, not only scheduled
backups. Additionally, specify a backup directory to write system backups to. For increased security, specify a
backup directory in the system.properties file by setting 'dbbackup.dir=PATH'. A directory entered in the file takes
precedence over a directory entered on this page.
Back up to BAS Central — Select to back up to BAS Central. This is only available if you have successfully
registered with BAS Central.
Click Run Manual Backup to initiate an immediate backup manually. In the Run Manual Backup window, enable Full
and/or Partial backup types. If necessary, choose whether to back up locally or to BAS Central, and enter any notes.
Then click Run Now.
Last Backup Status — Shows the most recent backup status. This field resets upon restarting the Liebert®
SiteScan™ Web server.

NOTE: If using a PostgreSQL database, you must set the path of the PostgreSQL binaries (database
executable files) directory containing the pg_dump executable by setting the dbtools.bindir property in the
system.properties file.

NOTE: The path must use forward slashes.

NOTE: Example: dbtools.bindir= C:/PostgreSQL/16/bin

• We recommend using the same version of PostgreSQL binaries as the PostgreSQL database running with
the Liebert® SiteScan™ Web system.
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Field Notes

• Use the links below to download either 'postgresql-client' (Linux) or 'command line tools' (Windows) which
contains the pg_dump and pg_restore executables.

Linux

https://www.postgresql.org/download/linux/ Select Linux distribution and follow the installation instructions for
“postgresql-client-<your-postgres-version>”.

Windows

https://www.enterprisedb.com/downloads/postgres-postgresql-downloads Download the installer and run it. Only
the "Command Line Tools" component needs to be checked/installed.

Daylight saving tab

On this tab, you can adjust the Daylight Saving Time settings for SiteScan Server.

Click Update to automatically set the table's Begin and End dates for the next 10 years based on the system's timezone. This
marks all controllers with ExecB drivers for a Parameters download.

If the updated dates are incorrect:

If you clicked Update but the dates are incorrect, your system's Java timezone data may be out of date. Do the following:

1. Go to the Oracle Java SE Download site (http://java.sun.com/javase/downloads).

2. Download the JDK DST Timezone Update Tool (tzupdater-< version >.zip) and unzip the file. The zip file contains
2 items:

• tzdata.tar.gz

• tzupdater.jar

3. In the Liebert® SiteScan™ Web interface, go to System Settings > Daylight Saving, then click Import.

4. Browse and select tzupdater.jar file then click Open.

5. Click Continue. This restarts the SiteScan Server application.

6. After the restart, in the Vertiv™ Liebert® SiteScan™ Web interface, go to System Settings > Daylight Saving, and
then click Import.

7. Browse to the tzdata.tar.gz file, select it, and then click Open.

8. Click Continue. This restarts the SiteScan Server application.

9. On the System Settings > Daylight Saving tab, click Update.

NOTE: If you have sites in different time zones that use Daylight Saving Time, you can click View DST Dates on the
site Properties page to see DST information and time change dates.

Add-ons tab

A Liebert® SiteScan™ Web system supports add-ons, such as EnergyReports, that retrieve and use the Liebert® SiteScan™
Web data.

By default, the Liebert® SiteScan™ Web application allows only signed add-ons that are supported by Vertiv. If needed, you
can override this setting in SiteBuilder by going to Configure > Preferences > Web Server, and checking Allow unsigned add-
ons.

To install an add-on:

1. Save the add-ons file (.addon or .war) to your computer.
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2. On the System Settings > Add-ons tab, click Browse, and then open the file.

3. Click Install. After a few seconds, the add-on will appear in the Installed table, and will be enabled. The table below
gives a description of each column.

Column Notes

Name The add-ons name.

Path

To open the add-on in a web browser, append this path to your Liebert® SiteScan™ system's address.

For example, to open EnergyReports,

enter: http://<system_name>/EnergyReports,

-Or-

http://<system_IP_address>/EnergyReports

Version The version is shown if the author provided the information in the add-on.

License

Displays: <License State> - <Expiration> - <Serial Number Match Check> - <Dealer License Check>

License State

• Licensed: the add-on license is present

• Licensed Required: the add-on requires a license and license is not present.

• License Not Required: a license is not required

• License Optional; a license is optional

• License Not Required For Cloud: a license is not required if using a Cloud system

Expiration

• (blank): Addon license does not have expiration date.

• Expires xx/xx/xxxx: Addon license has expiration date which is still in future.

• Expired: Addon license has expiration date which has past.

Serial Number Match Check

• (blank): Add-on license and product serial numbers match.

• Serial number mismatch: Add-on license and product serial numbers do not match. This causes a
Startup Error when enabling the add-on.

Dealer License Check

• (blank): Product is not running with Dealer License.

• Dealer license present: Product is running with Dealer License.

Status

If this column shows:

• Running, you can open the add-on in a web browser.

• Disabled, click Enable to run the add-on.

• Startup error, select the table row to see an explanation of the error under Details.

4. Select an add-on in the Installed table to disable or enable it, or to see the following details.

Column Notes

Add-on main page Click the main page link to open the add-on, if the author provided a main page.

Description A description of the add-on, if the author provided one.

Vendor Name The add-on author

Public Data Directory This public directory contains data generated by the add-on. This data is visible in a web browser.

Private Data Directory This private directory contains information such as configuration data.
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To back up the add-ons private and public data directories:

NOTE: This procedure will not back up data stored in an external database. For example, EnergyReports uses an
external database.

1. Select the add-on in the table.

2. Click Save Data.

3. Click OK.

4. Click Save.

5. Select the location where you want to save the data, then click Save.

To update an add-on:

NOTE: Add-ons for Vertiv™ Liebert® SiteScan™ Web v6.0 or later systems have a different folder structure than
previous versions.

1. Select the add-on in the table.

2. Click Remove Add-on and Data.

3. Follow the procedure above to install the new version of the add-on.

To Uninstall an add-on:

1. Select the addon in the table.

2. Click Remove Add-on and Data.

4.2.2 Setting up site properties

To set up site properties:

1. On the Network tree, select the site.

2. Click Properties.

3. Configure site properties.

Field Notes

Enable
Timesync

Daily synchronizes the time in the site controllers with the server time, adjusting for different time zones and Daylight Saving Time.
Synchronization occurs each day at the time specified in the field Enable time synchronization of controllers daily at on the System
Settings > Scheduled Tasks (see Scheduled tasks tab on page 135) tab.

CAUTION: Make sure that your server time and time zone setting are correct. Also, make sure that the site time zone
setting is correct in SiteBuilder.

View DST
Dates

If the site time zone (set in SiteBuilder) uses Daylight Saving Time, you can click View DST Dates to see DST information and time change
dates.

Group
Cache
Controller

The designated router where colors are cached when peer caching is enabled in SiteBuilder.

Device
Password

Applies only to devices with a drv_gen5 driver Set this password to restrict access to the Service Port controller setup pages of a controller
with a drv_gen5 driver. You will have to know the password to be able to see the setup interface.
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4.2.3 Registering your Vertiv™ Liebert® SiteScan™ Web software

To register your software, you must obtain a registered license from Vertiv and then apply it in the Liebert® SiteScan™
interface. You can apply it when you install the software or at a later time.

To register your software procedure:

1. Contact your local Vertiv Sales representative to obtain a new license.

2. Apply your license:

• During the Liebert® SiteScan™ installation: The installation requests the location of your license file.
Browse to location where you saved it.

• After the installation:

a. On the Liebert® SiteScan™ System Configuration tree, select License Administration.

b. Browse to the license file.

c. Click Apply.

d. Restart the SiteScan Server application.

NOTE: Do not edit any part of this registered license file. Editing a license file invalidates the license. Store the license
in a safe location.

4.2.4 Adding links or text to the Liebert® SiteScan™ Web login page

You can add links or text, such as a disclaimer, to the login page.

Adding links to the login page

To add links to the login page:

1. In a text editor such as Notepad, type 2 lines for each link that you want on the login page.
Line 1:link#.text=<the link text that is to appear on the login page
Line 2:link#.url=<the link's address>

NOTE: link#.text and link#.url must be lowercase.

2. Save the file with the following name and location.
File name:extra_login_links.properties
Location:SiteScanx.x\webroot\<system_name>

Adding text to the login page

To add text to the login page:

1. In a text editor such as Notepad, enter the text that you want on the login page.

2. Save the file with the following name and location.
File name:legal_disclaimer.txt
Location:SiteScanx.x\webroot\<system_name>
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4.3 Services Status

The Services window displays all current services for Vertiv™ Liebert® SiteScan™ Web and the status of each.

To view services:

Click , then click services in the navigation tree.

4.4 Configuring Client Installs

Client Install is used to install the Java Virtual Machine on the current connected workstation. Install only if required.

Wafer Font is used to display specific text in the Liebert® SiteScan™ Web session. Install only if required.

Alarm Pop Application is a thin application that can be used by a client to receive alarm notifications to a workstation outside
of the Liebert® SiteScan™ Web browser.

To download a client install:

1. Click , then click Client Install in the navigation tree.

2. Click a link to download:

• Sun’s Java VM: Java Virtual Machine plug-in for Internet Explorer applets.

• Wafer font: Wafer font for use with logic pages. (Place in your Windows install directory/fonts folder.)

• Alarm Popup Application: Stand-alone client application that receives Alarm Popup action messages.

• HTTP proxy tool: Engineering tool to tunnel web pages across BACnet (through RNet or access port).

4.5 Configuring the Trends Display Setup

The Trends Display Setup options allow you to specify the appearance of graphs on the screen.

To configure trend display:

1. Click , then click Trend Display Setup in the navigation tree.

2. In the Trend Colors section, choose options to specify colors for all graphs for the background, grid and axis, as
well as text portions: labels for x-axis and y-axis labels, the main title and the y-axis title.

3. You may set up display options for up to four types of graphs, including line style and color and marker color and
type.
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4.6 Configuring Trends Print Setup

The Trends Print Setup options allow you to specify the appearance of printed graphs.

To configure printed trend graphs:

1. Click , then click Trend Print Setup in the navigation tree.

2. In the Trend Colors section, choose options to specify colors for all graphs for the background, grid and axis, as
well as text portions: labels for x-axis and y-axis labels, the main title and the y-axis title.

3. You may set up display options for up to four types of graphs, including line style and color and marker color and
type.

4.7 Changing Unit Bezel Colors

1. On the top-level floor plan in the geographic view navigation tree, click the drop-down arrow next to the Graphics
menu tab, and select Bezel Color Scheme.

2. The Unit/System drop-down offers several color schemes and Custom. To change colors, select either an option
from the list.

• Selecting a color from Unit/System, applies a color scheme based on that color to the table header, bezel
background, and table background.

• Selecting Custom lets you set different colors for each of the bezel elements. If the color you want is not
available, select New in the element drop-down to open a color wheel and set the color.

4.8 Event Color Scheme

NOTE: Alarm colors are a System setting. Changing a System setting, such as alarm colors, will affect all users. If any
user changes the event color scheme it will overwrite the previous setting.

NOTE: Alarm colors can only be changed by an operator with administrative privileges. Changing the event color
scheme may also require downloading a module.

To change the alarm colors:

1. On the top level floor plan in the geographic view navigation tree, click the drop-down arrow next to the Graphics
menu tab, and select Event Color Scheme.

2. In Event Selection, select Custom and select a color under each of the event types to change:

• Critical Color

• Warning Color

• Message Color

• Maintenance Color

• Normal Color

3. Click Save Event Color, and click OK each time a confirmation pops up to make the changes. Making the color
change may take more than two minutes, depending on the size of the system.

NOTE: If the event color scheme does not take effect, a module download may be required. Contact your IT
department to download the module.
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5 Advanced Topics

5.1 Options for Running the Vertiv™ Liebert® SiteScan™ Web System

5.1.1 Running Liebert® SiteScan™ Web server without connecting to controllers

To verify links between graphics and to set up properties, schedules, alarms, and trends before you connect to the network,
run SiteScan Design Server instead of SiteScan Server. Then view the Liebert® SiteScan™ Web interface in a web browser.

NOTE: Question marks or purple thermographic color indicates correct microblock paths. Missing data or dark yellow
thermographic color indicates errors.

5.1.2 Switching Liebert® SiteScan™ Web server to a different system

Design engineers working on multiple projects can switch systems in the SiteScan Server application.

To switch SiteScan server to different system:

1. In the SiteScan Server application, select Server.

2. Change the Active System.

3. Select a different system (it must be in the webroot folder) and mode.

4. Click Select.

5.1.3 Running SiteScan server as a windows service

For Windows 8.1, 10, 2012R2, 2016, 2019, 2020, and 2022 Run SiteScan Server as a Windows service if you want SiteScan
Server to automatically start up when the server computer is restarted.

NOTE: If your Liebert® SiteScan™ Web system uses a database other than Derby and the database is located on the
same computer as SiteScan Server, you must set up Windows to delay starting SiteScan Server until the database
service has started. See How to delay loading of specific services (http://support.microsoft.com/kb/193888) on the
Microsoft website.

Installing Liebert® SiteScan™ Web server service

NOTE: If you are not sure if the service was previously installed, see Determining the installation status of SiteScan™
server service on page 1.

To install Liebert® SiteScan™ Web server service:

1. In the Windows Start menu, select All Programs and then Accessories.

2. Right-click on the Command Prompt, then select Run as administrator.

3. Select Yes in the User Account Control message.

4. In the Command Prompt window, enter: cd<path to the SiteScan install directory>.

For example, enter: cd c:\SiteScan_Web_x.x replacing x.x with your current version number.

5. Press Enter.

6. Enter : SiteScan Service.exe.

7. Press Enter.
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Installing Vertiv™ Liebert® SiteScan™ Web server as a windows service

To start Liebert® SiteScan™ Web Server as a Windows® service:

1. In the Windows Start menu, select Control Panel.

2. Select Administrative Tools, then double-click Services.

3. In the Services (Local) list, double click SiteScan Service X.X.

4. In the Startup type drop-down list, select Automatic.

5. On the Log On tab, do one of the following:

• Use the defaulted Local System account.

• Select This account, then browse to select a user who is a member of the Administrator Group on that
computer.

6. Optional:If you selected Local System account in step and you want to be able to access SiteScan Server on the
server computer's desktop, check Allow service to interact with desktop.

NOTE: If you do not check this field, the computer screen will give no indication that SiteScan Server is running; you
must view the computer's Services page to see if it is running.

This checkbox applies only to a user logged in on the server. A Windows Remote Desktop user cannot access SiteScan
Server running as a service.

If you check this field, you cannot use the instructions below to set up printing to a network printer. Ask your Network
Administrator to set up Local System account to use a network printer.

If you check this field and the Liebert® SiteScan™ Web application is to run email alarm actions, ask your Network
Administrator to set up Local System account to send emails.

7. On the General tab, click Start.

8. Click OK.

NOTE: If SiteScan Server does not start after you click Start, you may have a Windows permissions problem. Follow
the procedure below in Setting up the service for network printing on page 1 to set up the Windows user name and
password.

Setting up the service for network printing

If SiteScan Server runs as a service on a computer that is using a network printer, you must set up the Windows user name
and password for the service. The Print alarm action requires this setup to be able to print.

To set up the service for network printing:

1. In the Windows Start menu, select Control Panel.

2. Select Administrative Tools > Services.

3. Double-click SiteScan Service x.x.

4. On the Log On tab, select This account.

5. Browse to the computer's domain, then select the user that the service will login as.

NOTE: Contact your network administrator, if you need help determining the domain.

6. Enter the user password in the Password and Confirm password fields.
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Stopping or uninstalling SiteScan server service

To stop or uninstall the SiteScan server service:

1. In the Windows Start menu, select Control Panel.

2. Select Administrative Tools, then double click Services.

3. In the Services (Local) list, double-click SiteScan Service X.X (where X.X. is the SiteScan version number.

4. In the SiteScan Service X.X. properties dialog box, click Stop on the General tab.

5. Click OK.

To uninstall the SiteScan server service:

1. In the Windows Start menu, right-click on the Command Prompt, then select Run as administrator.

2. Select Yes in the User Account Control message.

3. In the Command Prompt window, enter cd <path to the SiteScan install directory>.

For example, enter cd c:\SiteScan_Web_x.x.

4. Press Enter.

5. Enter: SiteScan Service.exe -remove

6. Press Enter.

Determining the installation status of Vertiv™ Liebert® SiteScan™ WebServer service

If you do not know if the service was previously installed, follow the appropriate steps below.

To determine if SiteScan server service is installed:

1. In the Windows Start menu, right-click Command Prompt, then select Run as administrator.

2. Select Yes in the User Account Control message.

3. In the Command Prompt window, enter cd <path to the SiteScan install directory>.

For example, enter cd c:\SiteScanx.x.

4. Press Enter.

5. Enter : SiteScan Service.exe -check

6. Press Enter.

5.1.4 Running SiteScan server as a Linux® service

Setting up as a service on Ubuntu® or RedHat®

To set up as a service on Ubuntu® or RedHat®:

1. On the terminal screen, enter cd /opt/SiteScanx.x.

2. Press Enter.

3. On the terminal screen, enter sudo ./SiteScan\ Service add.

4. Press Enter.

5. Reboot the computer for the application to run as a service.
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Removing as a service on Ubuntu® or RedHat®

To remove as a service on Ubuntu® or RedHat®:

1. On the terminal screen, enter cd /opt/SiteScanx.x).

2. Press Enter.

3. On the terminal screen, enter sudo ./SiteScan\ Service remove.

4. Press Enter.

5. Reboot the computer.
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5.2 Setting Up a System for Non-English Languages

English is the Vertiv™ Liebert® SiteScan™ Web default language, but you can set up your system to display a different
language. You can also set up multiple languages so different operators can view the system in different languages.

Follow the procedures below to display the Liebert® SiteScan™ Web interface in non-English languages:

1. Install a language pack (see Installing a Language Pack on page 1 ).

2. Prepare your workstation for non-english text (see Preparing the Workstation for Non English Text on page 1 ).

3. Create control programs and translation files (see Creating Control Programs and Translation Files for a Non
English System on page 1 ).

4. Create graphics (see Creating Graphics for a Non English System on page 1 ).

5. Create your system in SiteBuilder (see Creating your system on page 1).

6. Set an operator’s language in the Liebert® SiteScan™ Web interface (see Setting an operator’s language in the
Liebert® SiteScan™ Web interface on page 1).

5.2.1 Installing a language pack

A language pack translates the text in the Liebert® SiteScan™ Web interface. A Liebert® SiteScan™ Web system is installed
with an English language pack.

To download other language packs:

1. Go to http://accounts.oemctrl.com/download.

2. Under Software Installs and Updates, select v# Language Packs, where # is your Liebert® SiteScan™ Web
version.

3. Select the required language.

4. Follow the instructions given under To install this language pack.

NOTE: If you create a system by copying an existing system that uses language packs, install the same language
packs on the new system.

5.2.2 Preparing the workstation for non-english text

NOTE: The instructions below are for a Windows XP operating system. If you have a different operating system, see
your system's Help for instructions.

Set up your workstation so you can enter international characters in control programs, graphics, or SiteBuilder.

To prepare workstation for non-english text:

1. Install the appropriate fonts for the languages you will be using. In the Windows Control Panel, open Fonts, select
File and then Install new fonts.

2. In the Control Panel, open Regional and Language Options, then select the Input language. See Figure 5.1 on the
next page.

3. Install an Input Method Editor (IME) for non-alphanumeric characters. See Figure 5.1 on the next page.
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Figure 5.1 Input Language Addition

See your operating system's Help for more information.

5.2.3 Creating control programs and translation files for a non-english system

To have the Vertiv™ Liebert® SiteScan™ Web interface display a control program’s user defined text (such as microblock
names and property text) in a non-English language, you must:

1. Create the control program using key terms instead of the text.

2. Create translation files of key terms and their language-specific equivalents.

In the Liebert® SiteScan™ Web interface, the key term is replaced with its equivalent in the translation file for the current
operator language. If a Liebert® SiteScan™ Web Properties page or Logic page shows ??key term??, the key term is missing
from the translation file.
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NOTE: To edit existing control programs or translation files, see Editing translation files or control programs for a non-
english system on page 152.

Entering a key term in the EIKON application

In the EIKON Property Editor, enter @ before each key term.

Figure 5.2 Property Text Page

NOTE: Enter only the key term in the EIKON application. Expressions such as $present_value$ are put in the
translation file as part of the translated text. See EXAMPLES in Translation files on page 1.

Key terms can contain only alphanumeric characters and underscores (no spaces) and cannot start with a number.

Translation files

Translation files are used to translate key terms in control programs. A translation file contains key terms and their language-
specific equivalents.

For a non-English system, you must create an English translation file and a non-English translation file* for each of the
following:

• Each control program

• Key terms used in multiple control programs

Translation files Key term=Language-specific equivalent

English This_value=This value is $present_value$   Zone_temp=Zone temperature

Spanish     This_value=Este valor es $present_value$   Zone_temp=Temperatura de zona

NOTE: *If the Vertiv™ Liebert® SiteScan™ Web interface will display multiple non-English languages, create a translation file for each language.

Table 5.1 Examples

Creating and implementing a translation file

To create and implement a translation file:

Create your translation file in a text editor, such as Microsoft Word, that supports the character encoding you need.

1. Enter one key term and language equivalent per line, left justified, starting in column 1. Do not put spaces on
either side of the equal sign.

2. Save the file using the appropriate file name and location in the below table.
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If key terms are used in... the file name is... File location

A single control program <any_name>_xx.native* Any location

Multiple control programs equipment_xx.native* SiteScan_Web_\webroot\ <system_name>\resources

* xx = the language extension code. See Extension Codes and Encoding below.

If you are using:

• The English character set, save the file as Text only.

• A non-English character set, save the file as Encoded text . (See your application’s help for information on
saving files as encoded text.) When prompted for the language and encoding, see Extension Codes and
Encoding below.

3. Open the control program in the EIKON application, then select Control Program > Bundled Resources.

4. Click , locate and select the translation files for this control program, then click Open.

NOTE: Do not add equipment_xx.native files that you created for multiple control programs.

You can use Ctrl+click or Shift+click to select multiple files.

5. Save the control program. The translation files are embedded in the control program, the original files are no
longer necessary.

Extension Codes and Encoding

Language Extension code Encoding*

Brazillian Portuguese pt_BR ISO-8859-1

English en ISO-8859-1

Canadian French fr ISO-8859-1

French fr_FR ISO-8859-1

German de ISO-8859-1

Italian it ISO-8859-1

Japanese ja EUC-JP

Korean ko EUC-KR

Russian ru KOI8_R

Spanish es ISO-8859-1

Swedish sv ISO-8859-1

Simplified Chinese zh GB2312

Traditional Chinese zh_TW Big5

Thai th TIS620

Vietnamese vi Cp1258

NOTE: * Encoding is used when you create the translation file.

Table 5.2 Extension Codes and Encoding
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5.2.4 Creating a non-english system in SiteBuilder

Choosing the languages for your system

To choose the languages for your system:

1. In SiteBuilder, select Configure > Preferences.

2. Select the Language tab.

3. Under Supported Languages, select each language that you want to be available in your system.

NOTE: This list shows all installed language packs. To install additional languages, see Installing a Language Pack on
page 1 .

4. In the System field, select the system Language (see System language below).

5. Click OK.

6. Save your database.

Creating your system

To create your system in each language that the system will display:

1. In SiteBuilder, select Configure > Preferences.

2. Optional:The Font tab shows the font that will be displayed in SiteBuilder for each language that you selected on
the Language tab. To change a font, click on the name in the Preview Font column, then make a new selection.

3. On the Language tab, select a language in the Current Session field.

4. Click OK.

5. Create your system.

6. Save your database.

7. If your system will display multiple languages:

a. Select Configure > Preferences, select the Language tab, and select another language in the Current
Session field.

b. Re-enter all node names and display names in the current language.

c. Save your database.

d. Repeat steps a . through c . for each additional language the system will display.

System language

The system language is used for:

• The default language for new operators

• Alarms sent to the database

• State text and object names downloaded to the field

• The default login page*

All other information is displayed in the operator’s language, which may be different than the system language. See Setting an
operator’s language in the Vertiv™ Liebert® SiteScan™ Web interface on the next page.

NOTE: You can change the language shown on the Vertiv™ Liebert® SiteScan™ Web login page by selecting a different
language from the list below the Password field (*).
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5.2.5 Setting an operator’s language in the Vertiv™ Liebert® SiteScan™ Web
interface

An operator can change their language preference in the Liebert® SiteScan™ Web interface.

To change language preference:

1. On the System Configuration tree, select My Settings.

2. Under Preferences, select the Language in the drop-down list.

3. Click Accept.

5.2.6 Editing translation files or control programs for a non-english system

If you add or edit a key term in a control program, be sure to make the same change in the translation file. See Creating
Control Programs and Translation Files for a Non English System on page 1 .

If you make changes after attaching a control program in SiteBuilder, do one of the following:

• If you changed text only in a control program or its translation file, right-click the control program on the
Geographic tree, then select Rebuild Equipment Pages.

• If you changed logic in the control program, right-click the control program on the Geographic tree, then select
Reload Control Program.

• If you changed a translation file located in <system_name>\resources, right-click each applicable graphic on the
Geographic tree, then select Rebuild Graphic Resources.

Editing a bundled resource

The EIKON application bundles (embeds) the translation files for a control program into the .equipment file. See steps 3
through 5 .

To edit a bundled translation file:

1. Open the control program in the EIKON application.

2. Select Control Program > Bundled Resources.

3. Select the file, then click Save to save it to your hard drive.

4. Edit the translation file.

5. In the Bundled Resources dialog box in the EIKON application, click and select the edited file.

6. Click OK to overwrite the existing file.

Editing an EIKON for SiteScan control program in the EIKON application

To edit a non English control program that you created in the EIKON for SiteScan application:

1. Open the .eiw or .equipment file in the EIKON application, then make your edits.

2. Select Control Program > Bundled Resources.

3. Verify that the list shows all translation files specifically for the control program. Use the plus or minus button to
add or delete translation files.
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NOTE: This list shows the translation files in the SiteScan\webroot\<system_name>\programs folder. This list should
not include translation files for multiple control programs.

4. Click OK.

5. Save the control program. The translation files are bundled with the control program; the original files are no
longer necessary.

NOTE: If you need to change a translation file after you save the control program, see Editing a bundled resource on
the previous page.

Copying translation files to another system

To copy most translation files from one system to another, you copy the files in the source system and paste them into the
same folders in the destination system.

However, if your source system and destination system have translation files with the same name, copying and pasting would
overwrite the files in the destination system. In this case:

1. Open the source system’s translation file in a text editor, then copy the key terms and translations.

2. Open the destination system’s translation file in a text editor, then paste into it the key terms that you copied.
Remove any duplicate key terms.
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Appendices

Appendix A: Technical Support and Contacts

A.1 Technical Support/Service in the United States

Vertiv Group Corporation

24x7 dispatch of technicians for all products.

1-800-543-2378

Liebert® Thermal Management Products

1-800-543-2378

Liebert® Channel Products

1-800-222-5877

Liebert® AC and DC Power Products

1-800-543-2378

A.2 Locations

Vertiv Americas Headquarters

505 N Cleveland Ave

Westerville, OH 43082

Vertiv EMEA Headquarters

Victor-von-Bruns Strasse 21,

8212 Neuhausen am Rheinfall, Switzerland

Vertiv Asia Headquarters

Singapore

151 Lorong Chuan, Lobby D #05-04

New Tech Park, Singapore 556741

India

Vertiv Energy Private Limited

Plot No. C 20, Road No. 19

Wagle Industrial Estate, MIDC

Thane (West), Maharashtra 400604, India
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China

Vertiv Technology Co., Limited

Floors 1–4 and 6–10,

Building B2, Nanshan I Park

No. 1001 Xueyuan Road, Nanshan District

Shenzhen, Guangdong 518055, China
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